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Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft
applications and PeopleTools. The help provides standard navigation and full-text searching, as well as
context-sensitive online help for PeopleSoft users.

Hosted PeopleSoft Online Help

You can access the hosted PeopleSoft Online Help on the Oracle Help Center. The hosted PeopleSoft
Online Help is updated on a regular schedule, ensuring that you have access to the most current
documentation. This reduces the need to view separate documentation posts for application maintenance
on My Oracle Support. The hosted PeopleSoft Online Help is available in English only.

To configure the context-sensitive help for your PeopleSoft applications to use the Oracle Help Center,
see Configuring Context-Sensitive Help Using the Hosted Online Help Website.

Locally Installed PeopleSoft Online Help

If you’re setting up an on-premises PeopleSoft environment, and your organization has firewall
restrictions that prevent you from using the hosted PeopleSoft Online Help, you can install the online help
locally. Installable PeopleSoft Online Help is made available with selected PeopleSoft Update Images and
with PeopleTools releases for on-premises installations, through the Oracle Software Delivery Cloud.

Your installation documentation includes a chapter with instructions for how to install the online help

for your business environment, and the documentation zip file may contain a README.txt file with
additional installation instructions. See PeopleSoft 9.2 Application Installation for your database platform,
“Installing PeopleSoft Online Help.”

To configure the context-sensitive help for your PeopleSoft applications to use a locally installed online
help website, see Configuring Context-Sensitive Help Using a Locally Installed Online Help Website.

Downloadable PeopleBook PDF Files

You can access downloadable PDF versions of the help content in the traditional PeopleBook format on
the Oracle Help Center. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft
Online Help, but it has a different structure and it does not include the interactive navigation features that
are available in the online help.

Common Help Documentation

Common help documentation contains information that applies to multiple applications. The two main
types of common help are:

* Application Fundamentals
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Preface

» Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential
information about the setup and design of your system. This information applies to many or all
applications in the PeopleSoft product family. Whether you are implementing a single application, some
combination of applications within the product family, or the entire product family, you should be familiar
with the contents of the appropriate application fundamentals help. They provide the starting points for
fundamental implementation tasks.

In addition, the PeopleTools: Applications User's Guide introduces you to the various elements of the
PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components,
and pages to perform basic functions as you navigate through the system. While your application or
implementation may differ, the topics in this user’s guide provide general information about using
PeopleSoft applications.

Field and Control Definitions

PeopleSoft documentation includes definitions for most fields and controls that appear on application
pages. These definitions describe how to use a field or control, where populated values come from, the
effects of selecting certain values, and so on. If a field or control is not defined, then it either requires
no additional explanation or is documented in a common elements section earlier in the documentation.
For example, the Date field rarely requires additional explanation and may not be defined in the
documentation for some pages.

Typographical Conventions

viii

The following table describes the typographical conventions that are used in the online help.

Typographical Convention Description

Key+Key Indicates a key combination action. For example, a plus sign
(+) between keys means that you must hold down the first key
while you press the second key. For Alt+W, hold down the Alt
key while you press the W key.

... (ellipses) Indicate that the preceding item or series can be repeated any
number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode syntax.
Options are separated by a pipe ( | ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.
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Typographical Convention Description

> This continuation character has been inserted at the end of a
line of code that has been wrapped at the page margin. The
code should be viewed or entered as a single, continuous line
of code without the continuation character.

ISO Country and Currency Codes

PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and
currency codes to identify country-specific information and monetary amounts.

ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency
identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a
country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY CD TBL) contains sample currency code data. The
Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and
also relies on ISO country codes in the Country table (COUNTRY TBL). The navigation to the pages
where you maintain currency code and country information depends on which PeopleSoft applications
you are using. To access the pages for maintaining the Currency Code and Country tables, consult the
online help for your applications for more information.

Region and Industry Identifiers

Information that applies only to a specific region or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft
Online Help:

¢ Asia Pacific
*  Europe
¢ Latin America

¢ North America

Industry ldentifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following
industry identifiers may appear in the PeopleSoft Online Help:

» USF (U.S. Federal)
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* E&G (Education and Government)

Translations and Embedded Help

PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft
aligns with the other Oracle applications by focusing our translation efforts on embedded help. We

are not planning to translate our traditional online help and PeopleBooks documentation. Instead we
offer very direct translated help at crucial spots within our application through our embedded help
widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that
the software and embedded help translation footprint is identical—something we were never able to
accomplish in the past.

Using and Managing the PeopleSoft Online Help

Select About This Help in the left navigation panel on any page in the PeopleSoft Online Help to see
information on the following topics:

»  Using the PeopleSoft Online Help.
» Managing hosted Online Help.

* Managing locally installed PeopleSoft Online Help.

PeopleTools Related Links

PeopleTools 8.60 Home Page

PeopleSoft Search and Insights Home Page

“PeopleTools Product/Feature PeopleBook Index” (Getting Started with PeopleTools)

PeopleSoft Online Help

PeopleSoft Information Portal

PeopleSoft Spotlight Series

PeopleSoft Training and Certification | Oracle University

My Oracle Support

Oracle Help Center

Contact Us

Send your suggestions to psoft-infodev_us@oracle.com.

Please include the applications update image or PeopleTools release that you’re using.
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Follow Us

)
o
3

Link

[]

Watch PeopleSoft on YouTube

X

Follow @PeopleSoft Info on X.

Read PeopleSoft Blogs

1]
L

Connect with PeopleSoft on LinkedIn
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Chapter 1

Getting Started with PeopleSoft Tree
Manager

PeopleSoft Tree Manager Overview

This document discusses PeopleSoft Tree Manager, the PeopleTools feature you use to create and
maintain hierarchical relationships, such as trees. To take full advantage of the information covered in this
book, you should have a basic understanding of how to use PeopleSoft applications.

With PeopleSoft Tree Manager, you represent data graphically to show a hierarchy. Other parts of the
system can use the trees that you have defined for hierarchical information — for reports, ChartField
combination editing, OLAP, summary ledgers, or security. You can update trees with specifically
designed tools, and your changes are then automatically applied throughout the system. You can also use
PeopleCode to manipulate trees.

Warning! Be cautious about using your browser’s Back button in PeopleSoft Tree Manager, as you may
receive unexpected results. Save changes to your trees before using the Back button.

Note: Query Access trees are not maintained or viewed by PeopleSoft Tree Manager or Tree Viewer.
Those trees can be viewed or maintained by using the Query Access Manager, which is located under the
Security > Query Security menu option.

The Tree Viewer module provides read-only access for all trees. Administrators can provide users either
PeopleSoft Tree Manager or the Tree Viewer module.

The following list explains the PeopleSoft Pure Internet Architecture pages that are included in
PeopleSoft Tree Manager and provides cross-references to the corresponding documentations:

Term Definition

Tree Manager page See Opening Trees.

Find Value page See Searching for Nodes or Detail Values.
Insert Sibling Node page See Inserting Nodes.

Insert Child Node page See Inserting Nodes.

Node Properties page See Switching Node Levels.
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Term Definition
Detail Value Range page See Working with Detail Values.

Tree Definition and Properties page

See Modifying Tree Definitions.

See Defining Basic Attributes.

Tree Levels page

See Defining Tree Levels.

Configure User Options page

See Setting Display Options.

Node Navigation page

See Using Navigation Options.

Tree Print Format page

See Printing Trees, Exporting Trees to PDF Files.

Tree Structure Properties page

See Defining Detail Tree Structures.

Levels page See Defining Levels.

Nodes page See Defining Node Properties.
Details page See Defining Tree Details.
Root Node page See Adding a Root Node.

Performance Options page

See Page Used to Select Performance Options.

Copy Tree page

See Copying Trees.

Tree Viewer page

See Viewing Trees.

Batch Report page

See Reviewing Audit Results.

Overview of PeopleSoft Trees

Trees depict hierarchical structures that represent a group of summarization rules for a particular database
field. For example, a tree can specify how your manufacturing locations should be summarized, or rolled
up, for reporting purposes. Or a tree can show the reporting relationships within an organization by
specifying how the individual department should be summarized into territories, territories into regions,
and regions into countries. Similarly, a tree can categorize items in a catalog.

The summarization rules depicted in a tree apply to the detail values of a particular field: vendors,
departments, customers, or other values that you define. These detail values are summarized into nodes on
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the tree. The nodes may also be organized into levels to logically group nodes that represent the same type
of information or level of summarization.

For example, the values of the DEPTID field identify individual departments in your organization. You
use PeopleSoft Tree Manager to define the organizational hierarchy that specifies how each department
relates to the others — departments 10700 and 10800 report to the same manager, department 20200

is part of a different division, and so on. In other words, you build a tree that mirrors the existing
organizational hierarchy.

Your chart of accounts is another prime candidate for trees. You can create trees that specify how you
want to roll up accounts into summary ledgers or reports. You can create multiple trees, providing
different roll-ups for different views of your account data.

After you have defined an organizational tree, the system can use it in a variety of ways. For example:
* Reporting

When you want a report that summarizes results for a particular division or region, the system can
check against the tree to determine which departments to include. Without the tree, you’d have to
explicitly specify the departments that you wanted every time you created a report.

*  Summary ledgers

To create a summary ledger that summarizes account balances by department, the system refers to the
tree to determine the DEPTID values to include in the summarized ledger entries. (Summary ledgers
are used only in PeopleSoft Financials applications.)

*  Security

You can restrict user access to their divisions. The application tables tell the system what department
the user is in; the tree tells it what other departments are in the same division. (This use is appropriate
for PeopleSoft Human Resources applications only.)

Additionally, you can create different organizational trees for different purposes. Suppose you want

to group departments together differently for reporting and for security. Maybe you want to include

data from regional offices in your summary reports, but you do not want to give corporate users access
to regional employee records. In this case, you’d create two trees — a “departmental” tree that groups
departments by function, regardless of region, and a “regional” tree that groups departments by location.
Then you’d use one for reporting and the other for security.

Advantages of PeopleSoft Trees

By building trees, you give the system a single place to look for summarization rules. This centralization
enables you to define rules once and then use them throughout the system. For example, different reports,
ledgers, and security profiles might refer to parts of your company’s organizational chart. All these
objects can refer to the same predefined tree.

Trees make it easier to select and update values in reports, ledgers, or security profiles. Rather than
specify departments 8202, 8203, 8513, 8515, and 8663 in a report, you can specify the Lafayette branch,
which includes all these departments according to the tree. When the organizational structure changes,
you update the tree once rather than updating an untold number of reports, ledgers, security profiles, and
SO on.

Another advantage of trees is that they present summarization rules visually. Looking at a tree through
PeopleSoft Tree Manager, you can easily see how the values relate to each other.
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Related Links
“Understanding Restrictions on Method and Function Use” (PeopleCode Developer’s Guide)

PeopleSoft Tree Manager Business Processes

This process flow illustrates the PeopleSoft Tree Manager business processes.

Audit and Use TreeMover
Repair Trees {optianal )

Y

Create Trees Maintain Trees

Y

h 4

Each business process—that is illustrated in the previous process flow—is discussed in the appropriate
topics of this product documentation.

See Understanding Steps to Create Trees, Maintaining Trees, Understanding the Auditing and Repairing
of Trees, Understanding TreeMover.

PeopleSoft Tree Manager Implementation

PeopleSoft Tree Manager is automatically installed with your PeopleTools installation.

Before creating a tree, you should plan the tree that you want to create. You should also know which data
you want to expose in the tree.

After you have planned your tree, you can create the tree structure. After you have created the tree
structure, you can create the tree.

Other Sources of Information
This topic provides information to consider before you begin to use PeopleSoft Tree Manager.

In addition to implementation considerations presented in these topics, take advantage of all PeopleSoft
sources of information, including the installation guides, release notes, product documentations, red
papers, the Updates + Fixes area of My Oracle Support, and PeopleSoft's curriculum courses.
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Working with Tree Concepts

This topic provides an overview of working with tree concepts.

Understanding Tree Concepts

This topic discusses general concepts used by PeopleSoft Tree Manager, such as levels, effective dates,
and setlDs.

Tree Levels

Levels provide a way to organize tree nodes. In most trees, all nodes at the same level represent the same
kind of information. For example, in a tree that reflects the organizational hierarchy, all division nodes
appear on one level and all department nodes on another. Similarly, in a tree that organizes your product
catalog, the nodes representing individual products might appear on one level and the nodes representing
product lines on the next higher level.

Sometimes you want to be able to identify all of the nodes on the same level as a group, even when they
do not share the same parent. For example, you might create a PeopleSoft nVision layout that summarizes
the data for a division, then define a PeopleSoft nVision scope that creates one report instance for each
division, regardless of what company it is in. To allow you to refer to all the nodes at a level, PeopleSoft
Tree Manager enables you to name each level. You will use the level name when you define the scope for
your PeopleSoft nVision report (rather than identifying all the nodes individually). Naming your levels
gives you another way to “slice” the data in the tree. Level names can appear next to the node description.
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This example illustrates a tree with levels.

Chapter 2

Tree Manager
Last

BU or UKV QEBILM Audit Walid Tree

Effective Date 04/25/2000 Status  active

Tree Name QE PROJECTS Project Data
Save As Close Tree Definition Display Options Print Format Expaortto POFE

ALL PROJECTS =00001 =MILT_SAT

Collapse All | Expand Al First Page [EM 13 of 60

[ ALL_PROJECTS - All NASA Space Projects
- [ 00001 - Satellite Projects
. " [ COMM_SAT - Commercial Satellites
- lTISAT Wiy sateiites % i He B3 F B X X
= MILT_SPEC - Obtain Military Specifications
L= MILT_DESIGH - Design Military Satellite
L= MILT_COMNST - Canstruct Military Satellite
L= MILT_TEST - Test Military Satellite
i L= MILT_HAMDO - Handover of Military Satellite
00002 - Space Shuttle Praojects
00003 - Space Station Prajects
00004 - Telescope Projects
*- i 00005 - Space Probe Projects

n Last Page

For each tree structure, you can determine how trees use levels:

*  When levels are not used the nodes in the tree have no real hierarchy or reporting structure but do

form a logical summarization structure.

» Strictly enforced levels mean that the named levels describe each node’s position in the tree.

This is natural for most hierarchies. Strict levels have the following advantages:

* You can skip a level if a portion of the hierarchy does not have a node at that level.

* The appearance of your tree more precisely matches the real-life hierarchy.

* If you use summary ledgers in PeopleSoft General Ledger, you can also create summary trees,

which are based on levels in the corresponding detail tree.

» Ifyou decide later that you need to change a tree from strict levels to loose levels, you can do so.

You cannot change a loose level tree to strict levels, because the level names are not connected to

specific positions in the tree.

* Loosely enforced levels mean that the nodes at the same visual level of indentation do not all
represent the same kind of information, or nodes representing the same kind of information appear at

multiple levels.
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With loosely enforced levels, you assign a level to each node individually; the level is not tied to a
particular visual position.

This diagram illustrates an example of loosely enforced levels.

Corporation
Sales Division
Region
District
Department
Manufacturing Division
Plant
Line
Department

In the previous example, the first two levels are clear: Corporation and Division. However, within the
Sales and Manufacturing divisions, the structure is different. This tree could be created with strict levels,
but would become distorted because the Plant and Line levels would need to appear either "above" or
"below" the Region and District levels when in fact they are parallel. You could define a strict level

tree with a level name such as Plant/Region or even Level3, but this makes it harder to identify just

the regions, districts, and so on for reporting or other purposes. With loose levels, the plants within the
Manufacturing division can be referred to as a level independent of the regions in the Sales division.

In a loose level tree, the level is an attribute of the node and is only loosely related to its position.
The level becomes a way of identifying a group of nodes that serve a common function within the
organization.

For most trees, you will want to use levels. Consider the following reasons before selecting the Level Not
Used option:

* You cannot add levels to a tree later.
» Ifyou use summary trees (generally used with PeopleSoft General Ledger), levels are required.

* PeopleSoft nVision enables you to build a report by nPloding the tree from a specified node to a
specified level.

This makes levels very useful on account hierarchies, for example.

Effective Dates

Using effective dates with trees enables you to specify new objects, departments, reporting relationships,
or organizational structures in advance and have them take effect automatically. You can also use trees
with past, present, or future effective dates when reporting on current or historic data.

Using Effective Date is required for all types of trees.

SetiDs

Most data in control tables is stored by setID. Trees can be identified by four key values: setID, user key
value, tree name, and effective date.

Copyright © 1988, 2024, Oracle and/or its affiliates. 19



Introduction to PeopleSoft Tree Manager Chapter 2

When using a setlD as a key value for your tree, you should assign the same setID as the record on which
your tree is built.

Note: You should not user key value for a newly created trees.

Related Links
Understanding Steps to Create Trees

Working with Effective Dates and Trees
Associating Trees with Additional SetIDs

Using Nodes

Nodes define the hierarchical relationship within the tree. Nodes can be either categories (as in a group of
assets) or items that need to be placed in a relationship with other items, such as an item in a catalog.

Each detail value reports to a tree node at the next higher level of the organization. Each tree node
represents the group of detail values that report to it. Referring to the node is a shorthand way of referring
to the group of detail values under it. For example, if a report refers to the Office of the President, it
includes data from all the detail values under the Office of the President node — including the detail
values under the Human Resources department, because Human Resources reports to the Office of the
President.

In turn, each tree node reports to another tree node at a higher level of organization until you reach the top
level of the hierarchy, called the root node.

Family Tree Terminology

Terminology derived from the idea of a family tree is used when talking about trees. The nodes that report
to the root node are called its children. They are also called child nodes. The root node is their parent.
Nodes that have the same parent are called siblings.

Using Detail Values (Leaves)

Detail values, or leaves, link a roll-up structure to the supporting detail. For example, the nodes in an
account tree are not the actual accounts but categories of accounts. Using this example, the account tree
has a node called Assets, with detail values specifying a range of accounts from 1000 to 1999 rolling up
to it.

The tree illustrated in the following example shows summarization rules for the PERSONAL_DATA
field. In other words, it is an organizational chart for the offices in a company’s headquarters. Individual
offices, such as 8200, represent the lowest level of organization and appear at the far right of the tree. The
leaves representing the offices are called detail values. Detail values have leaf icons and square brackets

[ ] surrounding their names.
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This example illustrates a personal data tree with detail values.

Introduction to PeopleSoft Tree Manager

Tree Manager
SetlD GEDMA
Effective Date 05/05/1987
Tree Mame QE_PERS_DATA

Last Audit
Status

Yalid Tree
Active

Personal Data Tree

Save Az Close

Tree Definition Display Options Print Format Export to PDF

= 00001 - Corporate Headguarters i = f
£ [3200] - ALBRIGHT

£ [3200] - VIMCENT

£ [3400] - WALTERS

S [B500] - DUNCAN

“ J [3600] - ELIAS

10100 - Office of the President
: 20100 - Office of the President (CDM)

[=] Motify

Il Last Page

8 of 132

First Page n

Related Links

Working with Tree Nodes
Working with Tree Branches

Understanding Types of Trees

This topic provides an overview of understanding types of trees.

Understanding Standard Detail Trees

In the most basic type of tree, the lowest level — that is, the level farthest to the right in the tree — holds
detail values. The next level is made up of tree nodes that group together the detail values, and each
subsequent level defines a higher-level grouping of the tree nodes. This kind of tree is called a detail tree.

In a detail tree, the lowest level in the hierarchy consists of the detail values, which are represented by
leaves; (these trees are sometimes called summer trees.) You can use a detail tree to represent account

hierarchies, product hierarchies, business unit hierarchies, and so on.

Detail trees are used most often for nVision reporting from the General Ledger.
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This example illustrates a detail tree.

Tree Manager

SetlD QEDMA LastAudit  vya)ig Tree
Effective Date 05/05/1997 Status  active

Tree Name CQE_PERS_DATA Fersonal Data Tree

Save As Close Tree Definition Display Options Print Format Exportto POF

ooood =20100

First Page [l 2of132 B8 LastPage

E 00001 - Corporate Headquarters
2 [3200] - ALBRIGHT

A [3300] - VINCENT

/F [3400] - WALTERS

/# [3500] - DUNCAN

/F [3600] - ELIAS

10100 - Office of the President

- &) Bofo0SOnceGrmepresigentieon = i+ R & B B X X

In this example, the Corporate Headquarters node is at the highest level and it has details such as
Albright, Vincent, Walters, and so on. These details are at the lowest level of hierarchy and in this case
denote individual employees in the Corporate Headquarters. Apart from details, this tree also has nodes
such as Office of the President and Office of the President (CDN), which itself contains details.

Understanding Dynamic Detail Trees

In a normal detail tree, the detail values that fall under each node are defined by a specific value or range
of values. With a dynamic detail tree, detail values are determined by matching the node name with a field
on the detail value table. The system dynamically determines appropriate values from the detail value
table at the time it uses the tree. Instead of specific or range of values, the detail values appear as blank on
the PeopleSoft Tree Manager display.

Note: Do not create trees that contain a combination of dynamic details and range details if the tree
is used by PeopleSoft Query or PeopleSoft nVision. Trees with this combination of details may yield
incorrect reporting results when used with these reporting tools.

For dynamic detail trees, the parent node value defines part of the primary key for the detail values.
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This example illustrates a dynamic detail tree.

Tree Manager

SetiD QEDM1 LastAudit  yalig Tree
Effective Date 01/01/1999 Status  active

Tree Name QE _DEPT _DYMAMIC Cynamic Detail Dept Tree

Save As Close Tree Definition Display Options Print Format Exportto PDF

0004 =10100 =10400

=

First Page [EM 210742 [ Last Page

"= 10400 - Retail Services % i K B B S

31 10300 - Controllers
""" 10200 - Human Resources

In the preceding illustration, each node represents a value of the DEPARTMENT _ID field. The structure
of the tree determines the relationships between departments and their groups, so that your reports can
roll up department data. Departments are not the lowest level of detail, though. Each department consists
of employees, and when you assign a department cost, you assign it to a particular department and an
employee. These two fields, DEPARTMENT _ID and EMPLID, are both key fields for the department
data. So to capture these costs, the department tree needs to group the employees for each department.
That is where the detail values come in.

The detail values in this tree represent values for EMPLID. Rather than listing each EMPLID value
separately, however, you tell PeopleSoft Tree Manager to use all of the employees associated with the
parent DEPARTMENT _ID. For example, if you ask for a report on the RETAIL SERVICES department,
the system will roll up the data whose DEPARTMENT _ID is RETAIL SERVICES and whose EMPLID
is any value.

You can select to display all detail values for a selected node or to display detail values based on the tree’s
current effective date.

See Defining Summary Tree Details.

© 1988, 2024, Oracle and/or its affiliates. 23



Introduction to PeopleSoft Tree Manager Chapter 2

Understanding Node-Oriented Trees

In standard detail trees, the detail values represent data values from a database field, and the tree nodes
represent roll-up points for detail values. The nodes have no meaning outside the context of the tree.
However, you can also create node-oriented trees.

Node-oriented trees are based on a detail structure, but the detail values are not used. For this type of tree,
the tree nodes represent the data values from the database field. The system uses node-oriented trees for
special purposes. For example, PeopleSoft HRMS applications use the Departmental Security tree to give
users access to information only about employees in their departments.

This example illustrates a node-oriented tree.

Tree Manager

SetlD QEDMZ Last Audit  qiig Tree

Effective Date 01/01/2001 Status  active

Tree Name QE_DEFT_SEC DERPART SECURITY
Save As Close Tree Definition Display Options Print Format Export to POF

GEOSTCORP »FLORIDA =F02

Collapee All | Expand Al Find First Page Bl 60 0f7274 I Last Page

E GEOSTCORP - CORP Level Mode

E FLORIDA - Florida

. " [ F01- Central Florida

= 702 - Management (Aflanta) 2o e B8 F B X %
Cl= FOZ26089692 - Treasury

Cl= FO26089691 - Treasurers Department
L= FOZ9691 - Treasurers Department

“l= FO20608969 - Closed - Treasurer's Dept
[=F FOS - Mature Coast

= F058999 - Default for Conversion

"= FO50580099 - Elfers Office

"= FO50880099 - Chelsea Place Office

Note: In this example, Florida is a node at the top level which has subnodes of Central Florida, Atlanta,
Nature Coast, and so on. These nodes in turn have nodes such as Treasury, Treasurers Department, and so
on. None of the nodes have leaves.

Node-oriented trees have no leaves, and are sometimes called winter trees. Instead, each node is a
possible value of the DEPTID field.

Understanding Summary Trees

24

Summary trees are generally used for General Ledger reporting. A summary tree provides an alternative
grouping of the nodes from a detail tree without duplicating its entire structure. In a summary tree, the
detail values are tree nodes from an existing detail tree rather than values from a database field. The tree
groups the nodes from a specific level in the detail tree differently from the way it groups the higher
levels in the detail tree itself.
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For example, suppose you want to roll up your departmental hierarchy differently for two reports. The
first report shows the reporting structure, so you want to group your departments according to the division
to which they report. The second report is a financial report, showing profit centers, overhead centers, and
production centers. From the group level down, the two hierarchies are the same.

You have two options:
1. Create two complete detail trees that are identical from the group level down.

2. Create one complete detail tree, then create a summary tree whose detail values are the group-level
nodes on the first tree.

This example illustrates a summary tree.

Tree Manager

SetlD QEDNMZ LastAudit  3jid Tree
Effective Date 01/01/1900 Status  active
Tree Name QE_ACCOUNTS COA Hierarchy
Save Az Close Tree Definition Display Options Print Format Exportto PDE

ALL ACCOUNTS »BALANCE SHEET »TOTAL ASSETS *EARMING ASSETS =INT BEAR REDEPOSITS

Collapse All | Expand Al Find First Page [l 460724433 Bl Last Page

[ZF ALL_ACCOUNTS - ALL_ACCOUNTS

IMCOME STATEMEMT - INCOME STATEMEMT
[=F BALANCE SHEET - BALANCE SHEET

E TOTAL ASSETS - TOTAL ASSETS

[ EARNING ASSETS - EARNING ASSETS .
- 2 [NTBESRREDEFOSITSINT BEARREDEPOSITS & i+ He & B 4 B X X

B 1121 - 1124

B 1125- 1125
1161 - 1164
" [1161000010] - ACCOUNT : 1181000010

JZ [1161000018] - ACCOUNT : 1161000018
S 1116100999B] - ACCOUNT - 1161009998
S [116109374F] - ACCOUNT - 116109374F

S [116109518F] - ACCOUNT : 116109518F

When you use a node from a summary tree in a report or summary ledger, the system refers back to the
detail tree to determine which detail values report to that node. For example, suppose you want to report
on production centers. You have created a summary tree that shows which groups are production centers,
and you pick the Production Center node. The summary tree shows that the Engineering group and the
Manufacturing group (among others) are production centers, but it does not show which departments are
in these groups. The system uses the detail tree to determine the departments in the group.

Summary trees make it easier to maintain trees. If you change the lower part of the tree, you need to
update only one tree.

The most common use of summary trees is to create summary ledgers in PeopleSoft Financial Data
Management applications. You create summary trees based on your basic ChartFields to create
alternative roll-ups. You create reports based on the various summary trees to view your financial data
from a variety of perspectives.
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Working with Effective Dates and Trees

This topic provides an overview of working with effective dates and trees.

Understanding Interactions Between Tree and User Data Effective Dates

User data are information collected from customers. When user data also has an effective date on key
record, PeopleSoft Tree Manager checks that date to determine which dated record item belongs in the
current dated tree. When only one dated item is in the user table, then the date determines whether that
item is available for use in the tree at all.

Trees and user data differ in how effective dates are considered in respect to the current date and when the
tree and the data come into scope. The rules are:

» The tree’s effective date is the good through date for the tree’s representative organization.
» The user data item’s effective date is the good from date for the user data.

Therefore, in a particular tree, the nodes and details valid for that tree must have an effective date on the
user data record earlier or the same as the effective date on the tree.

The following table presents an example of an effective-dated tree with a user table that has three
effective-dated records for the same item.

Tree Effective Date User Item Effective Date User Data Available to Tree?
12-31-2005 12-01-2005 Yes
12-31-2005 01-01-2006 No
12-31-2005 01-31-2006 No
12-31-2005 04-01-2006 No

The following table shows the actions when the tree is copied to a new effective date, with the same user
data records.

Tree Effective Date User Item Effective Date User Data Available to Tree?
02-28-2006 12-01-2005 Yes
02-28-2006 01-01-2006 Yes
02-28-2006 01-31-2006 Yes
02-28-2006 04-01-2006 No
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This diagram illustrates a graphical representation of user data and tree effective dates.

12/01/2005 01/01/2008 01/31/2006 04/01/20086
User Data Item : ! : :
is 1
good from: < | < | : <, . | <

i [ i

I ol 1

[l 1 1 1

Tree is good | | >
through: : : : :

12/31/2005  02/28/2006

Using Effective-Dated User Records

PeopleSoft trees are a hierarchical structure made up of the tree’s definition along with the nodes and
details (Ieaves) that form the parent-child relationships in the tree. The nodes and details are tied in to a
user record as defined in the tree structure.

When the user record has an effective date as a part of the record’s key, then that effective date determines
the criteria used for details and nodes available for use in the tree.

Related Links
“Using Effective Dates” (Applications User’s Guide)

Using Effective-Dated Trees

Trees must have an effective date. Effective dates on trees show planned changes in the hierarchy the tree
represents.

For example, in the HR Department tree, you want to add a new Hardware department effective
09/01/2001. You do this by copying the current HR Department tree to a new effective date of
09/01/2001, opening the new tree, and adding the Department node for Hardware.

When the current date reaches 09/01/2001, then the HR Department tree with the Hardware department
will become effective for application and reporting purposes, and the previous effective date version of
the HR Department tree will be a copy for historical purposes.

Associating Trees with Additional SetlDs

PeopleSoft applications store information in two types of tables: transaction tables and control tables.
Information in transaction tables is typically stored by business unit, while control table information is
stored by a set identifier, commonly called the setID.

Transaction tables store data about day-to-day business activities. As such, these tables are updated
frequently.

Control tables store information that defines the accounting and organizational structures and processing
rules that are used when business transactions are entered into PeopleSoft applications. Control tables
include master lists, such as customers, vendors, products, items, and charts of accounts. These tables are
generally static, and many are effective-dated.
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A tableset is a subset of data within the control tables that defines the accounting structure and processing
rules for a particular business unit or group of business units.

Trees are typically hierarchies built on top of control tables, and so you usually will want to key your tree
by setID if the underlying control table is keyed by setID.

Note: Because PeopleSoft Projects data is stored in tables keyed in by business unit rather than setID,
PeopleSoft Project trees may be keyed by either setID or business unit, depending on the tree’s function.

See the PeopleSoft Application Fundamentals documentation.

Sharing Trees Across SetlDs

Use the Tree page to associate a specific tree with a given set control value.

Navigation:

PeopleTools > Utilities > Administration > Maintain TableSet Controls > Tree

This example illustrates the fields and controls on the Tree page.

Record Graup

Set Control Value: CIEBLU

*Default SetlD: QEDMT &

Tree Controls Customize | Find | view a1 [ 20| 88 First B0 4 o 1 B Lot

*Tree Hame Description *SetiD Short Description
|QE_QRY_TREE Q QEDM'Q Setld 1 E|

PeopleSoft applications use the default setID on the tableset Record Group page to determine which trees
a business unit can access. This default setID is established when the business unit is created. However, if
you want a business unit to be able to access a particular tree created under a setID other than the default
setID, you can specify the tree on this page.

The setID you define for a tree should typically match the setID defined for the underlying record.

The Record Group page of the TableSet Controls component defines which setID is used for a specific
record group.

For example, if the PRODUCT TBL record is part of REC_GROUPA, and on the Record Group page
you have associated BU = CCB, Rec. Group = REC_GROUPA, and SetID = FS, then you should also set
up any trees based on PRODCT TBL so that BU = CCB and uses SetID = FS.
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Working with the Multiuser Environment

When the multiuser environment is enabled, PeopleSoft Tree Manager enables multiple users to work in
the same environment and on the same tree or branch without the risk of losing individual work due to
version control.

Note: PeopleSoft delivers PeopleSoft Tree Manager with the multiuser environment disabled. When
you enable the multiuser environment for PeopleSoft Tree Manager, you also enable the multiuser
environment for Query Access Manager.

See “Building Query Access Group Trees” (Security Administration), “Using Query Access Group Trees”
(Query).

The following example explains how PeopleSoft Tree Manager works when the multiuser environment is
enabled:

User A, User B, and User C open the QE. ACCOUNTS tree at around the same time and can view only
the tree without making any changes. During this time, Mode: Display appears at the top of the tree's
page for all users, notifying them that the tree is in display mode. If User A wants to make changes to the
tree, she must reserve the tree for editing. After she reserves the tree, Mode: Edit appears at the top of her
QE_ACCOUNTS tree page, confirming that the tree is in edit mode for herself only. However, Mode:
Display (Checked Out by User A) appears at the top of User B's and User C's QE_ ACCOUNTS tree page,
notifying these users that the QF ACCOUNTS tree page is currently being edited by User A.

While User A has the tree in edit mode, only User A can edit the tree. Although User B and User C
cannot edit the tree, they can still perform many actions. The following table describes the actions users
can perform on trees in the multiuser environment, using this example. The first column lists the action.
The second column denotes whether the action is available to User A while she has the QE. ACCOUNTS
tree reserved. The third column denotes whether User B and User C can perform the action on the

QE_ ACCOUNTS tree while User A is editing the tree:

Action Available to User A Available to User B and User C
Edit the tree definition. Yes No
View the tree definition. Yes Yes
Edit the application data. Yes Yes
Edit the tree. Yes No
Display the tree. Yes Yes
Navigate around the tree. Yes Yes
Change navigation options. Yes Yes
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Action Available to User A Available to User B and User C
Change display options. Yes Yes

Save the tree. Yes No

Save the tree with different keys(tree Yes Yes

name, effective date, and so on).

After User A releases the tree, it reverts to display mode for all users. It also reverts to display mode if
User A does not perform any action on the tree for the length of time as defined in the time-out setting.

Note: When the multiuser environment is enabled, the display of the checkout mode and editing user
will not be visible to users with view-only access. It will also not be visible to users working in the Tree
Viewer module or to users accessing Tree Viewer pages through other applications.

Performing an Update or Cancel Due to a System Prompt

During the time a user has a tree in edit mode, other users who have the same tree in display mode will be
required to either reload the tree or cancel out of the tree if the editing user performs any of the following:

* Branches a tree without existing branches.

* Deletes the last remaining branch of a tree.

* Deletes the branch that has been opened by one of the other users (for example, User B or user C).
» Saves the tree and releases it after performing the save.

If the user selects to reload a tree, PeopleSoft Tree Manager tries to open the tree at the node or leaf on
which the user worked. If this is not possible, PeopleSoft application opens the tree at the first page of the
tree.

Adding New Levels or Modifying Tree Definitions

When the multiuser environment is enabled, users can only add new levels or perform modifications to a
tree definition when the root branch is checked out and the tree has no other checked out branches.

Note: When the multiuser environment is enabled, a user cannot check out a tree branch if another user
working with a different branch of the same tree has modified the tree definition and either Aas or has not
saved the changes.

If users edit specific branches without modifying the tree definition, other users can still edit different
branches of the same tree at the same time.

Enabling the Multiuser Environment

Before enabling the multiuser environment, you must assign a unique user ID to each user. If you are not
using the multiuser environment, you can use a shared user ID; however, this is not required.

To enable the multiuser environment:

Copyright © 1988, 2024, Oracle and/or its affiliates.



Chapter 2

Introduction to PeopleSoft Tree Manager

Select PeopleTools > Utilities > Administration > PeopleTools Options.
In the Tree Manager Options group box, select the Use Tree Update Reservation option.

In the Max Tree Inactivity Period, min field, enter the number of minutes allowable for a user to
remain inactive during edit mode.

In PeopleSoft Tree Manager, inactivity is defined as not performing any operation. Minimal actions
including navigation and clicking on tree entries or action images are considered to be active. If the
user is inactive for the set number of minutes, the tree or branch reverts to display mode.

Note: PeopleSoft recommends that you set the inactivity period at less than or equal to the browser
time-out settings.

Reboot the application server.

Note: You must reboot the application server after enabling or disabling the multiuser environment
and after changing the inactivity period in order for these changes to take effect.

If a tree is opened in display mode, users can still modify user data such as node or leaf descriptions.
If a tree is branched, users can check out different branches independently.

See “Building Query Access Group Trees” (Security Administration), “Using Query Access Group Trees”
(Query).
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Opening Trees

This topic discusses how to search and organize trees.

Searching for Trees

After you have your browser open in PeopleSoft Pure Internet Architecture, navigate to PeopleSoft Tree
Manager (PSTREEMGR) so that you can view or modify trees.

To open a tree:
1. Select Tree Manager > Tree Manager.
The Tree Manager search page appears.
2. In the Search By drop-down list, select a value to search by.

Alternatively, click the Advanced Search link to search for a combination of values, such as Node
Record Name, Detail Record Name, Structure Name, Tree Category, and so on.

3. Click the Search button.
The system displays a list of the trees that match the data that you have entered.
4. Click the tree name link for the tree that you want to open.

Related Links
“Using Search Pages to Retrieve Data” (Applications User’s Guide)

Organizing Trees

Use the Tree Manager search page to organize trees and narrow search criteria by assigning trees to
categories that you define.

Navigation:

Tree Manager > Tree Manager
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This example illustrates the fields and controls on the Tree Manager search page.

Chapter 3

Tree Manager

Find an Existing Tree

Create Mew Tree

* Search Criteria

Enter any infarmation you have and click Search. Leave fields blank for a list of all values.

Tree Name: begins with |

Search Results

QE _ACCOUNTS

QEDMZ (hlank)

QE_ACE_848 EMPL

QEDCM1 (blank)

QE_ACE_AFTREE

QEDM1 (blank)

QE_ACE_DGC_BU

QEDM1 (blank)

QE _ACE DGC _DEPT

QEDM1 (blank)

QF _ACE _DGC DTRG1

QEDM1 (blank)

SetiD: begins with || Q
Set Control Value: | begins with v|
Effective Date: | = | | El
Tree Branch: hegins with |
Description: hegins with |
Category: kegins with | &)
Tree Structure ID: | begins with | QL
Valid Tree: | = v| | v|
Node Field: begins with | Q
Detail Field: beging with + | Q
[Ocase sensitive

Search ‘ Clear |Elasic Search [E] Save Search Criteria

First JfJj 1-200f20 |fJ Last

SetlD |Set Control Value |Effec Date | Tree Branch|Description Category (Valid Tree

01/011900  (blank) COAHierarchy QEDMO  Valid Tree
01/01/1900  (blank) ACE 848 Employee Tree  QEDMO  Valid Tree
01/011900  (blank) QE ACE All Function Tree  QEDMO  Valid Tree
01/011900  (blank) BU Tree for DGC Model  DEFAULT Valid Tree
01/011900  (blank) Dept Tree for DGC Model DEFAULT Valid Tree
01/01/1900  (blank) Date Range QEDMO  Valid Tree

Categories are defined on the Tree Definition and Properties page. Categories must conform to the same
character limitations as the tree name. Category names cannot exceed 18 characters and should not
contain special characters suchas/, |, * :, “, <, >, and |.

Note: There are no edit checks to verify a category’s existence — if the category does not exist, PeopleSoft
Tree Manager adds a new one.

Navigating PeopleSoft Tree Manager

This topic gives an overview of navigating PeopleSoft tree manager.

Using the Navigation Bar

Use the Tree Manager page (PSTREEMGR) to view or modify trees. This page displays the tree with the
root node expanded one level.

34
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Navigation:

Tree Manager > Tree Manager

Using PeopleSoft Tree Manager

This example illustrates the fields and controls on the Tree Manager page. Definitions for the fields and

controls appear following the example.

Tree Manager
SetlD QEDMA Last Audit a5 Tree
Effective Date 05/05/1997 Status - active

Tree Hame QE_FPERS_DATA Fersonal Data Tree

Save Az Close Tree Definition Display Options Print Format Exportto POE

First Page Bl 2o0f132 Bl Last Page

(% 00001 - Corporate Headquarters ~ ti+ 5 4
- 2 [8200] - ALBRIGHT

B [3300] - VINCENT

- 2 [8400] - WALTERS

¥ [8500] - DUNCAN

9 [8600] - ELIAS

10100 - Office of the President
: 20100 - Office of the President (CDM}

[=] Notify

Note: PeopleSoft Tree Manager displays one page of the tree at a time. You can navigate through large

trees using First Page, Next Page, Last Page, and so on.

You can perform the following actions on the selected tree by using the links and images on the
navigation bar — the horizontal blue bar at the top of the tree.

Field or Control

Description

Collapse All

Click to close all of the visible nodes except for the root node.
The root node is always expanded.

Expand All

Click to expand all of the nodes on the tree, so that the entire
tree or branch hierarchy is visible.

Expands all parent/child relationships, but the tree hierarchy

is still presented one page at a time. Use the Next Page and
Previous Page arrows to move forward and backward through
the tree.

Find

Click to access the Find Value page and search for nodes and
detail values.
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Field or Control Description

Notify Click to send an email containing a link to the tree to an
individual or group with whom you are currently working.
You can attach a message to this email to describe a specific
transaction.

See “Sending and Receiving Ad Hoc Notifications”
(Applications User’s Guide).

Note: PeopleSoft Tree Manager is delivered with the Notify
button enabled. You can disable this button in PeopleSoft
Application Designer.

See “Enabling the Notify Toolbar Button” (Workflow
Technology).

Related Links
“Understanding Grids and Scroll Areas” (Applications User’s Guide)

Using Navigation Paths

36

As you navigate through your tree, navigation paths appear above the navigation bar. They show you
the parent/child relationships between the currently-selected object and its parents. Navigation paths can
provide you with a basic map of your route through the tree.

When you hover your cursor over a navigation path, a tooltip appears that identifies whether the
navigation path is a link to a branch or a node.

Navigation path represent nodes in the current branch (A type nodes) and the parent branch of the opened
branch (B type nodes).
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In this illustration, node TOTAL REGION is the parent branch of AMERICAS; AMERICAS is the parent
node of NORTH AMERICA and SOUTH AMERICA; and NORTH AMERICA is the parent node of
402-NAM.

Tree Manager

SetlD LastAudit  ya)ig Tree
Effective Date 03/01/2000 Status  active

Tree Name QE_CUBT_REGION For Cube Manager Testing

Save As Close Tree Definition Display Options Print Format Exportto POFE

TOTAL REGION =AMERICAS =NORTH AMERICA =Detail

Collapse All | Expand Al Eind FirstPage B 2of11 Bl Last Page

E TOTAL REGICH - Total region

- 31 EUROPE - Eurape

_ ASIA - Asia
[= AMERICAS - Americas
[= SOUTH AMERICA - South America
L P [403]- SAM
[=F NORTH AMERICA - North America
- P EogoNEN B B §F = X

[=] Hotify
The maximum number of entries in a navigation path displayed is seven. When you start exceeding that

number, the system automatically removes the earlier ancestor nodes. This ensures that navigation paths
always begin with the parent node of the currently selected node.

Expanding and Collapsing Nodes

You can collapse any node at any level to give you a better overview of the entire tree. Closed yellow
folders indicate that you can expand the node to show additional nodes and detail values. Closed gray
folders indicate a node that has no children — either child nodes or detail values. Open yellow folders

indicate a node that has been expanded and is showing child nodes or detail values.

To expand a node one level, click its folder image. Click the folder image again to collapse the node.

To expand all child objects for a node, first select the node, and then click the image with two folders,
located to the right of the node description.

Note: Expanding all child objects (node hierarchy) can be a time-consuming process. The more levels in
the node hierarchy, the longer the process will run. A warning message appears if your process might take
a long period of time to run.

Searching for Nodes or Detail Values
Use the Find Value page (PSTREEMGRFIND) to find a specific node or value.

Navigation:
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1. Select Tree Manager > Tree Manager.

2. Search for an existing tree or create a new one.

Chapter 3

3. Select a tree on the Tree Manager page and click the Find link.

This example illustrates the fields and controls on the Find Value page. Definitions for the fields and

controls appear following the example.

Find Value

Find Tree Node

Tree Mode: |

Description: |

QOR

Find Detail value

Product ID: |

Description: |

[Icase Sensitive Search

Exact Matching

Find |

Zlose |

Note: The actual labels on these fields change depending on the default labels defined for the column
used for the node or detail values. For example, in the Department Security tree, the label for the node

values reads Department ID.

Field or Control

Description

Tree Node

Enter the tree node name and click the Find button. A newly
created node will not be listed in the Node List until a Save is
performed. However, if you enter the exact name of the newly
created node and click the Find button, the node will be found.
Search results of the newly created nodes do not depend on
selecting or clearing the Exact Matching option.

Description

Enter the tree node description and click the Find button.
When searching by description, the system does not locate
newly created nodes until a Save is performed.

38
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Field or Control Description

Detail Value (EmplID) and Description (Last Name) Note: In this example, the Detail Value field appears as

EmplID and the Description field appears as Last Name.

Enter a detail value or description and click the Find button.

When searching by value, if a detail value is defined as a range
of values, then the system looks for the detail values that the
entered value falls under.

If the detail value is defined as a specific value, then the
system looks for detail values that begin with or match the
value entered.

If a user types in the exact name of the newly created detail
value and clicks the Find button, the detail value is found.
Search results of the newly added details do not depend on
selecting or clearing the Exact Matching option. If the tree
features the Duplicate Leaves option, only the first occurrence
of the newly added detail value will be found.

Note: When searching for detail values that involve a range
of values or duplicate values, the system may not find a detail
value that has been recently added or changed until a Save
has been performed. The results of this operation depends on
database sorting options and database type.

Case Sensitive Search Select to use the case-sensitive search option for descriptions.

This option is not used for node or detail names, because they
are key fields, which PeopleSoft Tree Manager automatically
changes to upper case.

Exact Matching Select to search for an exact match. Clear this option to
perform partial searches.

If you clear this option, the system automatically adds a
wildcard character at the end of the user defined search
condition. If you want to use a wildcard search by applying a
wildcard character at the beginning of the word, you need to
use the database-specific wildcard character.

You receive a warning message if you cleared this option
and your search criteria was too broad — more than 200 rows
returned.

If PeopleSoft Tree Manager finds a node or detail value that matches your search string, it displays the
node or detail value and builds navigation paths to show the navigation path to the entry found.

Note: If the value for which you are searching is contained inside a detail range, PeopleSoft Tree
Manager displays the appropriate range. Click the Edit Data image to display the list of values contained
in that range. Keep in mind that detail values are stored as strings, so if your values are identified by
numbers, the range may include more values than expected.
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PeopleSoft Tree Manager finds the first occurrence of the node or detail value that matches your search
string and highlights it. If duplicate values exist, click Next to search for the next occurrence of the value.

When the next occurrence has been found, the Previous link become available.

If you enter values or descriptions in more than one field on the Find Value page, the system uses the
higher located field as a search condition and ignores the lower fields.

Related Links

Working with Detail Values
“Using Wildcard Characters to Find Information” (Applications User’s Guide)

Using the Line Counter

PeopleSoft Tree Manager's line counter provides an automatic count of the numbers of lines of a tree that
are currently displayed. In this example, the line counter displays /4 of 24433, telling us that 14 rows are
currently displayed out of a possible 24433 rows available in the tree. The line counter does not provide
information on the position in the tree of the displayed lines.

Example of line counter that provides number of rows currently displayed.

Tree Manager

SetlD QEDMZ LastAudit  vyajig Tree
Effective Date 01/01/1200 Status  Active

Tree Name QE_ACCOUNTS COA Hierarchy

Save As Close Tree Definition Display Options Print Format Exportto PDF

ALL ACCOUNTS =INCOME STATEMENT =NET IN

L COMM =NET INCOME =PROFIT CONTRIBUTION =NOM INTEREST REVENUE

Collapse All | Expand Al Find First Page JEl 140724433 [l Last Page|

[ ALL_ACCOUNTS - ALL_ACCOUNTS

2 INCOME STATEMENT - INCOME STATEMENT

E R NET ING AVAIL COMM - NET ING AVAIL COMM

[ NET INCOME - NET INCOME

[ PROFIT CONTRIBUTION - PROFIT CONTRIBUTION

NGNINTEREST REVENUENONINTERESTREVENDE % o #e & B F E X #&
NET INTEREST INCOME - MET INTEREST INCOME

PROV FOR LOAN LOSSES - PROV FOR LOAN LOSSES

NON INTEREST EXPENSE - NON INTEREST EXPENSE

B TOTAL TAXES - TOTAL TAXES

""" FREFERRED DIVIDEMNDS - FREFERRED DIVIDENDS

BALAMCE SHEET - BALAMCE SHEET
STATISTICS - STATISTICS

""" HISTSTAT - HISTSTAT

Notify

Working with Tree Nodes

40

This topic discusses how to work with tree nodes.
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Describing Tree Nodes

A node in PeopleSoft Tree Manager has three parts: the node image, the node name, and a node
description.

In this example, the node is collapsed, so the folder image is closed. The node name is 10600, and the
node description is Branch Office Administration.

10600 - Branch Office Administration

In this example, the node skips a level.

20300 - Controller (COMN) - Level . DEPARTMENT

To display images for working with nodes, click the description or node name.

This example illustrates Node with editing images. Definitions for the images appear following the
example.

WESTERN-Westempegion == i+ he & & & B X %

This is a complete list of node editing images. When you highlight a node, only the images representing
the available actions appear:

Field or Control Description
@ Click the Expand Node Hierarchy icon to expand all child

objects for the selected node.

Click the Insert Child Node icon to insert a new node that
will be a child of the currently selected node.

=
|
=

v Click the Insert Sibling Node icon to insert a new node that
will share the same parent as the currently highlighted node.

=
=
+

Click the Insert Detail icon to insert a new detail value.

]

This icon is available only if the detail value information has
been entered on the Tree Structure Detail page.

Click the Update Node Properties icon to display the Node
Properties page, which enables you to change the level of a
node or rename a node.

Al

Click the Edit Data to display a page for maintaining or
editing the application data for the node. The table that stores
the data is defined on the Tree Structure Maintenance page.
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Field or Control

Description

Click the Delete Node icon to delete the selected node.

Note: If you delete an object that has child nodes, all of its
child nodes will also be deleted.

Click the Cut icon to cut one or multiple tree nodes or tree
leaves, and then use the Paste as Sibling or Paste as Child
icons to paste all cut tree nodes or tree leaves at once as
children or siblings.

When you perform cut and paste in Tree Manager, note that:

* A node can be pasted as a sibling or child of a node, but a
node cannot be pasted as sibling of a leaf.

*  Aleaf can be pasted as a child of a node or sibling of a
leaf, but a leaf cannot be pasted as sibling of a node.

* A node cannot be pasted as a child or sibling of its own
children. When a node is cut, the Paste icon is available

with any of its children.

*  The Cuticon in a node or a leaf is not available if its
parent is cut.

*  Moving a node moves all its children (child nodes and
leaves) along with it.

*  Root node and branched node cannot be cut.

Note: This icon is not available for dynamic detail leaves.

Click the Paste as Sibling icon to paste a cut node into the tree
as a sibling.

Click the Paste as Child icon to paste a cut node into the tree
as a child.

Click the Branch icon to subdivide that part of the tree into
a separate component that can be maintained and viewed
separately from the main tree.

Click the Open Branch icon to open the selected branch in
PeopleSoft Tree Manager.

Click the UnBranch icon to remove the selected branch and
PeopleSoft Tree Manager replaces the branch image with the
node image. Any nodes that report to the selected node are
now available in the tree.
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Inserting Nodes

Note: You cannot define a sibling or child node with an effective date greater than the effective date of
the tree.

To insert a node:

1.

2.

Select Tree Manager > Tree Manager.

Search for an existing tree or create a new one.

On the Tree Manager page, highlight a node.

Click either the Insert Child Node or Insert Sibling Node icon.

In the Tree Node ficld, click the prompt button to find the node name to insert.
Enter the node name or select the node from the list.

The Insert Child Node or Insert Sibling Note page appears with the selected value.
Click the Add button.

If you entered values that have already been defined in the User Node data record (table) but was not
a part of the tree, PeopleSoft Tree Manager adds the values to the tree when you click the Add button.

If you enter new values, PeopleSoft Tree Manager opens a User Node data page, where you can add
a new value. If a new value is successfully added to the database, Tree Manager adds that value to the
tree.

If the node you specified already exists in the tree, the system displays an error pointing to the
duplicate node.

Moving Nodes

To move a node using cut and paste:

1.

2.

Select Tree Manager > Tree Manager.

Search for an existing tree or create a new one.

In the Tree Manager page, highlight the node and click the Cut icon.

Select the destination node and click the Paste as Sibling or Paste as Child icon.

The node is pasted into the position that you specified. Remember that you cannot insert a child node
into a branch node, insert a sibling node into a root node, or insert a parent node into its child.

PeopleSoft Tree Manager moves the entire part of the tree starting at the selected node. If the moved
node has nodes or detail values reporting to it, they also move to the new position.

Note: You cannot move branched nodes.
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Levels Behavior When Nodes are Moved

The following are general rules used for levels when nodes are moved:

Chapter 3

* Tree with strictly enforced levels: The parent node must always be at a higher level than its children.

* Tree with loosely enforced levels: No rules are enforced; therefore, levels of the descendant nodes
should be manually adjusted by using the switch level function on the pasted node.

The following table shows the basic behavior of levels when cutting and pasting nodes.

Action

Strictly Enforced Levels

Loosely Enforced Levels

Moving node to a higher level.

Levels of the pasted node and its

children are not automatically adjusted.

The pasted node appears as a skipped

node.

(Node image changes to a skipped node

image).

Levels of the pasted node and its

children are not automatically adjusted.

The pasted node appears as a regular
node.

Moving node to a lower level.

To ensure that the parent node is always
at a higher level than its children,
PeopleSoft Tree Manager automatically
adjusts the level of the node and its
children.

The levels of the pasted node and its
children are not adjusted.

Note: New tree levels are not automatically created in non-root branches when a tree node is moved or a

new tree node is added.

Related Links
Using Drag and Drop

Switching Node Levels

Use the Node Properties page (PSTREENODELEVELS) to change node levels, change node properties,

and rename nodes.

Navigation:

1. Select Tree Manager > Tree Manager.

2. Search for an existing tree or create a new one.

3. Select a node on the Tree Manager page and click the Update Node Properties icon.

44
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This example illustrates the fields and controls on the Node Properties page.

Mode Properties

Mode Properties

Tree Node: 10100
New Name: | Q, Rename |
Mode Level Settings
Current Level:  COMPANY COMPANY
Customize | Find | ® | | EI| Firzt 4] 1-4 of 4 n Last
Current |Level Hame All Values Description View Detail (Switch level |Delete
COMPANY F COMPAMNY Wiew Detail  Switch Level  Delete
DIMISION F DIVISION Wiew Detail — Switch Level Delete
DEPARTMENT (] DEPARTMENT Wiew Detail — Switch Level  Delete
BRAMCH F BRAMNCH Wiew Detail — Switch Level Delete
Ok Add Level

In the Node Properties page, click the Switch Level link associated with the level to which you want to
change the node. Then the node level information is updated and changed. The node level is indicated by
the green arrow.

Levels Behavior When Switching Node Levels
The following are general rules used when switching node levels:
» Tree with strictly enforced levels: The parent node must always be at a higher level than its children.

* Tree with loosely enforced levels: The parent node must be at the same or higher level than its
children.

The following table shows the basic behavior of levels when the switch node level function is used.

Action

Tree with Strictly Enforced Levels

Tree with Loosely Enforced Levels

Switching node to a higher level.

Only available for skipped nodes.

Can only ascend the number of levels

that have been skipped.

PeopleSoft Tree Manager automatically
adjusts the levels of the child nodes. For
example, if the parent node is switched
two levels, the children are automatically
adjusted two levels.

Only available for skipped nodes.

Can only ascend the number of levels

that have been skipped.

Levels of the child nodes are not

automatically adjusted.
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Action

Tree with Strictly Enforced Levels

Tree with Loosely Enforced Levels

Switching node to a lower level.

To ensure that the parent node is always
at a higher level than its children,
PeopleSoft Tree Manager automatically
adjusts the level of the node and its

children.

PeopleSoft Tree Manager will
automatically create additional levels, if
necessary.

The levels of the pasted node and its
children are not adjusted.

Note: If the switch results in a child node
level becoming higher than its parent,
PeopleSoft Tree Manager automatically
adjust the level to be equal to the level of
parent.

PeopleSoft recommends that when
switching levels, you should switch to

just one level at a time.

Use the Tree Node Maintenance page (PSTREENODEUPDATE) to edit node descriptions and other data.

To change the description of a node:

1. Select Tree Manager > Tree Manager.

2. Search for an existing tree or create a new one.

3. Access the Tree Node Maintenance page by selecting a node in the Tree Manager page, and clicking

the Edit Data icon.

The page that appears here is defined by application.

4. Update the value in the Description field.

5. Enter the new date as well as a new description.

6. Click the OK button to accept changes and return to the Tree Manager page.

Note: Tree node descriptions will not be visible if the effective date of the tree is earlier than the effective

date of the node.

Deleting Nodes

46

To delete a node:

1. Select Tree Manager > Tree Manager.

2. Search for an existing tree or create a new one.

3. Highlight the node in the Tree Manager page, and click the Delete icon.

Note: If you delete an object that has child nodes, all of its child nodes will also be deleted.
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In the message that appears, click the Yes button to delete or the No button to return to the tree
without deleting.

Renaming Nodes

To rename a node:

1.

2.

4,

Select Tree Manager > Tree Manager.
Search for an existing tree or create a new one.

Access the Node Properties page by selecting a node in the Tree Manager page, and clicking the
Update Node Properties icon.

Enter new name for the node in the New Name text box and click the Rename button.

Note: The edit data image is not available for the root node.
You cannot rename the root node or branched nodes.

Working with Detail Values

This topic discusses how to work with detail values.

Understanding Detail Values

A single detail value in PeopleSoft Tree Manager has three parts: the detail image, the detail name, and a
detail description. Detail values can also appear as a range of values or as dynamic detail.

This is an example of a detail value with a description.

B [M120] - Praduct Graup Sales Manager

This is an example of a range of detail values.

S [P30002 - PI0004]

This is an example of dynamic detail values or an empty detail.

Ll

The following is a complete list of detail value editing images. When you highlight a detail value, only
the images that represent the available actions appear.
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Field or Control

Description

=

Click the Insert Detail icon to insert a new detail value. This
icon is available only if the detail value information has been
entered on the Tree Structure Detail page.

Click the Edit Data icon to display a page for maintaining or
editing the application data for the detail value. The table that
stores the data is defined on the Tree Structure Maintenance

page.

S

Click the Edit Properties to enable you to change the detail
value itself.

For example, you can change the range to and range from
values.

Click the Delete Detail icon to delete the selected detail.

Click the Cut icon to cut one or multiple tree nodes or tree
leaves, and then use the Paste as Sibling or Paste as Child
icons to paste all cut tree nodes or tree leaves at once as
children or siblings.

When you perform cut and paste in Tree Manager, note that:

* A node can be pasted as a sibling or child of a node, but a
node cannot be pasted as sibling of a leaf.

*  Aleaf can be pasted as a child of a node or sibling of a
leaf, but a leaf cannot be pasted as sibling of a node.

* A node cannot be pasted as a child or sibling of its own
children. When a node is cut, the Paste icon is available

with any of its children.

e The Cut icon in a node or a leaf is not available if its
parent is cut.

*  Moving a node moves all its children (child nodes and
leaves) along with it.

*  Root node and branched node cannot be cut.

Note: This icon is not available for dynamic detail leaves.

i

Click the Paste as Sibling icon to paste a cut detail value into
the tree as a sibling.

Adding Detail Values

To add detail values:

48
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Select Tree Manager > Tree Manager.
Search for an existing tree or create a new one.

On the Tree Manager page, highlight the node that you want the detail values to report to, or you can
highlight one of the node’s other detail values.

To complete a detail value tree, you need to define detail values for each ferminal node in the tree,
which means each node that has no child nodes.

Click the Insert Detail icon.
If you are creating a dynamic detail tree, select the Dynamic Flag option.

The Detail Value Range page appears. It shows the tree node to which the new values report. If you
select the Dynamic Flag option other fields on a page become locked. When you click the Add
button, PeopleSoft Tree Manager displays brackets [ ] in place of the detail value for the selected
node. When you use the tree, the system automatically selects the appropriate detail values for the
node.

Note: Do not add dynamic details in a tree that already has details using ranges. Trees should be
either all dynamic details or all ranges. Mixing detail types can cause unpredictable results in other
applications, such as PeopleSoft Query and PeopleSoft nVision.

Use the search images to enter a range of detail values from the database field on which this tree is
based.

To enter a single value, enter the same value in the From and To fields.

Note: When you specify a range of values, you cannot specify another detail value that appears within
the range. For example, if you specify a range from 0271 to 0278, you cannot subsequently assign
0275 to another detail value — unless you selected the Allow Duplicate Detail Values option.

Click the Add button.

If you entered values that have already been defined in a database (User Detail Record), PeopleSoft
Tree Manager adds the values to the tree when you click the Add button.

If you enter new values, PeopleSoft Tree Manager informs you that you have entered an undefined
value. Depending on your security access, PeopleSoft Tree Manager may enable you to add the new
value.

If you’re adding a new value to the database, click the Yes button.

PeopleSoft Tree Manager displays the page for adding new values for the field.

Changing Detail Value Descriptions

To change the description of a detail value:

Select Tree Manager > Tree Manager.

2. Search for an existing tree or create a new one.

Copyright © 1988, 2024, Oracle and/or its affiliates. 49



Using PeopleSoft Tree Manager Chapter 3

3. On the Tree Manager page, highlight the detail value and click the Edit Data icon.
The original page with the detail value information appears.
4. Update the value in the Description field.

5. Click the OK button to apply changes to the appropriate database table.

Note: Detail value descriptions will not be visible if the effective date of the tree is earlier than the
effective date of the node.

Modifying a Range of Detail Values

Use the Detail Value Range page (PSTREELEAF) modify the range of values in a detail.
Navigation:

1. Select Tree Manager > Tree Manager.

2. Search for an existing tree or create a new one.

3. Select a detail value on the Tree Manager page, and click the Edit Properties icon.

This example illustrates the fields and controls on the Detail Value Range page.

Detail Value Range

Tree Node: WP

] Dymiamic Flag
Range From:  |1007 Q
*Range To: 1041 Q

pdate | Cancel

To modify a range of detail values:

1. Select Tree Manager > Tree Manager.

2. Search for an existing tree or create a new one.

3. Select a detail value on the Tree Manager page, and click the Edit Properties icon.

4. On the Detail Value Range page, modify the range values in the Range From and Range To fields.

5. Click the Update button to save your changes.

Deleting Detail Values
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To delete detail values:
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1. Select Tree Manager > Tree Manager.

2. Search for an existing tree or create a new one.

Using PeopleSoft Tree Manager

3. On the Tree Manage page, highlight the detail value and click the Delete icon.

A confirmation message appears.

4. Click the Yes button to delete or the No button to return to the tree without deleting.

Viewing Detail Values

Use the Detail Value List page to view the range of values in a detail or dynamic detail.

Navigation:

1. Select Tree Manager > Tree Manager.

2. Search for an existing tree or create a new one.

3. Select a detail value on the Tree Manager page and click the Edit Data icon.

Alternatively, select the bracket under a dynamic detail on the Tree Manager page, and click the Edit

Data icon.

Note: The Detail Value List page is available only for detail ranges. This page is application defined.

This example illustrates the fields and controls on the Detail Value List page — QEDMO Employee.

Definitions for the fields and controls appear following the example.

QEDMO Employee - 00001

Effective Date Criteria

& None C Tree Effective Date

Tree Details

’@ Last Hame

From = —
= 8200 ALBRIGHT
= 2400 WALTERS
=5 8500 DUMNCAM
= 8661 CHERRIER
= 8760 ESPINOZA
= 2884 BARBATOS
B 8885 SCHOUIK
B 8886 RABMEAL
= 8887 JOHMSON

Close |

P
Customize | Eind | “iew Al | El | First n 1-8af 3 n Last

164745113
042539942
796491472
334514044
548546523
267335612
510555654
510555645
106060337

Social Security Humber Department

0aant
0aant
00ant
0aant
0aaot
0oant
0aant
0aant
00ant

Customize Find
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Field or Control Description

Effective Date Criteria Select the None option to display all EFFDT data rows for
ranged or dynamic tree details, including future EFFDT data.

Select the Tree Effective Date option to display EFFDT detail
data with EFFDT less than or equal to a Tree EFFDT.

Note: Future EFFDT detail date is not displayed if the Tree
Effective Date option is selected.

Customize Click to change the column or sort order.

Bl Click the Update icon to select the required detail value.
‘=]

This page lists the values in a range, or the values in a dynamic detail, depending on the node that you
selected to access the page. In a normal detail tree, a specific value or range of values defines each node.
A dynamic detail tree determines the value by matching the node name with a field on the value table.

Dynamic detail trees use the parent node name as a key to select the detail values.

Values are stored and compared as strings, not numbers. Therefore a range of values identified by
numbers may include more values than anticipated. For example, a company contains the following
departments: 0107, 1000, 1002, 1010, 1090, 1100, 1779, and 1869. If you specify a range of departments
from 1000 to 1090, the values included would be 1000, 1002, 1010, and 1090 because the first three
characters of these departments fall in the range between 100 and 109.

Although the number 10699999 is greater than 1090, when you use a string, the length of the value does
not matter. For example, a range of words between CAP and CAT includes the word CARTWHEEL.

Using Drag and Drop

52

You can move detail values and nodes using drag-and-drop functionality as a substitute for cut-and-paste.

When using drag-and-drop functionality with nodes, you can use either the Paste as Child or Paste as
Sibling actions.

Note: The Paste as Sibling action is not available in Query Access Manager.

The following rules apply when using drag and drop:
*  You can drop values onto the root node, but you cannot drag the root node onto another value.

*  You can drag nodes and detail values to another location, but you cannot drop nodes onto detail
values.

* You cannot drag and drop on:

¢ Branched nodes.
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*  View-only trees.

* Dynamic detail leaves.

* Drag-and-drop functionality is available only for a single page that is opened in a browser.
To move a node or a leaf between different pages, use cut-and-paste functionality instead.
*  The drag-and-drop default action is set in the display options.

e The drag-and-drop functionality does not work on all the supported browsers listed in the platforms
database. System requirements for the drag-and-drop functionality for PC are: Mozilla FireFox 3.0,
and Safari 3.1.x, 3.2.x.

Note: To use drag-and-drop on large trees, change the Number of Lines per Page field to a greater
number.

See Setting Display Options.

Saving and Configuring Trees

This topic discusses how to save and configure trees.

Using Save and Configuration Options

From the Tree Manager page, you can perform actions on the selected tree using the links that are
displayed above the navigation bar.

Note: Not all of the options appear on the screen initially. For example, the Save Draft link does not
appear until the tree is modified, and the Navigation Options link appears only if the multi-navigation
option has been set for the tree structure.

Field or Control Description

Save Draft Saves the tree or branch, but does not perform detail audits.

Trees are marked as Draft until the audits are performed by
saving the tree using the Save command, or by manually
performing the detail value audits from either the Tree
Definition page or the Tree Maintenance page.

Save Saves the tree or branch and performs audits on detail values.

Save As Saves the current tree or branch with a new name, new
effective date, or modified properties.
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Field or Control Description

Close Closes the tree or branch and displays the Search page.

When you are through editing a tree, it is important to save
any changes you have made and use the Close link to let the
system know that you are finished editing the tree.

Tree Definition Displays the Tree Definition and Properties page where you
can access the Performance Options page, change audits and
edit levels, edit category of the tree, and edit description.

Display Options Changes the way trees appear on the page.

Also changes the way the drag-and-drop functionality behaves
in the current session.

Navigation Options Changes the navigation path for a selected node or detail to
any of the components on the menu bar that are specified on
the tree structure.

Print Format Formats all or part of the tree so that it can be printed by using
your browser’s print function.

Also prints the open branch of branched trees.

Export to PDF Click to access the Export to PDF page, where you can select
the optional tree attributes to be exported to PDF files.

Saving a Tree in Draft Mode

Draft mode prevents detail audits from being performed when a tree is saved. Thus, it's possible to save
draft trees that are invalid. The system considers all draft trees invalid and they cannot be used in other
PeopleSoft applications — such as PeopleSoft Query or PeopleSoft nVision — until they are saved or until
a tree audit is performed from either a regular Save, the Tree Definition page, Tree Maintenance page, or
using Tree Auditor.

To view all invalid values in a tree, you can run the audits from the Repair Tree program and use the View
Results option to see a list of audit problems. After an audit is performed with no errors, the status of the
tree changes from draft tree to valid tree.

You can see if your tree is a valid tree or draft tree by viewing the Last Audit value at the top of the Tree
Manager page. You can also check the status of a tree from the Tree Maintenance page.

Related Links
Performing Audits
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Copying Trees

You can copy a tree using the Save As link from the navigation bar, or you can use the copy function from
the Tree Maintenance page. The whole tree is copied, including its branches.

Note: To reduce copy time, PeopleSoft recommends copying large trees using the Copy function instead
of the Save As function.

You can copy a tree into another setID. However, you are only copying tree data, not the supporting
application data.

If the TREE_NAME field exists in the User Node table, then the user node data (node descriptions, and
so on) cannot be shared between trees with different names. For this reason, if you copy a tree using the
Save As function in PeopleSoft Tree Manager or the Copy function in the Copy/Delete Tree utility, and
user node table includes the TREE_NAME field like one of the key fields, you must manually insert the
new tree's node descriptions.

To copy a tree using the Save As link:

1. Select Tree Manager, Tree Manager.

2. Open the tree that you want to copy.

3. Select the Save As link from the Tree Manager page.
The Tree Definition and Properties page appears.

4. Update the information for the new tree.

You must enter at least a new tree name and effective date. You can also change any of the other
settings, although there are restrictions on your changes to the Use of Levels setting.

Note: You can change the Use of Levels setting, but you cannot change a tree from not using
levels to using them. Changing a tree from loosely enforced levels to strictly enforced levels is not
recommended.

5. Click the Save As link or Save As Draft button.

Related Links
Maintaining Trees

Modifying Tree Definitions

Use the Tree Definition and Properties page (PSTREEDEFN) to edit tree properties for an existing tree,
and to save a tree with a different name, effective date, and other properties.

Navigation:
1. Select Tree Manager, Tree Manager.
2. Search for an existing tree or create a new one.

3. Open a tree on the Tree Manager page and click the Save As link.
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This example illustrates the fields and controls on the Tree Definition and Properties page.

Alternatively, open a tree on the Tree Manager page and click the Tree Definition link.

Chapter 3

Tree Definition and Properties

*Tree Name: |QE_DEPT_DYNAMIC

*Structure 1D: QE_DEPT_DYMNAMIC

*Effective Date:  |01/01/1999 [l xgapys: | Active <]

*Description: |D].fnarnic Detail Dept Tree
*Category: |QEDMO Q

- - FPerformance Options
*Use of Levels: | Level Mot Used =

*SetiD: [QEDM1 @

I Al Detail Values in this Tree S 21
™ Allow Duplicate Detail Values
Leaf Count: 21
Level Count: 0
Perform Auditsl Branch Count: 0

Save As | Save As Draft Close

To modify tree definitions:

1.

In the Tree Definition and Properties page, enter a new description or select a new category for the

tree.

In the Status drop-down list, select the status of the tree to be Active or Inactive.

An active tree can be used by other applications. An inactive tree cannot be used by the system.

In the Use of Levels field, select how levels in the tree are enforced.
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The available options depend on the type of tree that you are modifying. If levels are not defined in
the selected tree structure, this field is unavailable and the value Level Not Used is displayed. Also,
the Define Tree Levels link is not displayed.

Click the Define Tree Levels link to access the Tree Node Definition page and add, update, or delete
levels.

In the Audits group box, select how you want the tree to handle detail values.
Detail Value options are not active for trees that are:
* Keyed by business unit or user key value.

A business unit is a corporation or a subset of a corporation that is independent with regard to one
or more operational or accounting functions.

* Simple winter trees, as they do not have detail values.

Click the Performance Options link to change performance options.
The available options depend on the type of tree that you are modifying.
See Page Used to Select Performance Options.

Click the OK button to save your changes.

When the multiuser environment is enabled, users can only modify a tree definition to a branched tree
when the branch is checked out and the tree has no other checked out branches, and add new levels

or perform modifications to a tree definition when the root branch is checked out and the tree has no
other checked out branches.

Note: When the multiuser environment is enabled, a user cannot check out a tree branch if another
user working with a different branch of the same tree has modified the tree definition and either Aas or
has not saved the changes.

If users edit specific branches without modifying the tree definition, other users can still edit different
branches of the same tree at the same time.

Defining Tree Levels

Use the Tree Levels page (PSTREEDEFNLEVELS) to add, delete, and modify tree-level information.

Navigation:

1.

Select Tree Manager, Tree Manager.

2. Search for an existing tree or create a new one.

3. Open a tree on the Tree Manager page and click the Save As link.

Alternatively, open a tree on the Tree Manager page and click the Tree Definition link.

4. Click the Define Tree Levels link on the Tree Definition and Properties page.
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This example illustrates the fields and controls on the Tree Levels page.

Tree Levels

Tree Name:  QE_PERS_DATA

Tree Levels customize | Find | View 41| B 88 First B 1.5 o5 5 I Last
[Levelame  [Alvales  |Descripion == |ViewDetal |Delete
CORPORATE CORFORATE View Detail Delete
COMPANY [F] COMPANY View Detail Delete
DIVIZION ] DIVISION View Detail Delete
DEFARTMEMNT [F] DEFARTMEMNT View Detail Delete
BRAMCH 1 BRAMCH View Detail Delete
oK | Add |

To modify, add, or delete tree levels:
1. Inthe Tree Levels page, click the appropriate View Detail link to edit level details.
2. To permit nodes to skip over a level and report to a higher level, clear the All Values options.

For example, you might want to skip levels if you have one or more departments that are not part of
any division but report directly to the COMPANY level. Select the All Values option to make sure
that all values from lower levels report to a node at this level.

Note: The All Values option for the top level (root node) is selected but not available. You cannot
skip over the top level.

3. To delete a level, click the appropriate Delete link.
You cannot delete a level that has nodes associated with it.
4. To add new levels, click the Add button.

The Tree Levels page appears.

Note: When the multiuser environment is enabled, users can only add new levels to a branched tree
when the root branch is checked out and the tree has no other checked out branches.

See Working with the Multiuser Environment.

5. Enter a name for the level.

Use a name that reflects what the nodes at this level represent. For example, the first level in the
Department Security tree is CORPORATE, indicating that the root node is Corporate Headquarters.

6. Specify whether nodes can skip over the level.
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Select this option if you want to make sure that all values from lower levels report to a node at this
level. To allow nodes to skip a level, clear the All Values option.

7. Click the OK button.

The Tree Level page closes. If you entered the name of an existing level from another tree, the level
name is added. If you entered a new name, PeopleSoft Tree Manager displays the page for entering
tree level information. The displayed page is the page specified for levels in the tree structure. For
most trees, it is the Tree Level page.

Setting Display Options

Use the Configure User Options page (PSTREEMGROPTIONS) to specify what information appears on
the Tree Manager page. You can also use this page to turn off and on tree node descriptions and set the
default action for dragging and dropping nodes.

Use these steps to access the Configure User Options page:
1. Select Tree Manager, Tree Manager.
2. Search for an existing tree or create a new one.

3. Open a tree on the Tree Manager page and click the Display Optionslink to access the Configure
User Options page.

This example illustrates the fields and controls on the Configure User Options page.

Configure User Options

Display Options

Display Node Id

Display Node Description
Display Detail Values
Show Detail Description

] Display Levels
Display Lines Per Page: G0

Nodes Drag/Drop Default Action

(O Paste As Sibling Mode
(¥ Paste As Child Node

Lpdate Cancel

J
d

To enable or disable tree node descriptions:

1. In the Configure User Options page, select each option to enable or disable its display option.
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The Display Levels option is not available if levels are not used.

2. Enter the number of lines that you want each page to show.

Chapter 3

The default number of lines is 60. The new number of lines entered remains valid until you change it
again. The value remains persistent even if the user ends and restarts an internet session.

Note: Displaying a large number of lines may impede performance. Oracle recommends a number of

less than 300 lines per page.

This example illustrates all display options on the screen: node ID, node description, detail values, and

levels.
Tree Manager
SetlD QEDWMZ LastAudit  vgig Tree
Effective Date 01/01/1900 Status  Active
Tree Hame QE_ACCOUNTS COA Hierarchy
Save Az Close Tree Definition Display Options Print Format Exportto PDF

ALL ACCOUNTS =|MCOME STATEMEMT =MET INC AVAIL COML =NET INCOME

Collapse All | Expand Al First Page [l 2 of 24433

[=F ALL_ACCOUNTS - ALL_ACCOUNTS  Level (LEVEL 1
[=3 INCOME STATEMENT - INCOME STATEMENT  Level :LEVEL 2
P [=F NET INC AVAIL COMM - NET INC AVAIL COMM  Level (LEVEL 3

- 0 NETINCOMESNETINGONE Level LEVEL4 & i+ Fir & B3 #

: FPREFERRED DIVIDEMD'S - FREFERRED DIVIDEMNDS  Level (LEVEL 4
BALAMCE SHEET - BALAMCE SHEET  Level (LEVEL 2
STATISTICS - STATISTICS  Level LEVEL 2

HISTSTAT - HISTSTAT  Level LEVEL 2

[=] Motify

I’ Last Page|

B X %

You can click the level name next to the node to display the Levels page and edit the level information.

Note: Tree node descriptions will not be visible if the effective date of the tree is earlier than the effective

date of the node.

Setting the Default Action for Dragging and Dropping Nodes

You can use the Nodes Drag/Drop Default Action group box to set the default action for dragging and
dropping nodes; you can select either the Paste as Sibling Node icon or the Paste as Child Node icon.

Note the following options when setting the drag-and-drop default action:

*  When right-handed users drag nodes using the /eff mouse button, they drop nodes using the set default

action.

Copyright © 1988, 2024, Oracle and/or its affiliates.



Chapter 3 Using PeopleSoft Tree Manager

When right-handed users drag nodes using the right mouse button, they drop nodes using the action
that is not set as the default action.

*  When left-handed users drag nodes using the right mouse button, they drop nodes using the set default
action.

When left-handed users drag nodes using the /eft mouse button, they drop nodes using the action that
is not set as the default action.

» For Macintosh systems, because one mouse button exists instead of two, users dragging nodes will
drop nodes using the set default action.

»  The setting for the drag-and-drop default action is session-based. For this reason, after a user closes a
tree, this setting reverts to the default assignment Paste As Child Node.

Related Links
Using Drag and Drop

Using Navigation Options

Use the Detail Navigation page (PSTREEMGRNAV) to select a detail page to open from the tree when
editing data for the selected node or detail. For example, using the Personal Data tree, you can navigate to
pages such as Personal Data, Benefits, or Salary Information.

Navigation:
1. Select Tree Manager, Tree Manager.
2. Search for an existing tree or create a new one.

3. Select a node or detail on the Tree Manager page and click the Navigation Options.

Note: The Navigation Options link appears only if multi-navigation flags have been selected in the
tree structure for nodes, details, or both.

See Defining Detail Tree Structures.
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This example illustrates the fields and controls on the Detail Navigation page. Definitions for the fields
and controls appear following the example.

Detail Navigation Page

Navigation Links

Current Component

Customize | Find | View Al | B | 3

Frocurement Control

Treasury Options

Purchasing Definition
Payables Definition
Receivables Definition

Order Management Definition
Project Costing Qptions
Project Costing Definition
Program Management Options
Receivables Definition

Order Management Definition
Order Management Definition
Order Management Definition
Project Costing Options
Project Costing Options
Purchasing Definition
Service Procurement Definition
Order Management Definition
Promaotions Mamt. Definition
Project Costing Options
Project Costing Options
Payables Definition

Order Management Definition
Contracts BU

Project Costing Options

This Page allows Userto set a Page to be accessible via "Edit Data” Action Image.

First Bl 1.25 o139 O Las

Page

GL Templates
Treasury Options

Req Approval Options
Matching
Bank/iPayment Options
General Holds 2
Microsoft Project

BU Definition

Program Managermnent Options
Accounting Options 2
Accounting and Billing
Taxes and Currency
Order Entry Features
Delete Utility Tables
Project Costing Options

PO Approval Options

Semnvices Procurement Bus Unit

General Holds 1
Promations Definition
Budget Row Versioning
Copy Temnplate Option 1
Payments

Credit Processing
Confidence Level Setup
Budget Alerts

You can select a detail page to open when editing data for nodes or details. For example, using the

Personal Data tree, you could navigate to pages such as Personal Data, Benefits, or Salary Information.

The page reflects the node or detail selection when you clicked the Navigation Options link. If no
selection was made, the page reflects the first entry, node or detail, on the Tree Manager page.

Note: This page is available only if the multiple navigation options have been selected on the Tree

Structure record.

62
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Field or Control

Description

Component This column lists components that you can navigate to when
editing tree node or detail value data.
Page This column displays pages that you can navigate to within the

component.

Click the Current Navigation icon to identify the current
navigation selection.

Set Click a page and then click this button to change navigation to
the selected page.

Reset Default Click to change the navigation back to the default page
specified in the tree structure.

Cancel Click to return to the Tree Manager page without saving any

changes.

Note: The newly selected navigation path remain current for the browser session. The path returns to the

default for each new session.

Printing Trees

You can print either part of the tree or the whole tree. When you print an opened branched tree, just the

branch prints.

Note: To avoid a browser or Tuxedo time-out, we recommend that you export large trees to PDF files

before you print them.

To print a tree in Tree Manager:

1. Highlight the node or leaf to print.

To print a whole tree, highlight the root node, or do not highlight any part of the tree.

To print part of a tree, highlight the top node for the hierarchy that you want to print. You can also

select a detail value belonging to that hierarchy.

Note: You cannot print a branch from the main tree. If you highlight a branch and click the Print
Format link, a warning message appears asking you to first open the branch.

2. Click the Print Format link on the navigation bar to format the entire tree so that it can be printed

from your browser’s print function.

The expanded tree appears in your browser.
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Note: The concept of pages does not exist on the Print Format page. For this reason, if a selected node
hierarchy is too large, your browser may time out. To reduce the chances of a time-out occurring, print
only the necessary portions of the tree.

3. Click the Print button of your browser or select File > Print from your browser to print the tree.

Note: Tree print jobs are sent to your default printer.

Exporting Trees to PDF Files

64

In addition to using the Tree Print Format page to print trees in Tree Manager, you can also use the Export
to PDF page (TREE2PDFOPTIONS) to export part of a tree or an entire tree to a PDF file. Then you can
save the exported tree in the file system, send it to Report Manager, or send it to a printer. When exporting
a tree to PDF format, you can export the tree with or without expanded branches, detail values, detail
descriptions, and level information. After exporting a tree, you can print it automatically or manually.

Note: To avoid a browser or Tuxedo time-out, we recommend that you export large trees to PDF files
before you print them.

Printing trees uses BI Publisher, Application Engine, and Process Scheduler. Process Scheduler enables an
Application Engine program to collect all relevant information from the tree and pass it to BI Publisher.
BI Publisher produces the required PDF output for the tree. Then, the Report Distribution process posts
the PDF output to Report Manager. You can save this PDF output in the file system or send it directly to
the printer, based on your selection during report scheduling.

Page Used to Export Trees to PDF Files

Use the Export to PDF page (TREE2PDFOPTIONS) to select the optional tree attributes to be exported to
PDF files.

Navigation:

Tree Manager > Tree Manager > Export to PDF
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This example illustrates the fields and controls on the Export to PDF page. Definitions for the fields and
controls appear following the example.

Export to PDF

Eeport Manager Process Maonitor M

Tree Node ALL_ACCOUNTS

PDF Options
Reset Indentation Limit 20

Expand Branches

Show Detail Values

[] Show Detail Description

Show Levels

Close

Field or Control Description
Tree Node Displays the name of the node that you selected to export to a
PDF file.

Note: This node and all its descendants will be exported to a
PDF file.

Reset Indentation Limit Indicates the visual position of tree objects in the PDF file.

Tree objects will be positioned at the beginning of the page if
set at a position beyond the reset indentation limit.

Expand Branches Select to export the tree with branches expanded.

If you do not have access to the branch, it will not be

expanded.
Show Detail values Select to export the tree with detail values.
Show Detail Descriptions Select to export the tree with detail value descriptions.
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Field or Control Description
Show Levels Select to export the tree with level information of the tree
shown.

Note: The Expand Branches, Show Detail Values, Show Detail Descriptions, and Show Levels options
are not active for Query Access trees.

Steps Used to Export Trees to PDF Files

To export a tree to a PDF file:

L.

Select Tree Manager > Tree Manager.

Alternatively, access the Query Access Manager page by selecting
PeopleTools > Security > Query Security > Query Access Manager.

Open a tree and click the Export to PDF link.

The Export to PDF page appears.

Set the PDF options that are used to convert the selected tree to a PDF file.
Click the Run button to schedule the PSTREE2PDF application engine.

The Process Scheduler Request page appears.

Select an option from the Type drop-down list.

»  Select the Printer option to send the PDF output file directly to a printer.
* Select the Web option to send the PDF output file to Report Manager.

» Select the File option to save the output file to a specific location.

Click the OK button.
The Export to PDF page reappears.

The system exports the Tree to a PDF file that is either saved in the file system, listed in Report
Manager, or printed from the selected printer.

Note the following information in the exported PDF file:

The first report page shows a header with tree name, tree keys, setID, effective date, and so on.
The first report page shows the tree definition, level definitions, and PDF-display option.

Each tree object has an associated icon that represents the object type and a reference to the parent
tree object (except the root node).

Each tree object has a printed reference to its parent.
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This is an example of a Node in BI Publisher generated report in PDF format.

2[ZF COMSULTANTS - Consultants & Contractors **ALL_JOBSA

In the previous example:

2 represents the level number.
CONSULTANTS is the node name.
Consultants & Contractor is the node description.

“MALL JOBS™ is the name of the parent node.

This is an example of a Leaf in BI Publisher generated report in PDF format.

& 1510 "*CONSULTANTSA

& [] 20300
# [-] ~00001

In the previous example:

[1510] is a leaf detail value.
[ ] indicates a dynamic leaf.
[ - ] indicates an empty leaf.

MCONSULTANTS™ , M20300™ , and 00001 are the name of the parent nodes.

The following table lists and describes the icon for each type of node or leaf.

Icon Description

Leaf

Node

Skipped Level Node

[

Collapsed Branch

%]

Expanded Branch

4

&)

Expanded Record
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Icon Description

Terminal Node

Record

Note: All users who have permission to run BI Publisher reports are able to use the Export to PDF
feature. If they do not have access to a specific branch of a tree, that branch is not expanded, even after
they click the Export to PDF link.

The Export to PDF feature is not supported if Process Scheduler is running on OS390.

Using Tree Viewer

Tree Viewer is a read-only version of PeopleSoft Tree Manager. It provides security administrators with
an easy way to limit some users to read-only access for all trees.

The only actions available in Tree Viewer are Display Options, Print Format, and Close. Navigation
options are the same as in Tree Manager.

The following images are available when displaying trees in Tree Viewer:

Field or Control Description

Collapse Node: Click to close a node with its contents not
showing.

]

Expand Node: Click to expand a node with its contents
showing all lower levels of the hierarchy.

HI

Terminal Node: Represents a node that has no children.

®]

Branch Node: Represents a node that has been branched.

%]

Detail Value or Leaf (detail/summary trees only): Represents
an individual field value attached to a node at the end of a
branch.

Expand Node Hierarchy: Expands all child objects.
T

Note: Tree Viewer ignores branches.
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Understanding Steps to Create Trees

Trees are built from the highest level of the hierarchy (root node) to the lowest level of the hierarchy.
Every tree is based upon a structure. The structure defines the links between your tree and the underlying
tables to which it refers. There are two main kinds of tree structures:

* Detalil tree structures.

There are two types of detail trees: detail-value (summer) tree and node-oriented (winter) tree.
*  Summary tree structures.

These are used for PeopleSoft nVision reporting using summary ledgers.
These are some basic steps to create trees:
1. Create the tree structure or find an existing tree structure to use.
2. Create the tree definition.

The tree definition specifies:

* Tree structure.

* The tree name and key values.

*  How the tree handles detail values.

¢ Whether the tree uses levels.

3. Specify the levels in the tree, if necessary.
4. Insert the tree nodes that define the hierarchy of the tree.
5. Attach detail values as leaves on your nodes.

Most types of trees — detail trees, summary trees, and dynamic detail trees — have detail values.
However, you skip this step for node-oriented trees.

Characters Not Used in Tree Name, SetIlD, Set Control Value, and Tree Branch

SmartNavigation passes the values of several tree-specific fields to the application via URL. Certain
characters are inappropriate for use in an URL and should be avoided. When you set up trees, do not use
any of the following characters in the tree name, setID, set control value, and tree branch fields:

* ampersand (&)
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L]

at symbol (@)
backslash (\)

colon (3)

comma (,)

caret (V)

dollar ($)

equals (=)

forward slash/virgule (/)
grave accent ()
greater than symbol (>)
left curly brace ({)

left square bracket ([)
less than symbol (<)
percent (%)

plus (+)

pound (#)

question mark (?)
quotation marks(")
right curly Brace (})
right square bracket (])
semi-colon (;)

space ()

tilde (~)

vertical Bar/Pipe (])

Chapter 4

Creating Detail Tree Structures

This topic discusses how to create detail tree structures.

70
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Note: When you define a tree structure, you specify the pages and record definitions PeopleSoft Tree
Manager uses to store data about the parts of a tree. When you add a new node, level, or detail value to a
tree, PeopleSoft Tree Manager uses this information to determine the component (pages) to capture the
relevant application data. When the specified component is displayed, all of the standard business logic
that is part of that component is invoked.

Defining Detail Tree Structures

Use the Tree Structure Properties page (PSTREESTRCTDEFN) to specify tree type, key fields, and
navigation options.

Navigation:
Tree Manager > Tree Structure

This example illustrates the fields and controls on the Tree Structure Properties page. Definitions for the
fields and controls appear following the example.

Structure

Tree Structure Properties

Structure ID: QE_FERS_DATA
*Description: Personal Data
*Twe: D Eta”
Additional Key Field Havigation Options
(® setld Indirection [INode Mutti-Navigation
C Business Unit [ Detail Multi-Navigation
) User Defined
) Hone
Field or Control Description
Type The default value is Detail.
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Field or Control

Description

Additional Key Field

Select from the following values:

*  SetID Indirection: When you create the tree, both the tree
name and the setID identify it. Including the setID as part
of the tree key means that you can use setID to share the
tree definition among multiple business units.

*  Business Unit: Use the Nodes tab to select a specific
business unit to act as the key of tree. Business Unit
structures can only be used with node-oriented trees (trees
with no detail values).

*  User Defined: This option is a desupported feature. You
should try to create all of your trees either using Set/D,
Business Unit, or None.

Note: Trees with User Defined Key field cannot be used
with other PeopleSoft tools such as Query and PeopleSoft
nVision. There are no current plans to enhance these
tools to work with user-defined keyed trees so you should
avoid using this option.

*  None: Your tree does not contain an additional key. It is
keyed only by tree name and effective date.

Navigation Options

Select to enable multi-navigation for nodes and details.
Multi-navigation enables you to navigate to any pages that

are relevant to the node or detail pages specified on the tree
structure. PeopleSoft Tree Manager enforces the set of rules to
determine which pages should be included in the list.

Multi-navigation is not available for Summary structure types.

See Using Multinavigation Paths.

Defining Levels

72

Use the Tree Levels page (PSTREESTRCTLEVL) to specify the page and record to enter and store

information about tree levels.

Navigation:

1. Select Tree Manager > Tree Structure.

2. Search for an existing tree structure or create a new one.

3. Select the Levels tab on the Tree Structure Properties page.
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This example illustrates the fields and controls on the Tree Levels page.

(S| Levels [Iaest]

Tree Levels

Component Hame:

Menu Name:
Menu Bar Hame:

Menu kem Name:

Structure ID: QE_FERS_DATA
Record Hame: TREE_LEYEL_TBL
Page Hame: TREE_LEYEL

Creating Trees

When you create a new level in a tree, PeopleSoft Tree Manager displays the page that you specify in the
Page Name field on the Tree Levels page and stores the application data that you enter using the record
definition in the Record Name field. The default values for these fields come from the standard Tree

Manager page.

When using standard pages, you do not need to enter anything in the Menu Name or Menu Bar Name
fields. However, if you want to store level information using something other than TREE_LEVEL_TBL,
then you have to create a page and component that uses that new record definition. You must also

ensure that the component has been defined on a menu somewhere in your system and specify all of this

information on this page.

Defining Node Properties

Use the Tree Nodes page (PSTREESTRCTNODE) to specify the page and record used to enter and store
information about tree nodes. The Tree Nodes page of a new tree structure includes default values, which

are similar as in the Tree Levels page.

Navigation:

1. Select Tree Manager > Tree Structure.
2. Search for an existing tree structure or create a new one.

3. Select the Nodes tab on the Tree Structure Properties page.
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This example illustrates the fields and controls on the Tree Nodes page.

[ [REEVEEN| nodes |

Tree Nodes

Structure ID: QE_PERS_DATA

*Record Hame: TREE_MODE_TBL Q
*Field Name: TREE_MODE Q
*Page Name: TREE_MCODE Q

Component Hame:
Menu Name:
Menu Bar Hame:

Menu kem Hame:

Enter the record name, field name, and page name to use for entering and storing information about tree
nodes.

For a node-only tree, where each node represents a detail value, use the page, record definition,

and field that correspond to the detail value you’re entering. For example, if each node represents

a department (as in the Department Security table), use the DEPARTMENT TREE page, the
DEPT_TBL record definition, and the DEPTID field. You would also identify the component that the
DEPARTMENT _TREE page belongs to, as well as all of the menu information.

Note: If you are creating a business unit or user-defined key tree structure, the Tree Nodes page displays a
field for entering the business unit or user-defined key field.

If the TREE_NAME field exists in the User Node table, then the User node data (node descriptions, and
so on) cannot be shared between trees with different names. For this reason, if you copy a tree using the
Save As function in PeopleSoft Tree Manager or the Copy function in the Copy/Delete Tree utility, and
user node table includes the TREE_NAME field like one of the key fields, you must manually insert the
new tree's node descriptions.

Defining Tree Details

74

Use the Tree Details page (PSTREESTRCTDETL) to define the application data and component used to
maintain the detail values for your tree.

Note: This page should only be filled in for structures that you plan to use for detail-value trees (summer
trees). This page is not applicable to node-only trees.

Navigation:
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Tree Manager > Tree Structure > Details tab

This example illustrates the fields and controls on the Tree Details page. Definitions for the fields and
controls appear following the example.

[ | Loveis | | Details |

Tree Details

Structure ID; QE_PERS_DATA

Record Name: QE_EMPLOYEE

Field Hame: EMPLID

Page Name: QE_EMPLOYEE

Component Hame: QE_EMPLOYEE aQ,

Menu Name: QE_SAMPLE_APFS Q

Menu Bar Hame: LISE ')
Q

Menu e Hame: QE_EMPLOYEE

Enter the name of the page, component, record definition, and key field name that will be used when
adding or updating the application data for a detail value. For example, if each detail value represents
a department, use a page, component, and menu path that enables you to create and update department
information.

Click the Save button to save your new detail tree structure.

Note: When the PeopleSoft Tree Manager searches for values for dynamic detail and detail ranges, the
search is based first on the override search record specified on the detail menu. By doing this, the values
displayed are only those that the user would normally have access to through the Application component.
If an override search record is not specified on the menu, then the system uses the component’s search
record. If there is no component search record, the system uses the tree structure detail record.

Unlike the level and node information, there is no standard page and record for detail values. These are
always built on application-specific tables.

Crea

Copyright

ting Summary Tree Structures

You use summary trees to group nodes from an existing detail tree without duplicating the entire tree
structure. Summary trees are used with PeopleSoft nVision reporting off of summary ledgers, where the
data is rolled up using a detail tree and stored with nodes from that detail tree instead of detail values.
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Defining Summary Tree Structures

Use the Tree Structure Properties page (PSTREESTRCTDEFN) to define tree type and select a detail tree
to summarize.

To create a summary tree structure:

1.

2.

Select Tree Manager > Tree Structure.

Create a new tree structure.

In the Tree Structure Properties page, enter a description for the tree structure.
Select Summary as the type.

Enter a detail tree name using the search prompt.

Enter a detail setID.

Enter a level number using the search prompt.

The level number defines the level in the detail tree that is used as the detail values for the summary
tree. (The lowest level of detail in the summary tree is made up of all of the nodes from the detail tree
at a specified level.)

The search results lists only the detail levels related to the selected detail tree.

Defining Summary Tree Levels

76

Use the Tree Levels page (PSTREESTRCTLEVL) to specify the page and record to enter and store
information about tree levels.

To define levels for the summary tree structure:

1.

2.

Select Tree Manager, Tree Structure.

Search for an existing tree structure or create a new one.

Access the Tree Levels page by selecting the Levels tab on the Tree Structure Properties page.
Enter the record name and page names using the search prompts.

When you create a new level in a tree, PeopleSoft Tree Manager displays the page you specify in the
Page Name field in the Tree Levels page and stores the data you enter using the record definition in
the Record Name field. The default values for these fields come from the standard Tree Manager

page.

When using standard pages, you do not need to enter anything in the Menu Name or Menu

Bar Name fields. However, if you want to store level information using something other than

TREE _LEVEL TBL, then you have to create a page and component that uses that new record
definition. You must also ensure that the component has been defined on a menu somewhere in your
system and specify all of this information on this page.
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Defining Summary Tree Node Properties

Use the Tree Nodes page (PSTREESTRCTNODE) to specify the page and record used to enter and store
information about tree nodes.

To define nodes in the summary tree structure:

1.

2.

Select Tree Manager, Tree Structure.
Search for an existing tree structure or create a new one.
Access the Tree Nodes page by selecting the Nodes tab on the Tree Structure Properties page.

Enter the record name, field name, and page name to use for entering and storing information about
tree nodes.

Defining Summary Tree Details

Use the Tree Details page (PSTREESTRCTDETL) to specify the record and field information used to
summarize the tree.

To define tree details for the summary tree structure in PeopleSoft Application Designer:

1.

2.

Select Start > Programs > PeopleTools 8.x > Application Designer.
Through PeopleSoft Application Designer, create a view with a record type of SQL View.

For example, if you create a summary tree based on a department detail tree that is keyed by setID,
and the detail tree uses PS_ TREE NODE TBL to store the node user data, then your SQL view
might contain the following fields:

+ SETID

« DEPTID

« EFFDT

« DESCR

Use the following SQL:

Select A.SETID, A.TREE NODE, A.EFFDT, B.DESCR
from PSTREENODE A,PS TREE NODE TBL B
where A.SETID = ‘<your setid>’

and A.TREE NAME = ‘<your tree name>’

and A.SETID = B.SETID

and A.TREE NODE = B.TREE NODE

and A.TREE LEVEL NUM = <your detail tree level number to be summarized>

and B.EFFDT =
(select MAX (EFFDT)
from PS _TREE NODE TBL
where SETID = B.SETID
and TREEiNODE = B.TREEiNODE and EFFDT <= A.EFFDT)

Note: In this SQL statement, TREE LEVEL NUM must match the level number specified on the Tree
Structure Property page.
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4. Through browser, select Tree Manager > Tree Structure.
5. Search for an existing tree structure or create a new one.
6. Select the Details tab on the Tree Structure Properties page.
The Tree Details page appears.
7. In the Record Name field, enter the SQL view that you created.

Confirm that the setID, tree name, and level number in the view is the same as what you entered on
the Tree Structure Properties page.

8. In the Field Name field, enter the field from the view that you are summarizing.
For example, DEPT _ID.

9. Click the Save button to save your new summary tree structure.

Defining New Trees

This topic discusses how to define new trees.

Defining Basic Attributes
Use the Tree Definition and Properties page (PSTREEDEFN) to specify general attributes for a tree.
Navigation:
1. Select Tree Manager > Tree Manager.
2. Search for an existing tree or create a new one.

3. Click the Tree Definition link on the Tree Manager page.
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This example illustrates the fields and controls on the Tree Definition and Properties page. Definitions for
the fields and controls appear following the example.

Tree Definition and Properties

*Tree Hame: QE_ACCOLUNTS

*Structure ID: QE_ACCOUMTS

*Effective Date:  01/01/1800 +*Status:
*Description: | COA Hierarchy
*Category: |QEDMO Q Define Tree Levels
“Use of Levels: | Strictly Enforced V| Fetforrnance Options
*Setil: QEL2
s
L] an petail Values in this Tree Node Count: aah
Ll anow Duplicate Detail Values
Leaf Count: 23847
Level Count: 15
Perfarm Audits | Branch Count: 0

0]4 | Close |

Field or Control Description

Tree Name If you create a new tree, enter a tree name.

Note: SmartNavigation passes the values of several tree-
specific fields to the application via URL. Certain characters
are inappropriate for use in an URL and should be avoided.
When you set up trees, some characters in the tree name,
setID, set control value, and tree branch fields should not be
used.

See Understanding Steps to Create Trees.

Structure ID Select a tree structure ID.

Define structures using the Tree Structure Properties page.
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Field or Control

Description

Status Select a status of Active or Inactive.
If you mark a tree as inactive, no other users have access to
your tree from other PeopleSoft applications or tools.
Category Select or add a category.

Categorizing is a user-defined way of organizing trees so that
they are easier to find when using the tree search pages.

Note: Previously, the category determined how trees were
arranged at the highest level and was an important visual clue
in organizing trees. Category is now used only as a search
value.

Use of Levels

Select a method for enforcing levels.

Use Strictly Enforced or Loosely Enforced levels unless you
have a compelling reason not to. Some features, such as
creating summary trees, require levels.

Note: For an existing tree, you can change the Use of Levels
field. For example, you can change Strictly Enforced levels to
Loosely Enforced levels, but you cannot change from not using
levels to using them.

»  Strictly Enforced: All the nodes at a particular level
represent the same kind of information. In an organization
tree, for example, all nodes at one level represent
companies, all nodes at the next level represent divisions,

and so on. With Strictly Enforced levels, each node has a
level assigned to it based on its position in the tree. Nodes
can skip levels, and the PeopleSoft Tree Manager will
visually display any levels that are skipped.

*  Loosely Enforced: The nodes at the same visual level
of indentation do not all represent the same kind of
information, or nodes representing the same kind of
information appear at multiple levels. With Loosely
Enforced levels, you assign a level to each node
individually; the level is not tied to a particular visual
position, although the nodes still have hierarchical parent/
child relationships.

Note: Changing a tree from Loosely Enforced levels to
Strictly Enforced levels is not recommended.

*  Not Used: The nodes in the tree have no real hierarchy or
reporting structure, but do form a logical summarization
structure. With this option, nodes do not have levels
associated with them.
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Field or Control Description

All Detail Values in this Tree Select to check if all values in the detail value table should be
included in the tree.

For example, if you want to verify that all of the department
IDs in the DEPT TBL for a given setID are contained in the
DEPT_SECURITY tree for that setID, select this box, and
PeopleSoft Tree Manager will check for any department IDs
that are not found in the tree.

If you select this option and click the Performance Methods
link, you can select an option in the Auditing All Detail
Values group box on the Performance Options page.

Note: This option is not available for use with winter trees.

See Page Used to Select Performance Options.

Allow Duplicate Detail Values Select to skip the audit that checks for duplicate detail values
in the tree.

When selected, you can have the same detail value appear
under different parent nodes.

Note: This option is not available for use with winter trees.

Perform Audits Click to run the selected audit option from this page.

PeopleSoft Tree Manager also performs audits whenever you
save a tree. However, no audits are performed if you save the
tree using the Save Draft option.

Item Counts Displays the number of nodes, leaves, levels, and branches in
the currently opened tree or branch. It does not count nested
branches (branches with a parent branch that is different than a
currently opened branch).

Define Tree Levels Click to access the Tree Levels page and add, update, or delete
tree levels.

See Defining Tree Levels.

Performance Options Click to access the Performance Options page and set access
method, tree selector, or selector options. You can also set the
Auditing All Detail Values option as well as Tree Change
Service Operation options.

Note: The Access Method, Tree Selectors, and Selector
options are used mainly for optimizing tree usage with
PeopleSoft nVision and Query when using the In Tree criteria
option.

See Setting Tree Performance Options.
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Adding a Root Node

Use the Enter Root Node for Tree page (PSTREEROOTLEVELS) to define tree levels and the root node.

82

Navigation:
1. Select Tree Manager > Tree Manager.
2. Create a new one.

3. Click the Tree Definition link.

Chapter 4

4. On the Tree Definition and Properties page, enter the appropriate values and click the OK button.

This example illustrates the fields and controls on the Enter Root Node for Tree page.

Enter Root Node for Tree

Tree Name:  PS_DEPARTMENT

Step 1: Set Up Tree Levels

Tree Levels Customize | Find | Wiewe Al | @ | " Fir=t n 1.2 of 2 u Last
Level Hame All Yalues Description View Detail Delete Level
ALL_FROJ ALL_FROJ Wiewy Detail Delete Lewel
TASK il TASK Wieny Detail Delete Level

Add Level |

Step 2: Define Root Hode

*RootNode:  ALL_JOBS Q

Ok | Cancel |

You create a tree from the top down. You start by creating the root node, then add the children of the root
node, and continue down to the detail values (if the tree has them). If the tree uses levels, then you must

first define the level for the root node. You may want to set up additional levels at this time.

To add a root node for tree:

Note: If your tree does not use levels and the Add Root Node page does not include level configuration,

skip to step 5.

1. In the Enter Root Node for Tree page, add tree levels by clicking the Add Level button.

The Tree Levels page appears.
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Enter a name for the level.

Use a name that reflects what the nodes at this level represent. For example, the first level in the
Department Security tree is CORPORATE, indicating that the root node is Corporate Headquarters.
You can also enter the name of a level from another tree.

Note: You can also use the search box to search for names of existing levels.

Specify whether nodes can skip over the level.

The All Values option specifies whether PeopleSoft Tree Manager permits nodes to skip over

the level you’re defining to report to a higher level. Select this option to make sure that all values
from lower levels report to a node at this level. Clear this option to allow nodes to skip a level. For
example, you might want to do this if you have one or more departments that are not part of any
division but report directly to the COMPANY level.

Note: When you are adding a top level (the root node), the All Values option is selected but
unavailable. You cannot skip over the top level.

Click the OK button.

The Tree Levels page closes. If you entered the name of an existing level from another tree, the level

name is added. If you entered a new name, PeopleSoft Tree Manager displays the page for entering
tree level information. The displayed page is the page specified for levels in the tree structure. For
most trees, it is the Tree Levels page.

Enter a new root node name or select an existing root node.
If you are entering new node information, you must enter the information in the Tree Nodes page.
Click the OK button.

The tree appears with the root node on the page.

Note: When the multiuser environment is enabled, a newly created tree appears by default in edit
mode.

Inserting Nodes into Trees

For more information on inserting nodes into trees, see Inserting Nodes, Working with Tree Nodes.

Adding Detail Values

For more information on adding detail values, see Adding Detail Values, Working with Detail Values.

Working with Tree Branches

This topic discuses how to work with tree branches.
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Understanding Tree Branches

Branching means taking a limb of the tree — a section of the tree that reports into a single node — and
creating an actual tree object to hold that limb. Branching a tree can improve PeopleSoft Tree Manager
performance (by reducing the amount of data it needs to load when you open a large tree). After you
branch a tree, you can specify different object security settings for the branches. When a tree is branched,
multiple users can maintain separate sections of the tree while working simultaneously.

When you branch a tree, you’re splitting the original tree into two parts. PeopleSoft Tree Manager creates
one new object for your branch and another object to hold the remaining part of the tree. After branching,
you have two objects:

e The new branch, or subtree, that you created.
* A branch that corresponds to the rest of the original tree (minus the new branch).

You can use PeopleSoft Object Security to give users different security access to these objects. For
example, by restricting access to the new branch, you can give users access only to that branch.

Assigning different security access to different parts of the tree prevents users from making unauthorized
changes to the parts of the original tree (tree branches) which they do not have access granted.

Note: Users can make copies of the entire tree by using the Save As option.

After you have created a branch, you can use it as you use any other tree. You can open it independently
of the larger tree, modify it, or even create branches from it. When you’re using the original tree, you
cannot edit the branch’s nodes or details until you open that branch.

Restrictions

The following restrictions have been applied to tree branches due to the risk of conflicts when multiple
users are performing modifications to a branch tree at the same time:

* Moving nodes with subbranches.
*  Switching levels on nodes with subbranches.

*  Unbranching nodes with subbranches.

Note: A message will appear if a user attempts to perform any of these actions.

When the multiuser environment is enabled, a user cannot check out a tree branch if another user working
with a different branch of the same tree has modified the tree definition and either has or has not saved
the changes.

If users edit specific branches without modifying the tree definition, other users can still edit different
branches of the same tree at the same time.

Creating Tree Branches

To create a tree branch:
1. Select Tree Manager, Tree Manager.

2. Search for an existing tree in the Tree Manager page or create a new one.
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3. Highlight the node that will be the root node of the branch.
4. Click the Create Branch icon.

PeopleSoft Tree Manager replaces the node icon with a branch node icon. None of the nodes or detail
values reporting to the branched node appears in the tree display.

This is an example of a branch node.

Tree Manager

SetlD QEDNA LastAudit  a)id Tree
Effective Date 05/05/1297 Status - active

Tree Name QFE_FPERS_DATA Fersonal Data Tree

Save As Close Tree Definition Display Options Print Format Exportto PDFE

00001 =20100 =20900

First Page [ 1507114 [l Last Page

l'_é' 00001 - Corporate Headguarters Level . CORFPORATE

- @ [3200] - ALBRIGHT

B [3300] - VINCENT

£ [3400] - WALTERS

B [3500] - DUNCARN

£ [3600] - ELIAS

10100 - Office of the President  Level :COMPANY

I__é' 20100 - Office of the President (CDM)  Level :COMPAMNY
2 [8052] - AVERY

- # [B506]

: 20200 - Human Resources (COM)  Level :DIVISION
20300 - Controller (COM) Level :DIVISION

20400 - Retail Banking Admin (CDM)  Level :DIVISION
X 20800 - Operations Administration{CON) ¥R

Notify

Opening Tree Branches
To open a tree branch:
1. Select Tree Manager, Tree Manager.
2. Search for an existing tree in the Tree Manager page or create a new one.
3. Highlight the tree branch, and click the Open Branch icon.

Alternatively, in the Tree Manager search page, click a tree name link for the branch that is being
defined by a value in the Tree Branch section.
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Removing Tree Branches

To remove a tree branch:

1. Select Tree Manager, Tree Manager.

2. Search for an existing tree in the Tree Manager page or create a new one.
3. Highlight the tree branch node and click the Unbranch icon.

PeopleSoft Tree Manager replaces the branch icon with the node icon. Any nodes that report to the
selected node are now available in the tree.

When you remove a tree branch, do not forget to update PeopleSoft Object Security.
Related Links

“Understanding Definition Security” (Security Administration)
“Understanding Definition Security (Browser Client)” (Security Administration)

Granting Security Access to Trees or Branches

86

You can use PeopleSoft Object Security to impose restrictions on your trees, tree branches, and tree
structures with one of the following security levels:

e Full access.
* Read-only access.
¢« No access.

You can also use PeopleSoft Definition Security to restrict access to branches. You can give users access
to an entire tree except for a branch or give them access to the particular branch without granting access to
the tree itself. This task should be performed using Application Designer — Definition Security dialog box.

The following examples show the QE_ PERS DATA tree that has three branches and the definition
security for user permission lists are set differently.
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In this example, branch 00001-Corporate Headquarters is defined with a full access.

Tree Manager
SetlD QEDM1 LastAudit  yaiig Tree
Effective Date 05/05/1997 Status active

Tree Name QE_PERS_DATA Personal Data Tree

Zave Az Close Tree Definition Display Options Print Format Exportto POF

First Page I 8of9 M Last Page

S 00001 - Corporate Headguarters . B f
S [18200] - ALBRIGHT

£ [3300] - VINCENT

£ [3400] - WALTERS

£ [8500] - DUNCAN

£ [3600] - ELIAS

F¥ 10100 - Office of the President

& 20100 - Office of the President (COM)

[=] Notify

In this example, branch 10100 - Office of the President is defined with a read-only access. User has a
read-only access to the 10100 - Office of the President branch, only an Open Branch icon appears for
10100 — Corporate Headquarters branched node.

Tree Manager

SetiD QEDMA Last Audit  y5)ig Tree

Effective Date 05/05/1997 Status  active

Tree Hame QE_PERS_DATA Fersonal Data Tree
Save As Close Tree Definition Display Options Print Format Exportto POF

00009 =10100

Collapse All | Expand Al i First Page [ 2of9 [l Last Page

'.‘;f( 00001 - Carporate Headguarters
B2 [3200] - ALBRIGHT

B 18300] - VINCENT

B2 [3400] - WALTERS

B 18500] - DUNCAN

B2 [8600] - ELIAS

X 10100 - Office of the President b
“ # 20100 - Office ofthe President (CDM])

[=] Motify
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In this example, branch /0100 - Office of the President is opened with read-only access, no modification
actions available for any entries in a branch, tree menu items allow only navigation actions, and user is
not able to save a branch.

Tree Manager

SetlD QEDMA LastAudit  va)ig Tree
Effective Date 05/05/1997 Status  active

Tree Name QE_PERS_DATA Personal Data Tree

Zave As Close Tree Definition Display Opticns Print Format Exportto POF

00001 =10100 =10200

Collapse All | Expand All Firzt Page Bl 130763 Bl LastPage

X 10100 - Office of the President
" £ [3001] - ASD
" P [8501] - BENNETT

¥ [3661] - CHERRIER

IE 10200 - Human Resources =3
. #P [8121]- GREGORY

~ @@ [3641] - DOBBS

- @ [3750] - FULLER

- @ [3760] - ESPINOZA

~ P [3840] - HILL

10300 - Controllers

10400 - Retail Services

""" 10900 - Operations Administration

=] Notify

Note: When a branch is opened, a parent entry in a tree navigation path points to the parent branch to
enable user navigating from a current branch to higher level branches.

Branch security with No access or Read Only access restricts user modification to the specific branch of
the specific tree. It does not prevent a specific user from seeing the content of a secured branch. Users can
work around the limited access by copying a tree with a different name and have unlimited access to that
new branch. To prevent users from seeing the content of the tree branch, a root node of the branched tree
should be secured with No Access or Read Only access as well.
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Read-Only Access

This example illustrates PeopleSoft Tree Manager with read-only access.

Tree Manager

SetlD LastAudit  y3)ig Tree
Effective Date 01/01/1999 Status 4 ctive

Tree Name QE_JOBCODES JohCodes

Close Display Options Print Format Exportto POF

Collapse All | Expand Al Eind Firzt Page [l Sof95 [ LastPage

(= ALL_JOBS - All Job Codes

EXECUTIVE - Executive

7 B0 EXEMPT - Exempt

MOMN_EXEMPT - Man Exempt / Hourly

""" COMSULTAMTS - Consultants & Contractors

In the All Jobs branch, which has read-only access, only the Open Branch icon is available.
When users open the branch, a message warns that users cannot make changes to the branch.

When the read-only branch opens, no edit icons and no Save link appear.

No Access

If users try to access a tree or branch that does not allow access, they receive a warning message.

Related Links
“Understanding Definition Security” (Security Administration)
“Understanding Definition Security (Browser Client)” (Security Administration)

Performing Audits

Performing Audits

After you have completed your tree, you can have PeopleSoft Tree Manager verify that it meets the
restrictions you set for it. For example, if you selected the All Detail Values in this Tree option when you
created the tree definition, PeopleSoft Tree Manager audit verifies that you have included all detail values.

You can perform a tree audit from the Tree Definition and Properties page, by saving the tree, by running
the Repair Tree batch program, or by using the Tree Maintenance page. If you want to audit a closed tree,
use the Tree Maintenance page. To get a report of all of the problems that have been found with the tree,
use the Repair Tree program.

When you perform an audit and find problems, PeopleSoft Tree Manager displays a warning message.
Some examples of the problems are:
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*  One or more nodes have no detail values reporting to them.

* You selected the All Detail Values option, but one or more defined values for the database field do
not appear in the tree.

* If you have not selected the Allow Duplicate Details option, then PeopleSoft Tree Manager checks
for duplicate detail values and detail values with overlapping ranges.

Note: Although PeopleSoft Tree Manager attempts to detect overlapping detail values when the user
inserts or modifies each detail value, the final audit process may detect overlapping or duplicate detail
values that are not caught when the detail value is created or modified.

PeopleSoft Tree Manager also indicates where the problem is.

The warning message flags that the tree is invalid. You can save the tree as a draft tree only, and you
cannot use it with other PeopleTools, such as PeopleSoft Query or PeopleSoft nVision, until the tree is
valid.

The warning message flags that the tree is invalid. You can save the tree as a draft tree only, and you
cannot use it with other PeopleTools, such as PeopleSoft Query, PeopleSoft nVision, and SmartNavigation
pages until the tree is valid.

At this point, you can either correct the problem that is causing the tree to be invalid, or use the Save As
Draft feature to save the tree in an invalid (unfinished) state.

All audits report the first occurrence found of any problem listed in the table. The audits are performed
first on the displayed nodes and details, and then on the nodes in the database.

Node audits are only performed on open trees. If you run an audit from the Tree Maintenance page (from
a closed tree), you run only the Detail audit. When you audit a tree branch, the node audits are performed
on the nodes in the current branch only, while the detail audits are performed on all branches.

Note: These audits report only problems, not values. Run the Repair Tree program to get a complete list
of problems with the tree.

The following table shows a complete list of audit checks.

Check For Purpose When Check Occurs
Overlapping Node Numbers Reports first occurrence of two nodes Always

whose internal node numbering is

overlapping.
Nodes Outside of Parent's Range Reports first occurrence of a node whose | Always

internal node number does not fall within
the parent node's internal node number
range.

Nodes Without Parents Reports first occurrence of a node Always
whose internal node number for a parent
does not have an actual node with that
number.
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Check For Purpose When Check Occurs
Duplicate Node Names Reports the first duplicate node name Always
when it finds a node with the same name
reporting to a different parent node.
Nodes Without Leaves In a detail tree, reports when any Always

terminal node has no leaves.

All Detail Values

Reports if you have not included all
detail values.

When the All Detail Values In This
Tree option is selected on the Tree
Definition and Properties page.

Duplicate Detail Values

Reports if there are any duplicate detail
values.

When the Allow Duplicate Detail
Values option is not selected on the Tree
Definition and Properties page.

Skipped Levels

Reports when a level is skipped.

When the All Levels option is selected
on the Tree Levels page.

Tuning the Performance of the Overlapping Detail Ranges Audit

The name of the PeopleSoft SQL object used for this audit is PS_ TDM SQOLOVERLAP, and it is stored in
the PeopleSoft database. Edit this object in PeopleSoft Application Designer.

To tune the performance of the Overlapping Detail Ranges audit:

1. Select Start > Programs > PeopleTools 8.x > Application Designer.

2. Select File > Open in PeopleSoft Application Designer.

3. Select the SQL option in the Definition drop-down list.

4. Enter PS TDM SQLOVERLAP in the Name field of the Selection Criteria group box.

5. Click the Open button.

The default SQL used for detecting overlapping leaves appears in the Definition workspace.

6. Edit the SQL object as needed.

Specifying Information for Tree Keys

In order for the PS_ TDM_SQLOVERLAP_SQL object to work properly, you must insert the following
PeopleSoft-delivered tree-specific metavariables into the SQL:

e #setid# = SETID
e f#efftdatein#

e #setcntrlvalue#
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e f#treename# = TREENAME

Each time the audit reaches one of these metavariables, the audit inserts the appropriate value.

Chapter 4

Note: These metavariables work only for this SQL object. They are not systemwide metavariables.

Using Metavariables in the SQL Object

The following code provides an example of using metavariables:

SELECT /*+ USE HASH( B ), ORDERED */ A.RANGE FROM, A.RANGE TO, B.RANGE FROM, B.RANG=

E TO

"FROM PSTREELEAF A, PSTREELEAF B

WHERE A.SETID = '#setid#'
AND A.SETCNTRLVALUE = '#setcntrlvalue#'
AND A.TREE NAME = '#treename#'
AND A.EFFDT = %DatelIn('#effdtdatein#')
AND A.DYNAMIC RANGE = 'N'
AND B.SETID = A.SETID
AND B.SETCNTRLVALUE = A.SETCNTRLVALUE
AND B.TREE NAME = A.TREE NAME
AND B.EFFDT = A.EFFDT
AND B.DYNAMIC RANGE = A.DYNAMIC RANGE
AND (A.RANGE FROM <> B.RANGE FROM

OR A.RANGE TO <> B.RANGE TO)

AND B.RANGE FROM <> B.RANGE TO

AND (A.RANGE FROM BETWEEN B.RANGE FROM AND B.RANGE TO
OR (A.RANGE TO >= B.RANGE FROM

AND A.RANGE TO < B.RANGE TO))

The code in this example includes #setid# at each point where the setID value should be inserted. The
same applies to the #t reename#, #effdtdatein#, and #setcntrlvalue# metavariables.

Using Metavariables Multiple Times Within the SQL Object

The following example shows how to use metavariables multiple times within the

PS TDM_SQLOVERLAP_SQL object. Specifically, the code from the previous example has been
rewritten using metavariables in both the top SELECT and bottom SELECT statements in the Union.

SELECT A.RANGE FROM, A.RANGE TO, B.RANGE FROM, B.RANGE TO
FROM PSTREELEAF A, PSTREELEAF B

WHERE A.SETID = '#setid#'
AND A.SETCNTRLVALUE = '#setcntrlvalue#'
AND A.TREE NAME = '$treename# '
AND A.EFFDT = '#effdtdatein#'
AND A.DYNAMIC RANGE = 'N'
AND .SETID = A.SETID

B
AND B.SETCNTRLVALUE = A.SETCNTRLVALUE
AND B.TREE NAME = A.TREE_ NAME
AND B.EFFDT = A.EFFDT
AND B.DYNAMIC RANGE = A.DYNAMIC RANGE
AND (A.RANGE FROM <> B.RANGE FROM
OR A.RANGE TO <> B.RANGE TO)

AND B.RANGE FROM <> B.RANGE TO

AND A.RANGE FROM BETWEEN B.RANGE FROM AND B.RANGE TO
UNION
SELECT A.RANGE FROM, A.RANGE TO,B.RANGE FROM, B.RANGE TO
FROM PSTREELEAF A, PSTREELEAF B

WHERE A.SETID = '#setid#'
AND A.SETCNTRLVALUE = '#setcntrlvalue#'
AND A.TREE NAME = '#treename#'
AND A.EFFDT = '#effdtdatein#'
AND A.DYNAMIC RANGE = 'N'
AND B.SETID = A.SETID

Copyright © 1988, 2024, Oracle and/or its affiliates.



Chapter 4 Creating Trees

AND B.SETCNTRLVALUE = A.SETCNTRLVALUE
AND B.TREE NAME = A.TREE_ NAME
AND B.EFFDT = A.EFFDT
AND B.DYNAMIC RANGE = A.DYNAMIC RANGE
AND (A.RANGE FROM <> B.RANGE FROM
OR A.RANGE TO <> B.RANGE TO)
AND B.RANGE FROM <> B.RANGE TO
AND (A.RANGE TO >= B.RANGE FROM
AND A.RANGE TO < B.RANGE TO)

Setting Tree Performance Options

Setting Tree Performance Options

You can set performance-enhancing options to improve the database performance of queries that use

trees as selection criteria. This includes queries to which tree criteria are added by PeopleSoft nVision
layouts and scopes. Both PeopleSoft Query and PeopleSoft nVision use the tree performance options. The
performance options do not impact PeopleSoft Tree Manager itself, only the performance of programs
that use the tree data.

Because of the many variations of data distributions, indexes, queries, and optimizers, you can select SQL
techniques that will tune your queries for optimum performance. By specifying these options at the tree
level, your trees can be used in queries whether they are run through PeopleSoft nVision. Those options,
however, can be overridden by the performance options set at the PeopleSoft nVision level.

Page Used to Select Performance Options

Use the Performance Options page (PSTREEDEFNPRPTY) to select options to enhance tree performance
as well as performance for queries that involve trees and nVision.

Use these steps to access the Performance Options page:

1. Select Tree Manager, Tree Manager.

2. Create a new tree, or search for an existing tree.

3. On the Tree Manager page, click the Tree Definition link.

4. Click the Performance Options link on the Tree Definition and Properties page.

The Performance Options page appears.
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This example illustrates the fields and controls on the Performance Options page. Definitions for the
fields and controls appear following the example.

FPerformance Options

Tree Hame: QE_PERS_DATA
Access Method Auditing All Detail Values
) use Literal Values (& use All Tree Keys (Default)
(%) Sub-SELECT Tree Selector ) Use Hot Empty Tree Keys
) Join to Tree Selector ) Use This Audit Only In Batch

Cluse Application Defaults

Tree Selectors Tree Change Message Options

(®) static Selector (%) Send Tree Change Message
O Dymamic Selectors ) Don't send Tree Change Message

Selector Options

@] Single VYalues
® Range of Values (>=...<=)
) Range of Values (BETWEEN)

ok | Close |
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Field or Control

Description

Access Methods

Select an access method from:

Use Literal Values: Eliminates a SQL join by retrieving
the detail ranges associated with the selected node and
coding them in the SELECT statement.

Note: This option is not available for use with winter
trees.

Sub-SELECT Tree Selector: Instead of adding the tree
selector to the FROM list of the main query, the tree
selector criteria and its relation to the data in the main
query is within an EXISTS clause in the WHERE portion
of the main query. This is called a correlated subquery.

Join to Tree Selector: Includes the tree selector table
in the FROM clause and uses join criteria to select the
appropriate rows from the fact table. This method is
sometimes used by PeopleSoft nVision, even when
another method is specified, if tree node information is
needed to produce the report.

Use Application Defaults: Uses the tree performance
options specified in the applications that use this tree.
PeopleSoft nVision defaults to the tree performance
options specified in a PeopleSoft nVision layout’s options.
If performance options are not specified in PeopleSoft
nVision, the PeopleSoft nVision’s default performance
options are used. For PeopleSoft Query, this option
defaults to the query’s sub-SELECT method.

Tree Selectors

Select a tree selector type from the following options:

Static Selector: A technique in which a selector represents
the entire tree remains valid until the tree changes.

Dynamic Selectors: A technique in which PeopleSoft
nVision creates a new tree selector for use in a section of
a single report. The dynamic selector represents just the
requested nodes.
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Field or Control

Description

Selector Options

Select a selector option from the following values:

»  Single Values: Used only with dynamic selectors. This
technique causes PeopleSoft nVision or PeopleSoft Query
to build a selector using the individual detail values (from
the detail table specified in the tree structure) that fall
within the detail ranges of the selected nodes.

*  Range of Values (>= <=): For a tree with ranges of
values, this makes the selectors more compact (fewer
rows) and less likely to become obsolete as detail
values are added. For some database optimizers, the
syntax fieldname >= RANGE FROM nn AND
fieldname <= RANGE TO_nn gets a better access
plan than BETWEEN.

*  Range of Values (BETWEEN): Similar to the other Range
of Values selector, but use the syntax fieldname
BETWEEN RANGE FROM nn AND RANGE TO
nn. This is a better choice for ranged selectors on most
database platforms.

Auditing All Default Values

Note: The Auditing All Default Values group box is read-
only when you work with winter trees.

If you've selected the All Detail Values in this Tree option
on the Tree Definition and Properties page and clicked the
Performance Options link, you can select from the following
values:

»  Use All Tree Keys (Default): This is the existing default
auditing behavior. Use this option if the performance time
is acceptable.

*  Use Not Empty Tree Keys: If the performance time is
unacceptable, attempt this option to expedite the process.
If the performance time is still unsatisfactory, then attempt
the Use This Audit Only in Batch option.

»  Use This Audit Only in Batch: If you select this option,
the All Detail Values in This Tree option audit is ignored
during online tree auditing or saving. Consequently,

the All Detail Values in This Tree option audit is run
only through the Application Engine tree audit process.
Although Tree Manager allows you to proceed to save
a tree as a valid tree, you should use the Save Draft
option. After you've saved the tree, proceed to start the
Application Engine auditing process.

Note: Use this option only if the first two options fail to
achieve the desired performance results.
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Field or Control Description

Tree Change Message Options Select a Tree Change Message option from the following:

*  Send Tree Change Message: Select this option to send a
TREE CHANGE message when Tree changes are made.

*  Don't send Tree Change Message: Select this option if
there are no subscribers to TREE_CHANGE service
operations.
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Maintaining Trees

This topic discusses how to maintain trees.

Performing Audits and Deleting Trees

Use the Tree Maintenance page (PSTREEMAINT) to audit a closed tree, copy a tree, delete a tree, or
view a tree.

Navigation:
Tree Manager > Tree Utilities > Copy/Delete Trees

This example illustrates the fields and controls on the Tree Maintenance page. Definitions for the fields
and controls appear following the example.

Tree Maintenance Tree Structure Maintenance
Tree Maintenance
Tree Definitions Customize |Find | view a1 | 0] 88 First K1 21.24 of 24 B Laat
Select Key Type User Key Tree Hame Effective Date Valid Tree
[F] Setld GCIEDN1 GE_DEPT_DvyNAMIC 01401519949 Yalid Tree
[F] Setld QEDM2 QE_ACCOLUNTS 0150151900 Yalid Tree
[F] Setld GEDmM2 GE_DEPT_SEC 0140152001 Yalid Tree
[FI Setld GCIEEL GE_CUBT_PRODUCTS 02927120049 Yalid Tree
Ferfarm Audits Copy Delete W] B
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Field or Control

Description

Key Type Displays the key type associated with this tree.
*  SetID: The tree is identified by tree name and setID.
*  Business Unit: The tree is identified by a business unit.
»  User Defined Node Key: The tree is identified by a user-
defined key.
*  None: The tree does not contain an additional key. It is
keyed only by tree name and effective date.
User Key Displays the key value.
This field is blank if the key type is None.
Valid Tree Displays the status of the tree.

Perform Audits

To audit a tree, select its check box and click this button.

The Last Audit field for the tree changes to Valid Tree if the
tree passes the audit. If the tree fails the audit, the Last Audit
field changes to Draft Tree.

Note: You can get a detail listing of audit errors by running the
Repair Tree batch program.

Copy To access the Tree Definition and Properties page and copy a
tree, select a tree check box and click this button.

Delete To delete a tree, select its check box and click this button.

View To access the Tree Viewer page and view a tree, select a tree

check box and click this button.

Note: Trees secured by PeopleSoft Object Security for anything but full access are not listed and cannot
be updated or deleted from the Tree Maintenance page.

Related Links

Using the Repair Tree Program

Copying Trees

Use the Copy Tree page (PSTREEDEFN) to copy a tree.

Navigation:

Tree Manager > Tree Utilities > Copy/Delete Trees > Copy button
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This example illustrates the fields and controls on the Copy Tree page.

Copy Tree
*Tree Name: |QE_DEF‘T_DYNAMIC
*Structure ID: QE_DEPT_DYMAMIC
“Effective Date: |01/01/1998 [ *Status:
*Description; |Dynamic Detail Dept Tree
*Category: |£§!EDMO ')
“Use of Levels: Level Mot Used Ferformance Options

*SetiD: QEDM1 O
s

] an Detail Values in this Tree 71

Hode Count:
Clanove Duplicate Detail Values
Leaf Count: 21

Level Count: 1]

Perform Audits | Branch Count: 0
Copy | _ Close_|

Make any necessary changes and click the Copy button.

Viewing Trees
Use the Tree Viewer page (PSTREEVIEWER) to view a tree.
Navigation:

Tree Manager > Tree Utilities > Copy/Delete Trees > View button
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This example illustrates the fields and controls on the Tree Viewer page.

Tree Viewer

SetiD: QEDM Effective Date:  01/01/1999

Tree Hame: QE_DEPT_DWMAMIC

First Page 11 of 42 B Last Page

E 00001 - Coparate Headquarers

B 21700 - Toronto Office

10100 - Office ofthe President

10600 - Branch Office Administration
11000 - Information Systems & Technlgy
11200 - Carporate Sales

41000 - Engineering

0000 - Manufacturing Division

55100 - Shipping

2000 - Intensive Care Unit

Cloze |

After viewing the tree information, click the Close button to return to the Tree Maintenance page.

Note: Trees displayed in view mode do not differentiate between standard nodes and branches. All nodes
expand and collapse so that you can view the whole tree. Use the Expand Node Hierarchy icon to
expand all child nodes.

If the multiuser environment is enabled, users will not be able to delete a tree if any branch of the tree — or
the tree itself — is checked out by any user.

Maintaining Tree Structures

This topic discusses how to maintain tree structures.

Deleting Tree Structures

Use the Tree Structure Maintenance page (PSTREESTRCTMAINT) to copy a tree structure, delete a tree
structure, or view a tree structure.

Navigation:

Select Tree Manager > Tree Utilities > Copy/Delete Trees > Tree Structure Maintenance tab
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This example illustrates the fields and controls on the Tree Structure Maintenance page. Definitions for

the fields and controls appear following the example.

Tree Structure Maintenance

Structure Maintenance

Select (Tree Structure ID Description Hude Record Hame Detail Record Hame

o CUBT_PRODUCTSTRUCT Product structure. TREE_MODE_THL PSCUBTPRODUCT
i CUBT_REGIONSTRUCT  RFengional Structures TREE_MODE_TBL PSCUBTREGION
] QE_ACCOUNTS Account Hierarchy TREE_MODE_THL QE_ACCOUNT_THL
[ QE_ACE_845_EMPL ACE 848 Employee Tree TREE_MODE_THL
[[] GQE_ACE_AFTREE GIE ACE All Function Tree TREE_MODE_THL
[0 QE_ACE_DGC_BU Bus Unit Tree for DGC Madel TREE_MODE_THL
] QE_ACE_DGC_DEPT Department Tree for DGC Model TREE_MODE_THL
i QE_ACE_DGC_DTRG DAte Range TREE_MODE_TBL QE_ACE_DGC_DTRG
] QE_ACE_DGC_EMPD EMPLOYEE 1D TREE_MODE_THL QE_ACE_DGC_EMPD
[0 GQE_ACE_DGC_EMPLID QE_ACE_DGC_EMPLID_Mavigation TREE_NODE_THEL
[[] QE_ACE_DGC FRODID  Productld Tree TREE_MODE_THL GE_ACE_PRDID_WAW
Fl QE_ACE_FPRODLICTS Product Tree for ACE Smoke Tes TREE_MODE_THL
] QE_CUBT_PRODUCTS For Cube Manager Testing TREE_MODE_THL QE_CUBTPRODUCT
i QE_CUBT_REGSTRUCT For Cube Manager Tasting TREE_MODE_TBL QE_CUBTREGION
o QE_FPERS_DATA Fersanal Data TREE_MODE_THL QE_EMPLOYEE
i QE_PROJECT Project Data QE_PROJECT_THL

Copy I Delete Wi

Field or Control

Description

Node Record Name Displays the name of the record that stores information about
the tree nodes.

Detail Record Name Displays the name of the record definition that corresponds to
the kind of detail value in the structure.

Copy To access the Copy Tree Structure page and copy a structure,
select a structure check box, and click this button.

Delete To delete a tree structure, select its check box and click this
button.
You cannot delete a structure that is currently being used by a
tree.

View To access the Tree Structure Properties page and view a

structure, select a structure check box and click this button.
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Note: Tree structures secured by PeopleSoft Object Security for anything but full access are not listed and
cannot be updated or deleted from the Tree Structure Maintenance page.

Copying Tree Structures
Use the Copy Tree Structure page (PSTREESTRCTCOPY) to copy a tree structure.
Navigation:
1. Select Tree Manager > Tree Utilities > Copy/Delete Trees.
2. Select the Tree Structure Maintenance tab.
3. Select a tree structure and click the Copy button.

This example illustrates the fields and controls on the Copy Tree Structure page.

Copy Tree Structure

Tree Structure ID: QE_PRCOJECT
*New Tree Structure Id:

*New Description: Project Data

Copy Close

To copy a tree structure:

1. In the Copy Tree Structure page, enter a new tree structure ID.
2. Change the description in the New Description field.

3. Click the Copy button.

You return to the Tree Structure Maintenance page. The new tree structure is listed.

Viewing and Editing Tree Structures
Use the Tree Structure Properties page (PSTREESTRCTDEFN) to view a tree structure.
Navigation:
1. Select Tree Manager > Tree Utilities > Copy/Delete Trees.
2. Select the Tree Structure Maintenance tab.

3. Select a tree structure and click the View button.
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This example illustrates the fields and controls on the Tree Structure Properties page.

| structure [ ILSiEIST | I |

Tree Structure Properties
Structure ID: QE_FERS_DATA

*Description: Persanal Data

*Twe: Dretail

Additional Key Field Havigation Options

() Setld Indirection [ INode Mutti-Navigation
) Business Unit [ petail Multi-Mavigation
C user Defined

) Hone

Select the Levels, Nodes, and Details tabs to view additional information.

Click the OK or Cancel button to return to the Tree Structure Maintenance page.

Related Links
Understanding Steps to Create Trees

Subscribing to TREE_CHANGE Service Operations

This topic discusses how to subscribe to TREE  CHANGE service operations.

Understanding TREE_CHANGE Service Operations

Every time you perform an action in PeopleSoft Tree Manager to change a tree definition (such as delete,
any kind of save, copy, branch, or unbranch), a TREE_CHANGE service operation is published based on
the Tree Key information using the PSTREEPUBSUB record.

Note: From PeopleTools 8.48, sending a TREE_ CHANGE service operation every time tree changes
are made is optional. To improve performance, you can select not to send a TREE _ CHANGE service
operation whenever you change a tree definition. The default setting is sending a TREE_ CHANGE
service operation. This service operation is not saved to the database.

If applications want to use TREE CHANGE service operation, they must create a service operation
handler. The service operation handler runs every time this service operation is published.
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This example shows the TREE  CHANGE service operation.

i TREE_CHANGE (Message) =3
e Message Structure Field Hame Alias |In-::|ude|
|23 VERSION_1 1 | TREE_EVENT_ID v
&3 PSTREEFUBSLIE 2 |EVENTNAME ¥
t;‘ﬁ Message Subscriptions 3 |SETID_OLD 7
4 | SETCMTRLYALLE v
5 | TREE_MAME_OLD 7
£ _|EFFDT_OLD v
7 | TREE_BRANCH_O v
8 |SETID_NEW v
9 |SETCMTRLWALLE 4
10| TREE_MAME_ME W
11 | EFFDT_MEW 7
12| TREE_BRAMCH_N 7
13| TREE_STRLCT_ID W

Note: The field EVENT _ID is defined in the Financials database as a Char, 20 field, and is used by
a number of applications. In PeopleTools PSTREEPUBSUB, the field was defined as a Number, 6.
To avoid conflicts, EVENT ID has been removed from PSTREEPUBSUB and replaced with

TREE EVENT ID.

This change may affect applications who subscribe to the TREE_CHANGE event, and check for
EVENT ID in PeopleCode using field name.

Creating a Notification PeopleCode
To create a notification PeopleCode:
1. Select Go > PeopleTools > Application Designer.

2. Create an application package and an application class that implements PS_PT: Integration:
INotificationHandler interface.

For a subscription, you use the INotificationHandler application class and the OnNotify method, and
optionally use the OnError method for error handling.

Note: This application package PeopleCode is tied to the TREE CHANGE service operation through
a service operation handler.
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This example shows an application class that is used to subscribe to TREE_CHANGE service operation
(1 of 2).

| TREE_CHANGE_SUB_TEST (application_class) lenExamta

import PS_PT:Integration:INotificationHandler;

class TREE_CHANGE_SUB_TEST implements P2_PT:Integration:INotificationHandler
method TREE_CHANGE SUEB_TEST();
method OnNotify(& M3G As Message);

private
method LogToFile(ifName As string, &txt As string);

end-class;

/* constructor */

method TREE CHANGE SUE_TEST
rem do nothing;

end-method;

method OnNotify
/+ &_MBG as Message +/
/+ Extends/implements P3_PT:Integration:INotificationHandler.OnNotify +/
f* Variable Declaration */

Local Message Grequest M3G;

Local Rowset &request R3., 4response RS;
Local Record EP3TREEPUEB3UE;

Local any &QryNode, &I;

/* Bubscription PeopleCode */
/* Get the reguest message from gqueus */
Erequest MSG = & MSG;

/* Get the request rowset object from the buffer */
Erequest RS = &reguest M3G. GetRowset();

Copyright © 1988, 2024, Oracle and/or its affiliates. 107



Maintaining Trees

Chapter 5

This example shows an application class that is used to subscribe to TREE_CHANGE service operation
(2 of 2).

| TREE_CHANGE_SUB_TEST (application_class) jIOnExecuie

/* Extract the record from the message rowset*/
SPITREEPUBSUE = &request_RI.GetRow(l) .GetRecord(Record. PATREEPUBSUE);
/* Get Changes */
If £ZP3TREEPUB3UEB => Null Then
Local string &setIdOld = PSTREEPUEBSUB. 3ETID OLD.Value;
Local string &setentrlvalueCld = PSTREEPUBAUE. SETCNTRLVALUE_OLD.Value;
Local string &treenameOld = PITREEPUBSUE.TREE_NAME OLD.Valus;
Local string &effdtOld = PSTREEFUB3UB.EFFDT_ OLD.Value;
Local string &treebranchOld = PETREEPUBSUE. TREE_ERANCH OLD.Value;
Local string &setidNew = PSTREEPUESUBE. SETID_NEW.Value;
Local string &setcontrlvalueNew = PITREEPUBSUB. SETCNTRLVALUE_NEW. Valus;
Local string &treenameNew = PSTREEPUBSUE. TREE_NAME NEW.Value;
Local string &effdtNew = PSTREEPUESUB.EFFDT_NEW.Value;
Local string &treebranchNew = P3TREEPUBSUB. TREE_ERANCH NEW. Value;
End-If;

/* Do something with a received message;
for example, log message to a file =/

Local string &logstr = “Tree ha=s been changed from * | Char(10);

tlogstr = &logstr | &=2etIdOld | " " | &zetentrlwaluelld | " ";

&logstr = &logstr | &treenamedld | " " | Geffdtdld | " " | &treebranchold;

Glogstr = &leogstr | Char(l0) | "te” | Char(l0);

&logstr = klogstr | &setIdold | " " | &setentrlvalueNew | " " | &setentrlvaluesNew | "
Glogstr = flogstr | &treenameNew | " " | GeffdtNew | " " | &treebranchOld;

#This.LogToFile("c: \temph\subscription.log®”, &logstr);

end-method;

method LogToFile

f+ &fName as String, +/
A+ Gtxt as Jtring +/
Local File &myFile;

tmyFile = GetFile(&fHame, "W", "A", &FilePath Absolute);
If émyFile.I=zOpen Then

EmyFile.WritebLine (&txt);

smyFile.Clo=e();
End-If;

end=-method;

In the previous example, TREE_CHANGE_ SUB_TEST application class has three methods.

The constructor, TREE_ CHANGE_SUB_TEST and the event handler, OnNotify are required.

TREE CHANGE SUB_TEST application class has an extra method LogToFile that is used for testing
purposes only. This message records a data retrieved from a message being received.

Related Links

“Understanding Sending and Receiving Messages” (Integration Broker)

Configuring Integration Broker

108

To configure Integration Broker in PIA:

L.

The search page appears.

Select TREE_CHANGE service operation name, and click the Search button.

Select PeopleTools > Integration Broker > Integration Setup > Services Operation
Definitions.
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3. Click the TREE_CHANGE link.
The General page appears.

4. On the General page, select the Generate Local-to-Local option.
Local-to-local routing is auto-generated.

This example illustrates the fields and controls on the General page - Service Operation.

General Handlers Routings

Service Operation TREE_CHANGE
Operation Type  Asynchronous - One Way
*Operation Description | TREE DEFINITION CHANGED MSG

Operation Comments " user/Password Required

*Req Verification |F-J-:|ne =

Service Operation Security

Owner ID |Pe-3pIeT-3-JIS j

Operation Alias
Default Senice Operation Version

*Version |VERSION_1 7 Defautt W Active

Version Description Routing Status

Version Comments
Any-to-Local Does not exist

Local-to-Local Does not exist

Local-to-Atom  Does not exist.

Runtime Schema Validation Routing Actions Upon Save

I" Request Message I” Generate Any-to-Local

I” Generate Local-to-Local
" Non-Repudiation

Message Information

Type Request

Message.Version | TREE_CHANGE.VERSION_1 3, View Message
*Queue Name | TREE_MAINT Q. View Queus Add New Queue
Save Return to Service Add Version

Related Links

“Understanding Managing Service Operations” (Integration Broker)
ing a Service Operation Handler
Use the Handlers page to create a service operation handler.

Navigation:

PeopleTools > Integration Broker > Integration Setup > Services Operation
Definitions > General > Handlers
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This example illustrates the fields and controls on the Handlers page - Service Operation.

General Handlers Routings

Service Operation TREE_CHAMNGE
Default Version VERSION_1

Operation Type Asynchronous - One Way

Handlers Personalize | Find | View All | @I L«.:_ﬁl First ‘4 10f1 '/ Last
*Hame *Type Sequence *Implementation *Status
1 [TREE_CHANGE IOn Motify v[ 1 |App|icati-:|n Class =] |.¢.l:ti'v'e »| Details +] [=]
Save Return to Service

To create a service operation handler:

1. Select PeopleTools > Integration Broker > Integration Setup > Services Operation
Definitions.

2. Select TREE CHANGE service operation name, and click the Search button.
3. Click the TREE_CHANGE link.

4. Click the Handlers tab from the General page, and enter a handler name.

5. Select the On Notify option from the Type drop-down list.

6. Select the Application Class option from the Implementation drop-down list.
7. Click the Details link.

The Handler Details page appears.

o

Populate the required fields with data from the application package that you created.
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This example illustrates the fields and controls on the Handler Details page populated with data from the
application package.

Handler Details

Handler N\ame TREE_CHAMNGE
Handler Type  On MNotify
Description |TREE_CHANGE Message Handler

Message appears when tree definition is changed.
Comments geapp .

Handler Owner

Application Class

*Package Name |EMAIL_MSG Q
*Path |’ Q
Class D | EMAIL_GUARANTEED Q,
Method | OnNotify [

Note: There is a colon in the Path field.

Related Links
“Adding Handlers to Service Operations” (Integration Broker)

Setting Full Access to the Permissions List
To set full access to the corresponding permission list:

1. Select PeopleTools > Integration Broker > Integration Setup > Services Operation
Definitions.

2. Select TREE CHANGE service operation name, and click the Search button.
3. Click the TREE_CHANGE link.
4. In the General page, click the Service Operation Security link.

The Web Service Access page appears.

5. Set full access to corresponding permissions list, and click the Save button.

Note: For additional security setting, check whether the permission list used for your user includes
TREE MAINT queue. Also, check whether TREE_MAINT queue has full access rights.
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This example illustrates the fields and controls on the Web Service Access page.

Web Service Access

Operation: TREE_CHANGE

Personalize | Find | @| L;_ﬁ' First

Permission

Permission List Access

4 1of1 &
Last

PTFT1200 ) | Full Access

§ & =

Testing a Subscription Process
To test a TREE_ CHANGE subscription process:

1. Select Tree Manager, Tree Manager.

2. Search for an existing tree and open it in the Tree Manager page.

3. Change any tree and save it.

Note: You can also use Save As functionality to create a new tree.

4. Select PeopleTools > Integration Broker > Service Operations Monitor > Monitoring >

Monitor Asynchronous Services.
5. Select the Subscription Contracts tab.

6. Select a node in the Node Names field.

7. Select the TREE CHANGE option from the Service Operation drop-down list.

8. Select the TREE MAINT option from the Queue Name drop-down list.

9. Click the Refresh button.

A list of service operations are displayed under your test subscription.
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This example illustrates the fields and controls on the Subscription Contracts page with the list of service

operations received under test subscription.

[ Archived

Node Name [QE_LOCAL Q

Q ™ user Level view

Status | Done ~

Service Operation TREE_CHANGE

Queue Name | TREE_MAINT Q

Transaction ID|

Correlation ID|

Time Period
From Date i To Date E
From Time To Time | Refresh

First Bl 1zor2 B oot

8348ea00-3acC-1182-0845-

11/30/2012

849903d 1-3acc- 1182-8535-
e TREE_MAINT  QE_LOCAL 1 TREE_CHANGE  VERSION_1 Sub Queue Link  Done R R SR Details
62d19307-3acc- 1122-6535- 11/30/2012 283ee607-3a00-1182-h645-
r TREE MAINT ~ QE_LOCAL 1 TREE_CHANGE  VERSION_1 Sub Queue Link  Done P e e Details

19540057836
¥ SelectAl [T Deselect Al

Resuomt | Cancel |

When you click the Details link in the Results section of the Subscription Contracts page, the
Asynchronous Details page appears.

This example illustrates the fields and controls on the Asynchronous Details page.

Asynchronous Details
Transaction ID

External Service Name
Publishing Node

Queue Name

Queue Status

Queue Sequence ID

Sub Queue

Original Publishing Node

Status

e |B Info
Subscription Contracts

efment
TREE_CHANGE 1

Done

8348ealh-3acc-11e2-hB45-5c0fa1005d20
TREE_CHANGE WERSION_1

Refresh

QE_LOCAL “Segment
TREE_MAINT Wi bl ﬁl
Running
73
QE_LOCAL
DONE Uncompressed Data Length 3246
Data Length Yiew Limit 100000

Status

Wi XML

Eesubrmit

Bl &=
Fersonalize | Find B 2

cancel Wiew Error/info iey |B Info

First n 1011 u Last

Handler Tester

|§ﬁReium to Eearch

Note: If a subscription PeopleCode test program is used as in previous example, you can view the file
being generated (Windows OS) as a part of a test subscription class at e:\temp\subscription.txt.
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Auditing and Repairing Trees

Understanding the Auditing and Repairing of Trees

Tree repairs should be performed on trees that are having problems or have had major changes made to
them.

Before using the repair programs, you should first run audits to learn which trees, if any have problems
and which utility will repair the damaged tree. Review the audit reports to determine the correct solution
for repairing your tree. You may need to run more than one utility program.

The Repair Tree program is designed for administrators who need a wide range of utilities with which to
work. Besides containing various utilities for repairing trees, the Repair Tree program also includes the
Tree Audits utility.

The Tree Auditor program is only the Tree Audits utility, and is designed for users who only need to audit
trees.

Running the utility programs may result in a large number of updates to the tree. Because the system
automatically puts a lock on a tree while the process is running, you should run these programs during off-
work hours, to lower the risk of users trying to access the tree.

You should also perform a backup of your tree tables before running the repair programs.

Note: If you expect that saving a tree will take an especially long time due to an audit running as a

part of saving process or on account of large, memory-intensive trees, PeopleSoft recommends that

you save the trees as drafts, then run the audits with Application Engine using the Repair Tree or Tree
Auditor programs. After the audits have completed without finding any problems, the tree status will be
automatically changed to Valid Tree.

Using the Repair Tree Program

Use the Repair Tree page (RUN_TREE UTILITIES) to audit, troubleshoot, or repair problem trees.

Note: Use the Repair Tree Application Engine program to audit and repair trees. You can also use the
Tree Auditor Application Engine program to audit trees.

Navigation:
Access the Repair Tree page by selecting Tree Manager > Tree Utilities > Repair Trees.

Optionally, access the batch audit function by selecting Tree Manager > Tree Auditor.
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This example illustrates the fields and controls on the Repair Tree page. Definitions for the fields and
controls appear following the example.

Repair Tree
Run Control ID: 111

Tree Utility Type

Beport Manager Process Monitor Fun |

*Tree Litilit: | Tree Audits

Audit Scope

® Single Tree O Muktiple Trees

Tree Definition

Tree Name: |CUBT_PRODUCTS

Q. Setid:

EUR Q

Date Selection

O As of Current Date
O s of Specific Date
O &l Trees

0B B2009

© Effective Date of Tree |10/27/2008 O

Wiew Resulis

Field or Control

Description

Report Manager

Click the link to access the report manager inquiry page.

Process Monitor

Click the link to access the process manager inquiry page.

Note: If any trees are skipped while running any repair or
audit programs due to an existing checkout, you see a status
of Warning after the repair or audit program has completed.
When this occurs, you should check the log to determine
which trees have been skipped, and then rerun the appropriate
program after the checked-out trees have been released.

See “Viewing the Process List” (Process Scheduler).

Run

Click to run a Process Scheduler request.
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Field or Control

Description

Tree Utility Type

Copyright © 1988, 2024, Oracle and/or its affiliates.

Note: Typically, you would run the audits first, and then select
a repair program as indicated by the audit results.

Select a tree utility from the following options:
*  Tree Audits: Audits a selected tree or subset of trees.

*  Correct Level Numbers: Ensures level numbers are
correct. Reset node numbers are equal to the parent node's
level number plus one.

*  Correct Parent Node Numbers: Ensures parent node
numbers are correct in the tree node table.

*  Delete Orphan Tree Objects: Ensures there are no orphan
nodes or levels.

When running this repair program and specifying a tree,
the program only deletes orphan nodes and leaves, not
orphan levels.

When running the program for all trees, this program
deletes orphan nodes and leaves, and then deletes orphan
levels. This is because orphan levels are not tied to a
specific tree.

Orphans can be the result of the following three
situations:

1. The parent node that the orphan leaf refers to no
longer exists.

These orphans are removed when running this
program either for a specific tree or all trees.

2. The tree name that the orphan leaf refers to no longer
exists.

These orphans are removed only when running this
program for all trees.

3. The Query Access Group record no longer exists in
PSRECDEFN.

These orphans are removed when running this
program either for a specific tree or all trees.

*  Remove Tree Branches: Removes all branches from the
selected tree.

*  Remove Tree Reservations: Cancels all current checkouts.
This utility is helpful because if you try to audit or repair
any trees that are currently reserved, the audit or repair
utility will skip the reserved trees. For this reason, you
can use this utility before running any audit or repair tree
utility to ensure that the audits or repairs are performed
on every tree. Also use this utility during emergency
situations.
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Field or Control

Description

Note: PeopleSoft recommends you use this utility
judiciously. When you run this utility, all unsaved changes
of users currently editing trees will be lost.

Reset Tree Node Gaps: Re-gaps a tree, so that intervals
between tree nodes and their node numbers are evenly
distributed. Consider running this program if you start to
get messages that nodes can no longer be inserted into a
tree.

Note: The SQR program PTUGAPTR is also available
for re-gaps. PTUGAPPTR.SQR is an interactive SQR
program which prompts for user inputs and can only run
interactively from a Windows client.

Update Tree Table Statistics: Calls the databases Update
Statistics utility on the PeopleSoft Tree Manager tables.
This program can be run whenever large changes have
been made to trees or a large tree is imported or deleted
from the database.

Report Only: Select to run a report to view results prior to
updating the tree. Not available for all utilities.

Audit Scope

Available options are:

Single Tree: Select to run the selected utility for a single
tree. Not all utilities can be run for single trees.

Multiple Trees: Select to run the selected utility for
multiple trees. Fields in the Tree Definition group box
become unavailable. Not all utilities can be run for
multiple trees.

Tree Definition

Available options are:

Tree Name: Select a tree to audit or repair.

Setld, Business Unit, or Tree Key Value: Select the setID,
business unit, or tree key value for the specified tree. The
field is not available if the selected tree does not have a
setID, business unit, or tree key value.
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Field or Control

Description

Date Selection

Available options are:

Effective Date of Tree: You can select an effective date to
run the audit on a single instance of the tree.

As of Current Date: Select to audit trees which have the
most recent effective date. If you select Single Tree in
the Audit Scope group box and select a specific tree,
only the instance of the tree with the most recent effective
date will be audited. If you select the Multiple Trees
option in the Audit Scope group box, all trees whose
effective dates are current will be audited. This option is
only available for the Tree Audits utility.

As of Specific Date: Select to enter a specific date. If you
select the Single Tree option in the Audit Scope group
box and select a specific tree, only the instance of the tree
whose effective date matches the specified date will be
audited. If you select the Multiple Trees option in the
Audit Scope group box, all trees whose effective dates
match the specified date will be audited. This option is
only available for the Tree Audits utility.

All Trees: Select to audit all trees. If you select the Single
Tree option in the Audit Scope group box and select a
specific tree, all instances of this tree will be audited,
regardless of effective dates. If you select the Multiple
Trees option in the Audit Scope group box, all instances
of all trees will be audited. When you select Multiple
Trees, fields in the Tree Definition group box become
unavailable. This option is only available for the Tree
Audits utility.

View Results

Click the link to open a new browser instance that displays the
Batch Report page.

Enter a run control ID to view the results from running audits
or a utility program.

Audits Performed

The following table lists the types of audits performed from the Repair Tree program. These audits differ
from those performed on the Tree Definition and Properties page.

Audit Type

Checks For

Purpose

Detail Values

Orphan tree leaves.

Lists detail values that refer to an invalid
tree node number.
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Audit Type

Checks For

Purpose

Detail Values

Detail values not found in the tree.

Lists any detail values that are found in
application table but are not defined in
the tree.

This audit is only performed if the
All Detail Values option on the tree’s
Definition and Properties page is

selected.

Detail Values

Duplicate detail values.

Lists any detail values that are defined
more than once in the tree.

This audit is only performed if the Allow
Duplicate Detail Values option on the
Definition and Properties page of tree is

cleared.

Detail Values

Detail values with overlapping ranges.

Lists detail values that are defined as
a range of values that overlap another

detail value’s range of values.

This audit is only performed if the Allow
Duplicate Detail Values option on the
tree’s Definition and Properties page is
cleared.

Detail Values

Nodes with no child nodes or detail

values specified.

Lists any nodes that do not have any
detail values or child nodes defined. This
audit is performed for detail value trees
only.

than the end number of parent.

Node Audit Nodes without a parent. Lists tree nodes that refer to an invalid
tree node number.
Node Audit Tree node numbers that are greater than | Lists tree nodes with end numbers
end numbers. greater than the node number.
Node Audit Tree node end numbers that are greater | Lists tree nodes with end numbers

greater than the parent node's end
number.
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Audit Type Checks For Purpose
Node Audit Tree nodes with overlapping ranges. Lists tree nodes whose node number
and ending node number overlaps with
another range of node numbers.
Note: When this occurs the tree is
corrupted.
Node Audit Node level numbers that are less than the | Lists any tree node with level numbers
parent node’s level number. less than the level number of parent.
Structure Audit A level record name in the Tree Structure | Lists tree structures that reference an
table that does not exist in Record invalid record name for the tree level
Definition table. application data.
Structure Audit A node record name in the Tree Structure | Lists tree structures that reference an
table that does not exist in Record invalid record name for the tree node
Definition table. application data.
Structure Audit A detail record name in the Tree Lists tree structures that reference an
Structure table that does not exist in invalid record name for the tree detail
Record Definition table. values application data.
Structure Audit A missing tree structure record. Lists any trees that refer to a tree
structure that is not found in the Tree
Structure table.

Related Links

“Understanding Report Manager” (Process Scheduler)
“Understanding Process Monitor” (Process Scheduler)

Reviewing Audit Results

Use the Batch Report page (PSBATCHREPORT) to view results of an audit.
Navigation:
Tree Manager > Tree Utilities > Tree Audit Reports

Alternatively, click the View Results link on the Tree Utilities page, click the View Results link on the
Repair Tree page, or click the View Results link on the Tree Auditor page.
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This example illustrates the fields and controls on the Batch Report page. Definitions for the fields and
controls appear following the example.

User ID:

Batch Report

Process Instance: a2 Run Control ID: 111

Show Reports Criteria

' Reports with Data ) All Reports

FTODOCKM Run Date/Time: OB 2/09 9:30:56AM

Report List
Open Report Report Content
B BT Tree E_tru_c:ture tahle cnnta_ins Level Record Mame that does 0
not exist in Record Definition takle
Open Report Tree S_tru_cture table cnnt;_ina Mode Record Mame that does 0
hot exist in Record Definition tahle
G BT Tree S_tru_u:ture table cnnt;_ins Cetail Record Mame that does q
hiot exist in Recard Definitian takle
Dpen Report FParent Mode Does Mot Exist 15
Qpen Repart Qrphan Tree Leaves
Cpen Report Tree Mode Mumbers are Greater than End Mumber
G BT Tree Modes' End Mumber is Greater than Parent's End q
Mumber
Cpen Report Tree Modes With Cverlapping Ranges
Qpen Repart Mode's Level Mumber iz less than Parent's Level Mumber
Field or Control Description
Show Reports Criteria Available options are:

*  Select the Reports with Data option to list only those
reports that contains data. This is the default value.

»  Select the All Reports option to list all reports.

Report List

Lists each available report, with report title and total row
count.

Click the Select link to access each report. The Select link is
inactive for reports with zero row count.

Reviewing Individual Reports
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Access a report page (PSBATCHREPORTLIST) to view individual reports.

Navigation:
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1. Select Tree Manager > Tree Utilities > Tree Audit Reports.

2. Click the Select link for a report on the Repair Tree Report page.

Reports contain the following information:

* Instructions and recommendations on how to correct the problem.

* Tree identifying information, if more than one tree is affected. This includes:

e setlD

¢ Set control value

¢ Tree name

* Effective date

* Node information for the affected nodes, which might include:

* Node name

* Node number

*  Node end number

* Parent node

* Parent node number
* Parent level number
* Range from

* Rangeto

The following table discusses details on fixing problems associated with reports.

Problem

Solution

Parent node does not exist.

If there are no other audit errors for this tree, then running the
Correct Parent Node Numbers utility program should correct
this problem.

Do not run the Correct Parent Node Numbers utility program
if there are other audit problems with this tree. The other errors
should be addressed first before trying to correct problems by
running the utility program.

Orphan tree leaves.

Run the Delete Orphan Tree Objects utility to delete these
records.
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Problem

Solution

Tree node numbers are greater than end number.

Use PeopleSoft Tree Manager to delete these nodes, and then
run the Reset Tree Node Gaps utility program. You will then
need to use PeopleSoft Tree Manager to reinsert the problem
nodes.

Note: Deleting a node causes all of its children to be deleted.
Therefore, if the problem node has child nodes or leaves under
it, you will have to recapture those as well. If it is not possible
to use PeopleSoft Tree Manager to delete the problem nodes,
call the PeopleSoft Support Center for help to analyze this
problem.

End number of tree node is greater than end number of parent.

Use PeopleSoft Tree Manager to delete these nodes and then
run the Reset Tree Node Gaps utility program. You will then
need to use PeopleSoft Tree Manager to reinsert the problem
nodes.

Tree nodes with overlapping ranges.

Use PeopleSoft Tree Manager to delete these nodes and then
run the Reset Tree Node Gaps utility program. You will then
need to use PeopleSoft Tree Manager to reinsert the problem
nodes.

Level number of node is less than level number of parent.

The level numbers can be corrected by either:
*  Switching the levels in PeopleSoft Tree Manager.

*  Running the Correct Level Numbers utility to reset all
invalid level numbers on the tree.

Copyright © 1988, 2024, Oracle and/or its affiliates.



Chapter 7

Using TreeMover

Understanding TreeMover

This topic provides an overview of TreeMover.

Purpose of TreeMover

TreeMover enables you to move PeopleSoft trees between different PeopleSoft application databases. It
enables you to export a tree to a flat file and to import a tree from a flat file. TreeMover moves all types of
tree data, including the tree definition, tree structure, tree nodes, tree leaves, tree node data, and tree level
data.

TreeMover does not support branched trees. If you import a branched tree, the branches become regular
tree nodes.

Advantages of using TreeMover instead of other methods of moving trees, such as Data Mover or custom
SQR, include:

+ TreeMover can move trees between different versions of PeopleSoft databases, for example, from a
PeopleSoft Financials 7.5 database to a PeopleSoft EPM 8 database.

» Tree Mover can move tree node data (description, setID, effective date, and effective status) for trees
that have node data stored in the PS_ TREE NODE_ TBL (the table that stores the tree node data is
specified as part of the tree structure).

» Tree Mover can move tree level data (long description, short description, setID, effective date, and
effective status) for trees that have level data stored in the PS_ TREE LEVEL TBL—the table that
stores the tree level data is specified as part of the tree structure.

» TreeMover uses the tree APIs, which means the same logic used for the PeopleSoft Tree Manager
application is used to load and unload trees using TreeMover.

All the same edit checks are performed on a tree created with TreeMover as are performed on a tree
created manually with PeopleSoft Tree Manager because both use the same functionality to create the
tree. Because TreeMover processes are initiated from standard PeopleSoft pages, the ability to import and
export tree data can be restricted by using PeopleSoft standard security mechanisms for limiting access

to pages. If a source tree uses branches, you need to recreate them after TreeMover finishes its import
operation.

Here are some example tasks that you can use with TreeMover:

* Load a winter tree with nodes from a legacy financial database quickly and easily into PeopleSoft 8
databases.

* Automatically replace an account tree every month with a new tree based on current information.
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Note: When the PS TREEBASEDIR environment variable is set, the flat file for the import process is
located in %PS TREEBASEDIR%\<USER>\InputFilename and the flat file for the export process is
located in %PS TREEBASEDIR%\<USER>\OutputFilename. You can override this and create another
location using the Process Definition Override page.

TreeMover currently supports fixed-format files only.

TreeMover does not support related language tables.

When you export a tree containing text data, the data is saved in the codepage of the server—for example,
CP1252 Western European on English Windows, or CP932 Shift-JIS on Japanese Windows. Any
characters which are not valid in the server's codepage are converted into question mark characters.

TreeMover consists of three parts: a utility to export a tree from a PeopleSoft 8 database, a utility to
import a tree into a PeopleSoft 8 database, and a utility to export a tree from a PeopleSoft 7.x database.
The import and export functionality for a PeopleSoft 8 database is implemented as a PeopleSoft
Application Engine application process. As with other Application Engine processes, they can be
scheduled to run automatically from the Process Scheduler. The Application Engine process uses
PeopleCode Tree APIs, PeopleCode File APIs, and file layout definitions. The utility that enables you to
export trees from a PeopleSoft 7.x database is implemented as an SQR program (TMDOWNLD.SQR).

Related Links

“Defining Process Type Definitions” (Process Scheduler)

“Understanding Setting PS_FILEDIR, PS_SERVDIR, and PS_ TREEBASEDIR Environment
Variables” (Integration Broker)

“Setting PS_FILEDIR and PS_ TREEBASEDIR in Microsoft Windows Environments” (Integration
Broker)

“Setting PS_FILEDIR and PS_TREEBASEDIR in UNIX Environments” (Integration Broker)

Populated Record Types

126

TreeMover uses the following PeopleTools system tables for trees during both the tree import and tree
export processes:

«  PSTREEDEFN

- PSTREENODE

«  PSTREELEAF

«  PSTREESTRCT

«  PSTREELEVEL

« PS TREE LEVEL TBL
- PS_TREE NODE TBL

TreeMover also reads the PSSTATUS table during the tree export process to identify the version of the
tree data exported.
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As delivered, TreeMover uses seven different file layouts. All the data for an exported tree is contained in
a single file. Prior to a change in the file layout used for the export file, TreeMover writes a header record
to the file to indicate what the next file layout is. The following table lists the standard file formats, along
with their actual file layout name and the text of the header record that precedes a given layout data.

File Layout

Description

Header Record Text

TREE_VERSION

Contains the PeopleTools release number
used to create the export data file. If a
tree version is not provided, then the
TreeMover import program assumes that
the tree data is from a database before 8.
1.

999TREE_VERSION

TREE STRUCTURE

Used for data from the PSTREESTRCT
table.

999TREE STRCT

TREE DEFN

Used for data from the PSTREEDEFN
table.

999TREE_DEFN

TREE USERLEVEL

Used for data from PS_ TREE LEVEL
TBL.

999TREE_USERLVL

TREE_LEVEL

Used for data from the PSTREELEVEL
table.

999TREE_LEVEL

TREE USERNODE

Used for data from PS_ TREE _NODE
TBL.

999TREE USERND

TREE NODE

Used for data from the PSTREENODE
and PSTREELEAF tables.

999TREE NODE

The TreeMover export program processes the data in the order listed in the preceding table.

If you write your own export file, then you must adhere to the following rules:

»  The Tree Structure record, if present, must always come first in the file.

If it is not present, the TreeMover import program defaults to the record layouts used prior to release

8.1.

e The Tree Definition record, if present, must come after the Tree Structure record.

* The Tree Level records—only for trees with levels—must come before the Tree Node and Leaf

records.

* The Tree Node and Leaf records are required for any export file.
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The TreeMover file formats and contents are:

Chapter 7

Prior to the change in the record layout, you must precede the next data record with the appropriate

header record for that file format.

999TREE_VERSION
Tree Version Data
999TREE STRCT
Tree Structure Data
999TREE_DEFN
Tree Definition Data
999TREE USERLVL
Tree Level Data 1
Tree Level Data 2
Tree Level Data N
999TREE LEVEL
Tree Level 1

Tree Level 2

Tree Level N
999TREE USERND
Tree Node Data 1
Tree Node Data 2
Tree Node Data N
999TREE _NODE
Tree Node 1

Tree Node 2

Tree Detail 1

Tree Detail 2

Tree Node 3

Tree Node 4

Tree Node N

Tree Detail 5

Copyright © 1988, 2024, Oracle and/or its affiliates.



Chapter 7 Using TreeMover

¢ Tree Detail N

This is an example of TreeMover.

999TREE_VERSION

08.50-810.3 1

999TREE_DEFN

2AQEDM1 QE_PERS_DATA 1997-05-05QE_PERS_DATA Personal Data Tree 23
NSNQEDMO ASSR109

999TREE_USERLVL

3AQEDM1BRANCH 1997 -05-05ABRANCH BRANCH
JAQEDMICOMPANY  1997-05-05ACOMPANY COMPANY
3AQEOMICORPORATE 1997-05-05ACORPORATE CORPORATE
3AQEDM1DEPARTMENT1997 -05-05ADEPARTMENT DEPARTMENT
SAQEDMIDIVISION 1997-05-05ADIVISION DIVISION
999TREE_LEVEL

4ACORPORATE 1 Y

4ACOMPANY 2 N

4ADIVISION 3 N

4ADEPARTMENT4 N

4ABRANCH 5 N

999TREE_NODE

6A00001 Gl

6A 00001 8200 8200

6A 00001 8300 8300

TreeMover File Rules
TreeMover reads these records in the following strict order during an import:
1. PeopleTools Version (optional).
This record is needed only if loading data from an 8.1 or later PeopleSoft database.
2. Tree Structure (optional).

This record is needed only if the structures do not already exist. One or more structure records can be
loaded.

3. Tree Definition (required).

The information needed to create a tree. Only one tree definition record can exist in the input file.
4. Tree Level Data (optional).

The detailed level data for a tree. One or more level data records can exist in the input file.
5. Tree Levels (required for leveled trees).

The levels defined for the tree. Must include enough to define all the nodes. One or more level records
can exist in the input file.

6. Tree Node Data (optional).
The detailed tree node information: description, effective date, and so on.

7. Tree nodes and leaves (required).
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Tree node and detail information. Each node must contain either a parent node or a previous sibling
node. The referenced node—parent or sibling—must precede the node that references it in the input
file.

Detail values for a tree must exist in the database before importing the tree.

One or more node records listed in level plus sibling order—that is, the root node on the first level,
nodes on the second level, and so on—can exist in the input file.

File Layout Details

Each record starts with a unique identifier for that record type, followed by the associated column data.
All data is in a fixed format.

Tree Structure Layout (TREE_STRUCTURE)

For the Tree Structure layout, most column names map directly to the PSTREESTRCT record.

Note: The tree structure record is optional if the database already has the structure defined for the new

tree.
Column Name Column Type Length Start Position End Position Comments
File Record ID Number 1 1 1 Always 1.
UPDATE Character 1 2 2 Always A
ACTION
(only add mode is
supported at this
time)
TREE STRCT ID | Character 18 3 20 None
DESCR Character 30 21 50 None
TREE_STRCT_ Character 1 51 51 None
TYPE
DYNAMIC Character 1 52 52 YorN
RANGE
SETCNTRL _IND | Character 1 53 53 S, B, U orN
LEVEL Character 15 54 68 None
RECNAME
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Column Name Column Type Length Start Position End Position Comments
LEVEL Character 18 69 86 None
PNLNAME

LEVEL Character 30 87 116 None
MENUNAME

LEVEL Character 30 117 146 None
BARNAME

NODE Character 15 147 161 None
RECNAME

NODE Character 18 162 179 None
PNLNAME

NODE _ Character 18 180 197 None
FIELDNAME

SETCNTRLFLD Character 18 198 215 None
NODE _ Character 30 216 245 None
MENUNAME

NODE Character 30 246 275 None
BARNAME

DTL_RECNAME | Character 15 276 290 None
DTL Character 18 291 308 None
FIELDNAME

DTL PNLNAME | Character 18 309 326 None
DTL Character 30 327 356 None
MENUNAME

DTL BARNAME | Character 30 357 386 None
DTL SETID Character 5 387 391 None
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Column Name Column Type Length Start Position End Position Comments
SETCNTRLVALUE]| Character 20 392 411 None
DTL TREE Character 18 412 429 None
NAME
DTL TREE Character 5 430 434 None
LEVEL_NUM
LEVEL Character 50 436 485 Only for release 8.
PNLGRPNAME 1 and later.
NODE Character 50 487 536 Only for release 8.
PNLGRPNAME 1 and later.
DTL Character 50 538 587 Only for release 8.
PNLGRPNAME 1 and later.
LEVEL Character 30 589 618 Only for release 8.
ITEMNAME 1 and later.
NODE _ Character 30 620 649 Only for release 8.
ITEMNAME 1 and later.
DTL _ITEMNAME | Character 30 651 680 Only for release 8.

1 and later.

TreeMover Tree Definition Layout (TREE_DEFN)

The tree definition record columns require either a tree structure defined in the database or a previous
tree structure record in the file. For the Tree Definition layout, most column names map directly to the

PSTREEDEFN record.
Column Name Column Type Length Start Position End Position Comments
File Record ID Number 1 1 1 Always 2.
UPDATE Character 1 2 2 Always A
ACTION

(only add is mode
supported at this

time).
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Column Name Column Type Length Start Position End Position Comments
SETID Character 5 3 7 None
SETCNTRLVALUE| Character 20 8 27 None
TREE NAME Character 18 28 45 None
EFFDT Date 10 46 55 YYYY-MM-DD
format.
TREE STRCT ID | Character 18 56 73 None
DESCR Character 30 74 103 None
NODE _COUNT Character 10 104 113 None
ALL VALUES Character 1 114 114 YorN
USE_LEVELS Character 1 115 115 S, L orN
DUPLICATE Character 1 116 116 Yor N
LEAF
TREE Character 18 117 134 None
CATEGORY
EFF STATUS Character 1 135 135 None
TREE _ACC_ Character 1 136 136 None
METHOD
TREE ACC _ Character 1 137 137 None
SELECTOR
TREE_ACC_SEL | Character 1 138 138 None
_OPT
LEAF COUNT Character 10 139 148 None
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Column Name Column Type Length Start Position End Position Comments
TREE IMAGE Character 30 139 168 Only for release 8.
1 and later.
BRANCH_IMAGE | Character 30 170 199 Only for release 8.
1 and later.
NODECOL Character 30 201 230 Only for release 8.
IMAGE 1 and later.
NODEEXP Character 30 232 261 Only for release 8.
IMAGE 1 and later.
LEAF IMAGE Character 30 263 292 Only for release 8.
1 and later.
Tree User Level Data Layout (TREE_USERLEVEL)
The columns in this layout correspond to the columns in the TREE LEVEL TBL record.
Column Name Column Type Length Start Position End Position Comments
File Record ID Number 1 1 1 Always 3.
UPDATE Character 1 2 2 Always A4
ACTION
(only add mode is
supported at this
time).
SETID Character 5 3 7 None
TREE LEVEL Character 10 8 17 None
EFFDT Date 10 18 27 YYYY-MM-DD
format.
EFF STATUS Character 1 28 28 None
DESCR Character 30 29 58 None
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Column Name

Column Type

Length

Start Position

End Position

Comments

DESCRSHORT

Character

59

68

None

Tree Level Record Layout (TREE_LEVEL)

The tree level layout requires a tree definition record in the file previous to this record type. The columns

in this layout correspond to the columns in the PSTREELEVEL record.

Note: No-level records should be defined for no-level trees.

Column Name Column Type Length Start Position End Position Comments

File Record ID Number 1 1 1 Always 4.

UPDATE Character 1 2 2 Always A4

ACTION
(only add mode is
supported at this
time).

TREE_LEVEL Character 10 3 12 None

TREE LEVEL Character 3 13 15 None

NUM

ALL VALUES Character 1 16 16 Yor N

Tree Node Data Layout (TREE_USERNODE)
The columns in this layout correspond to the columns in the TREE_NODE_TBL record.

Column Name Column Type Length Start Position End Position Comments

File Record ID Number 1 1 1 Always 5.

UPDATE Character 1 2 2 Always 4

ACTION
(only add mode is
supported at this
time).

SETID Character 5 3 7 None
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Column Name Column Type Length Start Position End Position Comments

TREE NODE Character 20 8 27 None

EFFDT Date 10 28 37 YYYY-MM-DD
format.

EFF_STATUS Character 1 38 38 None

DESCR Character 30 39 68 None

Tree Node Record Columns (TREE_NODE)

Tree node record columns require a tree definition record in the file previous to this record type and level
records if the tree has levels. Node records must have parents defined before their children. Detail records
can be interspersed between node records.

Note: Node type is either G or R. G is for standard nodes, and R is for Query Access Group record nodes.

Branch nodes are not supported at this time.

Column Name Column Type Length Start Position End Position Comments

File Record ID Number 1 1 1 Always 6.

UPDATE Character 1 2 2 Always 4

ACTION
(only add mode is
supported at this
time).

TREE NODE Character 20 3 22 Only for node
records.

PARENT NODE | Character 20 23 42 Tree TREE NODE

NAME for the parent node
of the node or
detail.

TREE NODE Character 1 43 43 Only for node

TYPE records; must be G

or R.
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Column Name Column Type Length Start Position End Position Comments

TREE LEVEL Character 3 44 46 Only for node

NUM records.

TREE NODE Character 20 47 66 Only for node

PREV_SIB records.

RANGE FROM Character 30 67 96 Only for detail
records.

RANGE TO Character 30 97 126 Only for detail
records.

DYNAMIC Character 1 127 127 Only for detail

RANGE records; must be ¥
or V.

LEAF IMAGE Character 30 129 158 Only for release 8.
1 and later.

NODECOL _ Character 8 160 167 Only for release 8.

IMAGE 1 and later.

NODEEXP Character 8 169 176 Only for release 8.

IMAGE 1 and later.

Importing and Exporting PeopleSoft 8 Trees

Understanding TreeMover and PeopleSoft 8.x Trees
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This topic provides an overview of using TreeMover with PeopleSoft § databases and discusses how to
import and export PeopleSoft § trees.

As with other PeopleSoft Application Engine processes, you initiate the TreeMover process from
PeopleSoft pages. You need to submit a few required parameters at runtime, including the file name for
each tree import (load) or tree export (unload). You can run TreeMover each time you need to load a tree,

or you can set PeopleSoft Process Scheduler to run a tree load process automatically.

To view the results of TreeMover processes, perform the following steps from the Tree Import or Tree

Export page:

1. Click the Process Monitor link.
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The Process List page appears. The run status for your process will appear as Success, No Success, or
Warning.

Note: If you receive a No Success or Warning status, you should also review the TreeMover log file.
This file may include additional information that the Process Monitor does not include.

2. Click the Details link.
The Process Detail page appears.
3. Click the Message Log button.
4. Click the Explain button for further details on each message.

You can also view the log output file. To find this file, navigate to the log_output directory. The location
of the log_output directory is specified in the Process Scheduler configuration file. After you are accessed
the log_output directory, navigate to the following path: /AE  TREEMOVER <PROCESS ID>/
TreeMover—-<Date-Time>.log.

This example shows the full path to the log output file — the italicized portion of the path is specified in
the Process Scheduler configuration file:

C:\Documents and Settings\admin\psft\pt\8.xx-xxx-xx\appserv\pres\QEDMO\log output
|AE._ TREEMOVER_5%\TreeMover-YYYY-MM-DD-09.44.59.log

This example shows the TreeMover log file.

B TresMover-2009-06-18-09.44.59.log - Notepad
File Edit Format  Wiew Help

2009-06-18-09.44,5%: Begin: Peoplesoft Treemover

20059-06-18-0%9.44,59: UnToading tree ,,QUERY_TREE_PT,1500-01-01.
2009-05-18-09.45,02: Completed processing tree structure.

2009-06-18-09,45,02: Completed processing tree definition.

2009-06-18-09.45,02: warning - User tree level table is not one that s currently
supported by Treemover. (125,45)

2009-06-18-09.45.02: Completed processing tree Tewels.

2009-06-18-09.45.02: Total number of tree Tewels processed: O.
2009-06-18-0%.45.02: warning — User tree node table is not one that s currently
supported by Treemowver., (125,46)

2009-06-18-09,.45,12: Peoplesoft TreeMover Completed successtully.
2009-06-18-09.45.12: End: rPeoplesoft Treemover

The delivered TreeMover application can move only tree node data that is associated with the
PS TREE NODE TBL and only tree level data that is associated with the PS TREE LEVEL TBL. You
can modify TreeMover to support other tables for node and level data.

Note: Creating TreeMover customization for moving non-standard node and detail user data is a
complicated process. Oracle recommends using PeopleSoft Data Mover or other database tool when you
move user data from a source database to a target database.

When a tree replaces an existing tree using the Tree Import Utility, the system import a new tree using a
unique name and check if the tree creation process is successful. If the tree creation process is successful,
the system delete the existing tree and rename the newly created tree. If the import file from which you
are importing is corrupted, you don't lose your existing tree.
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Also, if the existing tree was secured by Definition Security, it is automatically removed from the
Definition Security Group at the time of deletion. Because the removal of the tree from the Definition
Security Group occurs prior to the import, the utility has no knowledge of the tree being secured, and
therefore, the new tree will have to be manually secured after the import is complete.

Related Links

Customizing TreeMover for Additional Node and Level Data Records

Prerequisite for Importing and Exporting PeopleSoft 8 Trees to an External
File

Before you import or export a tree, you must set the PS TREEBASEDIR environment variable. See
“Setting PS_FILEDIR and PS TREEBASEDIR in Microsoft Windows Environments” (Integration

Broker) and “Setting PS_FILEDIR and PS TREEBASEDIR in UNIX Environments” (Integration
Broker).

Note: If PS TREEBASEDIR is not set, an error message will be displayed saying Environment variable
PS TREEBASEDIR, needed to qualify a file name, is not set.

Exporting PeopleSoft 8 Trees to an External File

Use the Tree Export page (RUN_TREEMOVER_ EXP) to export trees using TreeMover.

Navigation:
Tree Manager > Tree Utilities > Export Trees

This example illustrates the fields and controls on the Tree Export page.

Tree Export

Run Control ID:  TreeExport Report Manager Process Wonitor Fun

“Output File Hame: |TFEEE}{FJDH

Tree Definition

Tree Hame: |QUER‘I’_TREE_WF ') Effective Date: |01/01/1800 &

Setld: |QEDM1 Q

Tree Data to Export

Tree Definition Tree Structure Tree User Level
Tree Level Tree Node/Leaf Tree User Nodes

To export a tree to an external file:

1. Inthe Tree Export page, enter the correct output file name.
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Note: When the PS TREEBASEDIR environment variable is set, the flat file for the export process
is located in %PS TREEBASEDIR%\<USER>\OutputFilename. You can override this and create
another location using the Process Definition Override page.

Enter the tree name, effective date, and tree key value.

Note: The tree key value applies to only setID, business unit, or user-defined key trees (tree key type
is set in the tree structure). For trees that have no additional key value, the field is not available.
The default encoding used to export trees is UTF-8.

Select the tree data to export.

You can export the tree structure data, the tree definition, the tree levels, the tree level data, the tree
nodes and leaves, and the tree node data. You also can export the tree definition, tree level, and tree
node/leaf data.

Note: You need to select Tree Structure if the tree structure does not already exist in the

target database. You can also select the Tree User Level option to move related data from the

PS TREE LEVEL TBL table, and select the Tree User Nodes option to move related data from the
PS TREE NODE TBL.

Click the Run button to move the tree. This will export the specified tree as a flat file in the location
%PS TREEBASEDIR%\<USER>\OutputFilename.

If PS_ TREEBASEDIR is set as E:\buildArea\TREE_LOC and the user is QEDMO, the file will be
exported as E:\buildArea\TREE _LOC\QEDMO\ test tO1.

Verify that the settings on the Process Scheduler Request page are correct, and click OK to run the
process.

Check the run status in the Process Monitor.

If an Error or Warning status exists for the process, check the TreeMover log file which may contain
additional information that describes the problem. Potential problems are not limited to — but may
include — the following:

* You tried to export tree level data and the tree has no levels.

*  You tried to export tree user level data and the tree does not use the PS TREE LEVEL TBL for
level data.

* You tried to export tree user node data and the tree does not use the PS TREE NODE TBL.

Related Links

“Understanding Setting PS_FILEDIR, PS_SERVDIR, and PS_ TREEBASEDIR Environment
Variables” (Integration Broker)

“Setting PS_FILEDIR and PS_ TREEBASEDIR in Microsoft Windows Environments” (Integration
Broker)

“Setting PS_FILEDIR and PS_ TREEBASEDIR in UNIX Environments” (Integration Broker)
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Importing PeopleSoft 8 Trees from an External File
Use the Tree Import page (RUN_TREEMOVER _IMP) to import trees using TreeMover.
Navigation:

Tree Manager > Tree Utilities > Import Trees

Note: PeopleSoft Tree Manager does not accept wildcard characters. To prevent creating a corrupted tree,
the Tree Import utility checks for invalid tree node names.

This example illustrates the fields and controls on the Tree Import page.

Tree Import

Run Control 10: TreeExport  Report Manager Process Monitar M

*Input File Name |TreeExport

*Save | Save v Replace Tree if Exists [ Load Tree Defn from File
Tree Name |QIUERY_TREE_WF Q Effective Date [01/01/1990 [3]
Structure ACCESS_GROUP Q [1an values Clanow Duplicate Leaf
Setld *Encoding | UTF-8 W
Description Category DEFALLT
Use Levels | Strictly Enforced b

To import an existing PeopleSoft tree:

1. In the Tree Import page, enter the correct input file name.

Note: When the PS TREEBASEDIR environment variable is set, the flat file for the import process is
located in %PS TREEBASEDIR%\<USER>\InputFilename. You can override this and create another
location using the Process Definition Override page.

2. Select a save method.

By default, you should use the Save option. However, if you think the tree might not pass all the
PeopleSoft tree audits, then select the Save Draft option, which saves the tree in draft mode and
functions just as it does in PeopleSoft Tree Manager.

3. If'the tree already exists in your database, select the Replace Tree if Exists option.

Note: If the tree already exists in your database and you do not select the Replace Tree if Exists
option, the tree will not be imported.

4. Select the Load Tree Defn from File (load tree definition from file) option if the tree definition is
contained in the input file and you want to load the tree with the same tree definition values.
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Note: In most cases, you want to load the tree definition from the file. If you select this option and the
tree definition does not exist in the input file, then the load process fails.

5. Enter the basic tree information if you are not loading the tree definition from the input file.

If you are not loading the tree definition from the input file, then you are required to specify all the
basic tree information on the run control page. These fields correspond to the same values that you’d
have to enter if you were creating the tree using PeopleSoft Tree Manager. TreeMover skips the input
record that contains the tree definition information and instead use the values that you enter.

You must load the tree definition from the file if you’re also loading the tree structure from the file. If
you try to load the structure from the file, but have overridden the definition values on the page, then
the process will not run completely.

TreeMover loads a new tree structure only if the structure doesn't already exist.

Note: If your TreeMover data file contains user level data or user node data and you are changing the
setlD of your tree on import, the user data will retain the original setID. TreeMover import does not
support the changing of user data setIDs.

6. Select the encoding option. The available options are ANSI and UTF-8.

7. Click the Run button to move the tree. This will import the flat file in the location
%PS_TREEBASEDIR%\<USER>\InputFilename.

If PS_ TREEBASEDIR is set as E:\buildArea\TREE _LOC and user is QEDMO, the file will be
imported from E:\buildArea\TREE LOC\QEDMO\ test t01.

8. Verify the successful completion of the process by checking the run status of the process in the
Process Monitor page.

If you receive either a run status of Warning or No Success, view the message log explanations for
details and recommendations. You should also view the TreeMover log for more information.

Note: You can also check the log file. If the process completed successfully, the log file states
PeopleSoft TreeMover Completed Successfully.

If you’re loading a tree that contains detail values, then those detail values must exist in the target
database before you load the tree. If they do not exist, then the tree import process fails.

Related Links

“Understanding Setting PS_FILEDIR, PS_SERVDIR, and PS TREEBASEDIR Environment
Variables” (Integration Broker)

“Setting PS_FILEDIR and PS_ TREEBASEDIR in Microsoft Windows Environments” (Integration
Broker)

“Setting PS_FILEDIR and PS TREEBASEDIR in UNIX Environments” (Integration Broker)
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Importing and Exporting PeopleSoft 7.x Trees

This topic provides an overview of the TMDOWNLD SQR program and discusses how to install and run
SQR program.

Understanding the TMDOWNLD SQR Program

TreeMover provides the TMDOWNLD SQR program for unloading a PeopleSoft tree from a PeopleSoft
7 or 7.5 database. (The SQR should also work against a PeopleSoft 6 database, but it has not been tested
against that version and is not certified for it.) This program exports most of the same tree information as
the Tree Export functionality provided with PeopleTools 8. Differences include:

* Tree categories are not exported; the category defaults to DEFAULT.
e Tree performance options are not exported.

» Tree structures are not exported.

Installing the SQR Program

To install the TMDOWNLD SQR program, copy the TMDOWNLD.SQR file from your PeopleTools 8
PS HOME/SQR directory to the SQR directory for your PeopleTools 7 or 7.5 install.

Note: If you do not have a copy of TMDOWNLD.SQR, contact PeopleSoft Customer Service.

When you run this SQR against a given version of a PeopleSoft database, you must run it with the
common SQC files that are delivered for that PeopleTools version. For example, if you run it against
a PeopleSoft 7 database, you should run it so that it uses the SQC files delivered with PeopleTools 7.
Otherwise, the process will not run correctly.

Running the SQR Program
To run the TMDOWNLD SQR program:
1. Run the TMDOWNLD SQR program from the SQR command line.

2. Follow the system prompts.

Note: There is no associated run control page with this SQR for PeopleSoft 7 or 7.5 databases. In
order to schedule this process to run without manual intervention, you need to create a run control for
the process. See your PeopleTools manual for more information on creating run controls.

Related Links
“SQR for PeopleSoft Overview” (SQR for PeopleSoft Developers)
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Customizing TreeMover for Additional Node and Level Data
Records

144

This topic discusses how to customize TreeMover for additional node and level data records.

The TreeMover program only moves data in the standard PeopleSoft tree tables. PeopleSoft trees
generally have application node data stored in the PS TREE NODE TBL table and application level data
stored in the PS_TREE_LEVEL_TBL table.

However, the tables used to hold the application data for the detail values, such as leaves, are always
application-specific; there are no default tables for storing that application data. For example, you

might have trees that reference employees as leaf values, and the employee information is stored in

the PERSONAL DATA TBL table. TreeMover does not handle moving data from application tables.
Generally, when you move trees between different PeopleSoft databases, you should move the application
data using other means, such as with DataMover. However, you can also customize the TreeMover
program to copy other application data. As with any PeopleSoft application, you should avoid performing
any customizations whenever possible.

Note: Creating TreeMover customization for moving non-standard node and detail user data is a
complicated process. Oracle recommends using PeopleSoft Data Mover or other database tool when you
move user data from a source database to a target database.

Before customizing TreeMover, you should consider the tables for which you intend to add support.
Application tables that hold data used by other parts of the PeopleSoft system should be moved by other
means, such as DataMover.

Modifying the TreeMover Application Engine Program

The TreeMover process is a PeopleSoft Application Engine process called TREEMOVER. To add support
for additional node and level tables, you must perform two basic steps: create the file layout to be used for
the new data and modify the TREEMOVER AET PeopleCode according to the following steps.

Note: You should not need to make any modifications to the actual Application Engine code.

To modify the TreeMover Application Engine program:

1. Create file layouts for your desired tree node data record or tree level data record using Application
Designer file layout functionality.

Use one of the existing TreeMover file layouts as an example (TREE_DEFN, TREE NODE, and so
on). Each file layout you add for TreeMover must have a unique file record ID, which is specified as
part of the file layout record properties; the existing TreeMover file layouts use numbers 1 through 6.

Each file layout you add must also have the UPDATE _ACTION field.

2. Inthe TREEMOVER AET record, modify the PROCESS INSTANCE FieldFormula PeopleCode as
follows:

* In the isValidUserNodeRec function, add your desired PeopleSoft records for node data to the
condition check.
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» In the isValidUserLevelRec function, add your desired PeopleSoft records for level data to the
condition check.

* In the setUserNodeRecLayout function, add code to set the correct file layout based on the node
data record.

* In the setUserLevelRecLayout function, add code to set the correct file layout based on the level
data record.

* In the getUserNodeData function, add code to get data from your new node records.

* In the getUserLevelData function, add code to get data from your new level records.

Note: In the previous steps, do not modify the original code in the functions. You should add new
code only within new “if” conditions. If you change any of the existing code, trees based on the
PS TREE LEVEL TBL and PS TREE NODE_TBL will no longer be handled with TreeMover.

Modifying the TreeMover SQR Program

If you have modified the TREEMOVER Application Engine program, then you also need to make similar
changes to the TMDOWNLD.SQR, assuming you’re using that SQR to download trees from a PeopleSoft
7.x database.

To modify the TMDOWNLD SQR program:
1. Change the Download-TreeUserLevel procedure to handle the new tree level data tables.

Be sure to add conditional logic so that the existing logic is still executed when the tree
structure uses PS TREE LEVEL TBL. The tree level record name is stored in the variable
&TS.LEVEL RECNAME.

2. Change the Download-TreeUserNode procedure to handle the new tree node data tables.

Be sure to add conditional logic so that the existing logic is still executed when the tree structure uses
PS _TREE NODE TBL. The tree node record name is stored in the variable &7S.NODE RECNAME.
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Setting Multinavigation Paths

Using Multinavigation Paths

When you define tree structure, you also define the menu, menu bar, and default navigation pages for
nodes and details. With multinavigation, you can navigate to any of the components and pages that belong
to the menu bar specified on the tree structure. For example, using the Personal Data tree, you could
navigate to pages such as Personal Data, Benefits, or Salary Information.

When multinavigation is enabled on the structure of the tree, you can click the Navigation Options link
in PeopleSoft Tree Manager and select the component to be invoked when editing data on a node or detail
value.

Navigation:

Tree Manager > Tree Manager > Navigation Options
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This example illustrates the fields and controls on the Detail Navigation page.

Detail Navigation Page

This Page allows Userto set a Page to be accessible via "Edit Data” Action Image.

First B0 1.25 or 39 O Last

Page

Customize | Find | View All| B

Current Component

Frocurement Control

Treasury Options

Purchasing Definition
Payables Definition
Receivables Definition

Order Management Definition
Project Costing Qptions
Project Costing Definition
Program Management Options
Receivables Definition

Order Management Definition
Order Management Definition
Order Management Definition
Project Costing Options
Project Costing Options
Purchasing Definition
Service Procurement Definition
Order Management Definition
Promaotions Mamt. Definition
Project Costing Options
Project Costing Options
Payables Definition

Order Management Definition
Contracts BU

Project Costing Options

GL Templates
Treasury Options

Req Approval Options
Matching
BankiPayment Options
General Holds 2
Microsoft Project

BU Definition

Program Management Options
Accounting Options 2
Accounting and Billing
Taxes and Currency
Order Entry Features
Delete Litility Tables
Project Costing Options

PO Approval Options

Semnvices Procurement Bus Unit

General Holds 1
Promations Definition
Budget Row Versioning
Copy Temnplate Option 1
Payments

Credit Processing
Confidence Level Setup

Budget Alerts

Note: User navigation selections are valid only while the current tree is open. After the tree has been
closed and reopened again, the default navigation is restored.

Enabling Multinavigation

148

Two tree structure fields determine if multinavigation is available for nodes and details. These fields let
the tree developer select whether multiple navigation targets should be supported when accessing node or
detail data. By default, multinavigation is not enabled.

Navigation:

Access the Tree Structure Properties page (PSTREESTRCTDEFN) by selecting Tree Manager > Tree
Structure
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This example illustrates the fields and controls on the Tree Structure Properties page.

 Suuciuro JALBRIEN INGSEEN ADGBIEN

Tree Structure Properties
Structure ID: CE_FERS_DATA

*Description: Personal Data

*Twe: Dretail

Additional Key Field Havigation Options

(*) Setld Indirection [ Node Mutti-Navigation
(O Business Unit [ petail Multi-Navigation
(O User Defined

) None

Navigation options are hidden when the structure type is Summary.

Creating Multinavigation Menus

We recommend that you create special menus to be used for multinavigation. These menus should be
specific to the nodes or details and should not contain any extra visible components.

Pages that you want to display on the Detail Navigation page should use the Menu and Bar items defined
in the tree structure.

To prevent these special menus from being used for something other than tree navigation purposes, clear
the Menu Installed option on the Menu Properties dialog box in PeopleSoft Application Designer.

If the tree structure has been defined with multinavigation flags enabled, you can select the component
and page to open when editing the node or leaf data.

While populating the Detail Navigation page, PeopleSoft Tree Manager collects pages using this logic:
pages appear in the Navigation Links section belong to the components that have the same key fields in
their search records. There are two exceptions from this logic:

* EFFDT key field is ignored during the validation.

*  The menu item, which points to the underlined component, can overwrite the component search
record.

In this case, the previous logic is applied to the overwriting search record.

Related Links
Using Navigation Options
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Configuring PeopleSoft Tree Manager on
the Web

Using PeopleSoft Tree Manager Upgrade Programs

PeopleSoft Tree Manager was developed using standard PeopleSoft Pure Internet Architecture. For
example, it was developed using pages, components, and standard PeopleCode functionality. Because of
this, additional steps are required for configuring new and existing trees that will be accessed through the
web.

Application Engine upgrade programs, UPG8RPTG and UPG81RPTG, automatically perform many of
the steps that are required to configure your existing trees so that they can be viewed from a web browser.

Note: When upgrading from any 7.x release, you will be instructed during the upgrade process to run
the UPGS8RPTG program. When upgrading from an 8.0x release, you will be instructed to run the
UPGS81RPTG program. You can rerun the UPG81RPTG program as often as required to complete
the upgrade of PeopleSoft Tree Manager structures. You should run the UPG8RPTG program once as
directed by the upgrade process.

To run the UPG8RPTG and UPG81RPTG programs:
1. Select PeopleTools > Application Engine > Submit AE Process Requests.
2. Create a new Application Engine process request run control ID.
The Application Engine Request page appears.
3. Click the Run button to send the request to the Process Scheduler.
The Process Scheduler page appears.

4. Select an application server to run the program from, and then select the UPGERPTG or
UPG81RPTG program from the list of processes displayed.

5. Click the OK button on the Process Scheduler Request page to start the Application Engine program.

6. Seclect PeopleTools > Process Scheduler > Process Monitor to monitor the status of the
UPGS8RPTG or UPG81RPTG process.

The process should only take a couple of minutes to run to completion.

7. From the Process Monitor page, find the UPGS8RPTG or UPG81RPTG process that you initiated, and
select the Details link from the process list.

8. Click the Message Log button to view any messages associated with the program.

You might encounter two messages with the UPGERPTG and UPG81RPTG programs:
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* A page on a tree structure was not found on a component.

* A tree structure referenced a page that was part of a component, but the component was not found
on a menu.

Note: If you receive either of these messages, you need to use the manual configuration steps to
upgrade these tree structures to be usable from the web.

You can use the View All option to display all messages generated by the UPG8RPTG or
UPGS81RPTG programs and then use your browser’s print functionality to print out the messages.

Completing Manual Configuration Steps

152

You may need to perform manual configuration steps for trees that used application-specific pages to add
or update nodes, levels, or detail values in the tree. No additional configuration steps should be required
for trees that use only the standard PeopleSoft Tree Manager pages and tables.

The Windows-based PeopleSoft Tree Manager had the ability to invoke virtually any application-specific
page by just knowing the name of the page to be invoked. It did not require that the component and
complete menu path be specified on the Tree Structure record. Neither did it use standard security edits or
permission lists for determining if the user should have access to a component. It was quite common, in
prior releases, for the tree structure to only specify the page and possibly the component to be used. The
menu information was usually left blank.

The web-based PeopleSoft Tree Manager uses standard PeopleCode functions to display the application
pages used for maintaining the node, level, and detail values. These functions require that:

*  The complete menu path is provided.
» Users have security access to work with the pages.

For tree structures that did not fully specify menu paths and security access, the upgrade programs attempt
to complete the information by searching existing menus and components to find a valid and complete
menu path for node, level, and detail user data pages. However, there might be cases where existing trees
use application pages that are not part of a component, or the component was not part of a PeopleSoft
menu definition.

To add or update the nodes, levels, and detail values for the web-based PeopleSoft Tree Manager, you
have to configure the tree structure records so that all of the page, component, and menu information is
correctly specified. The UPGSRPTG and UPG81RPTG programs complete the component information
for all of the application pages that are part of a component. They also complete the menu path
information for all components that are defined on at least one PeopleSoft menu definition.

Note: The Process Scheduler messages that were generated by the UPG8RPTG and UPG81RPTG
programs tell you the pages that are not part of any component, or components that are not part of a
PeopleSoft menu definition. After you have created component definitions for all of these pages, you need
to rerun only the UPG81RPTG program to update the tree structure records with the new information.
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Enabling Security Access for Application Pages

The web-based PeopleSoft Tree Manager uses standard PeopleSoft security and permission lists to control
which users should have access to the application pages and what types of actions they should be able to
perform.

You need to verify the following:

* All of the application pages that are used by PeopleSoft Tree Manager for maintaining the nodes,
levels, and detail values are part of a component.

* The component must be defined on a menu definition to which the user has been granted access.

» Users have specific access to any of the actions, such as Add, Update, and Correction.

Note: The Windows-based PeopleSoft Tree Manager did not use standard PeopleSoft security checks, so
existing pages that were accessed from the Windows-based PeopleSoft Tree Manager may not be set up
correctly.

Updating Effective-Dated Application Pages

If the application pages used to maintain node, level, or detail value tables are effective-dated, the
Windows-based PeopleSoft Tree Manager had special coding to ensure that when you added a new value,
the default effective date was the effective date of the tree. When a tree was saved, the Windows-based
PeopleSoft Tree Manager checked the effective date of the newly added node, level, or detail value and
issued a warning if it was greater than the tree's effective date.

In order to implement tree-specific effective date processing from the web-based PeopleSoft Tree
Manager, a PeopleTools-provided work page - PSTREEMGRXFER — needs to be added to any
component that updates effective-dated application tables. This work page contains logic that:

* Automatically sets the default effective-date as the effective date of the tree.

» Compares the effective date of the user data to the effective date of the tree during SaveEdit
processing.

This new work page has already been added to the default components used to maintain the
TREE NODE TBL and TREE LEVEL_ TBL, so only those trees that use effective-dated application
pages for maintaining the node, level, or detail values need to be updated.

This illustration shows the PERSONAL DATA1 component updated to include the new
PSTREEMGRXFER work page. Notice that the new work page is marked as a hidden page.

il PERSONAL_DATA.GBL {Component)

Definition lSh‘ucture l

Page Name | Item Hame | Hidden| Item Label Folder Tab Label | Allow Deferred Prucessingl
1 |PERSOMAL_DATA PERSOMAL_DATA r Perzonal Data v
2 |SCRTY_TEL_GL |SCRTY_TBL_GBL WR| W Scity Thl Ghl'wik W
2 |PSTREEMGR:<FER| PSTREEMGRXFER Pstreemgrafer V
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Note: In the previous example, the SCRTY TBL BGL_ WRK page was already part of this component
and is used for other non-tree related purposes.

This configuration step is optional. However, remember that users of the Windows-based PeopleSoft
Tree Manager are used to having the effective date of the application data automatically set to the tree’s
effective date. Therefore, in order to provide consistent functionality, you should consider adding the new
PSTREEMGRXFER page to your effective-dated components.

Customizing TREE_NODE/TREE_LEVEL Pages

154

The Windows-based PeopleSoft Tree Manager provided standard pages and components for maintaining
the TREE NODE TBL and TREE LEVEL TBL tables, such as the default tables that are used for the
node and level data. If you have customized either of these pages or components, you should apply the
same customizations to the versions that are used specifically by the web-based PeopleSoft Tree Manager.

The web-based PeopleSoft Tree Manager uses the following pages and components for maintaining data
in the TREE NODE TBL and the TREE LEVEL TBL tables:

¢ Node Components(Page):

TREE NODE PeopleSoft Internet Architecture (TREE NODE PIA) TREE NODE PIA 2
(TREE_NODE_PIA 2)

* Level Components(Page):

TREE_LEVEL PIA(TREE LEVEL PIA)TREE LEVEL PIA 2 (TREE LEVEL PIA 2)
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